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In This Guide...
This guide describes how to use the Methylation (CH3) 
application of Agilent Genomic Workbench 7.0 to apply 
algorithms that help identify methylated regions.

1 Getting Started

This chapter gives instructions on ho w to start the 
application and enter license information. It also giv es an 
overview of how to analyze CH3 dat a.

2 Importing, Managing, and Exporting CH3 Data and Other Content

This chapter describes how to import, organize, manage, and 
export CH3 dat a and ot her content in Agilent Genomic 
Workbench 7.0. 

3 Displaying CH3 Data and Other Content

This chapter shows you how to display log ratio data from 
imported feature extraction data files and analysis results, as 
well as gene list and track content, in the Genomic Viewer. It 
also gives you instructions on ho w to change parameters to 
display the data and content the way you prefer.

4 Setting Up Methylation (CH3) Analysis

This chapter gives instructions on how to set up the analysis 
functions for Methylation (CH3) experiments. These include 
the Preprocessing, Analysis and Re ports tabs.

5 Methylation (CH3) Analysis Reference

This chapter describes the tabs, commands, shortcut menus 
and dialog boxes specific to Agilent Genomic Workbench 
methylation (CH3) dat a analysis. The chapt er also includes 
information on the format of the reports created by the 
program.
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6 Statistical Algorithms

This chapter provides implementation details of t he 
algorithms used in t he CH3 application of Agilent Genomic 
Workbench 7.0. The CH3 applic ation algorithms facilitate the 
statistical analysis of methylated genomic regions. The first 
section presents the main methylation detection algorithm. 
The next section describes the display options available for 
methylation analysis.
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Agilent Genomic Workbench – Methylation (CH3) Analysis
User Guide
1
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Getting Help 35

This chapter gives an o verview of the Methylation (CH3) appl ication of 
Agilent Genomic Workbench 7.0. It shows you how to start the application 
and find help, and giv es general instructions on h ow to get st arted with 
analyzing CH3 dat a.

Before or af ter you import extracted data into the program, you can 
assign identification information and attributes to the samples through the 
Sample Manager tab. See the Sample Manager User Guide.

To display or anal yze imported CGH data, you organize the data files into 
logical units called experiments. Experiments are used t o define the data 
you want to display or analyze using A gilent Genomic Workbench. You can 
then use t he Preprocessing, Analysis, Discovery and Reports tabs of the 
program to interactively analyze the data in t he experiment for 
aberrations. For detailed steps on ho w to create an experiment, see the 
Data Viewing User Guide.
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1 Getting Started
What is the CH3 Application?
What is the CH3 Application?

The CH3 (methylation) application is a frame work used to identify 
methylation events in your samples. CH3 microarray analysis can help 
identify methylated regions isolated using affinity based methods such as 
methylated DNA immunoprecipitation. The sof tware helps you:

• Identify molecular e vents associated with DNA methylation

• Find and validat e gene regulation and regulatory networks by 
creating high- resolution, genome- wide methylation profiles

• Show modes of action and potential therapeutic activities of 
compounds and t arget genes by understanding the relation of DNA 
methylation to transcriptional con trol

With the CH3 application, you can:

• Import data from the Agilent Feature Extraction and Axon programs, 
and import UDF files

• Use an intuitiv e graphical interface to display data and annot ations 
in the context of an organism’s gen ome, at se veral simultaneous 
levels of detail

• Use a Z- score or BATMAN (Bayesian Tool for Methylation Analysis) 
algorithm to calculate the probability that probes are methylated or 
unmethylated

• Compare the moving average of your log ratio and Z- score data 
within the boundaries of CpG Island track s

You cannot use w orkflow mode for methylation event detection.
14 Methylation (CH3) Analysis Guide



Getting Started 1
Using Agilent Genomic Workbench on a Mac
Using Agilent Genomic Workbench on a Mac

The content of this User Guide applies to both the Windows and Mac 
versions of Agilent Genomic Workbench. Both of these versions have the 
same features. However, when you use the Mac version of the program, 
please note the following:

Windows command Equivalent Mac command

Right-click • Command-click ( -click)
• On Macs with trackpads, other options are available. On 

certain machines, you place two fingers on the trackpad 
while you press the button below the trackpad. See the user 
guide for your specific machine.

• If you have a third-party mouse that has more than one 
button, you may be able to use one of the buttons as a right 
mouse button.

Control-click Control-click (Same as the Windows command)

Shift-click Shift-click (Same as the Windows command)

 (Close button)  (Close button)
Methylation (CH3) Analysis Guide 15



1 Getting Started
Entering a License and Starting the CH3 Application
Entering a License and Starting the CH3 Application

This section describes how to enter your license for the CH3 applic ation 
to begin analyzing CH3 data.

When you start Agilent Genomic Workbench for the first time, the 
program opens in t he Home tab, with the Open Application tab 
displayed. From this tab, you can click any of the application areas, enter 
license information, or click Help to open the User Guide for that 
application.

Figure 1 Open Application tab for CH3
16 Methylation (CH3) Analysis Guide



Getting Started 1
To enter your license for analyzing Methylation (CH3) data interactively
To enter your license for analyzing Methylation (CH3) data 
interactively

1 Click the Open Application tab if it is not alread y displayed. 

2 Click License next to the description of DNA Analytics (CH3 Module).

The License tab of t he User Preferences dialog box appears.

There are tw o ways to provide the license information:

Use a Server Location

1 Unzip the license .txt file into a folder on your server, to which the 
program has access.

2 Copy the path for that folder to the Clipboard.

3 In the User Preferences License tab, click Server Location.

Figure 2 License tab of the User Preferences dialog box 
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1 Getting Started
To start the CH3 application
4 Paste the license folder path into the field below Server Location. (To 
paste the license for both Windows and Mac c omputers, hold down the 
ctrl key and press V.)

5 Click Apply, or cl ick OK to apply the license and close t he dialog box.

Enter a Text License

1 Find the folder that contains the CH3 application  license .txt file.

2 Double- click the license name to open the file in Notepad (or open the 
file in another text editor), and copy the text displayed to the 
Clipboard.

3 In the User Preferences License tab, click Text License.

4 Paste the license information into the License text box. (To paste the 
license for both Windows and Mac com puters, hold down the ctrl key 
and press V.)

5 Click Apply.

6 If you have no ot her licenses, click OK.

OR

If you have another license, click the arrow from the Select Analysis 
Application list, select the application and repeat st eps 1- 5.

To start the CH3 application

• In the Open Application tab, click the icon next to DNA Analytics 
(CH3 Module) .

The CH3 application starts and the Genomic Viewer is displa yed.
18 Methylation (CH3) Analysis Guide



Getting Started 1
Using Main Window Components to Display/Analyze Data
Using Main Window Components to Display/Analyze Data

You can use t he data viewing capability in Agilent Genomic Workbench 7.0 
without a l icense to view data for many types of arrays, including CGH, 
ChIP, and Methylation (CH3). You can use t he data analysis capability in 
Agilent Genomic Workbench only if you have a license for one or more of 
the DNA Analytics programs (CGH, ChIP, or Met hylation).

What are the main window components?

You use four primary components of the Agilent Genomic Workbench main 
window to import, manage, export, display, and anal yze extracted data.

• Home tab commands — im port, manage and expor t data

• Navigator — creat e and fill new experiments wit h array data 

When you make the experiment active, the data appear in the display, 
called Genomic Viewer.

• Genomic Viewer — display data and content in f our Views: Genomic 
View, Chromosome View, Gene View, and Tab View

You use commands in the interactive analysis tabs to perform 
preprocessing, analysis, and reporting of da ta. You can vie w the results 
of data analysis in t he Genomic Viewer.

• View tab commands — change appear ance of Genomic Viewer display

Figure 3 shows the main window of Agilent Genomic Workbench when the 
Genomic Viewer tab is sele cted, and ide ntifies the names of its 
components. 
Methylation (CH3) Analysis Guide 19



1 Getting Started
What are the main window components?
Figure 3 Agilent Genomic Workbench 7.0 showing main components for CH3
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Getting Started 1
What can you do with the main components for display of data and results?
What can you do with the main components for display of data and 
results?

See the table below for the parts of the main window you use to display 
log ratio data and results.

Table 1 Components of Agilent Genomic Workbench main window for display of data 
and results

To do this Use this part of the main window

Change program to CGH, ChIP, 
Methylation (CH3), Expression, 
microRNA, or SureSelect Target 
Enrichment module

Switch Application button: Click the button and click the 
program module you want to open. The window and 
options are different for the different program types.

Import or export data Home tab: Click the Import or Export button to select the 
data you want to import or export. See Chapter 2, 
“Importing, Managing, and Exporting CH3 Data and Other 
Content” for more information.

Select array data to display in the three 
graphical views or in the Tab View as a 
table

Experiment pane of the Navigator: Create an experiment 
with the imported data, select the experiment, and then 
select the data within the experiment to display or 
analyze. See Chapter 3, “Displaying CH3 Data and Other 
Content” for more information.

Display array data/results for only a 
certain portion of a chromosome

Genome View: Select a chromosome to display in 
Chromosome View. You cannot view log ratio data points 
here.

Chromosome View: Select a gene region to display in 
Gene View. You can display log ratio data points here if 
you select Scatter Plot in the View Preferences dialog 
box.

Gene View: See the log ratio data next to a selected 
region of a chromosome, with associated genes and 
track-based annotation. See Chapter 4, “Setting Up 
Methylation (CH3) Analysis” for details about these 
Views.
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What can you do with the main components for display of data and results?
Show/Hide or customize the data 
points for the scatter plots

Gene View: Move the mouse pointer over Scatter Plot to 
display the options. Or, right-click and then click View 
Preferences.

Chromosome View: Right-click and then click View 
Preferences.

View tab: Click View Preferences.

See Chapter 3, “Displaying CH3 Data and Other Content” 
for information on how to do this.

Display array data next to tracks or 
gene lists

My Entity List pane of Navigator: Add or select a track or 
gene list to have it appear in Gene View. 

See Chapter 3, “Displaying CH3 Data and Other Content” 
for information on how to do this.

Change the appearance of the display View Tab: Click View Preferences. From the View 
Preferences dialog box, you can change the orientation, 
select what type of data to view, and configure scatter 
plot options.

Genomic Viewer: Right-click any View except the Tab 
View and select View Preferences. In the View 
Preferences dialog box, you can select to show or hide the 
scatter plots and how to display them, including results. 

See Chapter 3, “Displaying CH3 Data and Other Content” 
for more information.

Analyze or reanalyze displayed data Preprocessing Tab: Click this tab to display commands 
you use to manipulate the data before you apply the 
algorithms.

Analysis Tab: Click this tab to display commands you use 
to analyze the data.

Reports Tab: Click this tab top display commands you use 
to generate and manage reports.

For more information on what you can do in these tabs, 
see “Tabs” on page 24.

Table 1 Components of Agilent Genomic Workbench main window for display of data 
and results (continued)

To do this Use this part of the main window
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Getting Started 1
Switching Applications
Switching Applications

You can use the Agilent Genomic Workbench to work with a variety of 
different data types. Because the requirements for the display of data (and 
calculation of results, if using a license) are different for different data 
types, you must swit ch the application for the type of data you want t o 
display.

The Switch Applications menu, located at the upper right corner of the 
Agilent Genomic Workbench window, is used to change t he application. 
The selected application is mark ed . The selected application is also 
displayed in the title bar of t he Agilent Genomic Workbench main win dow.

Figure 4 Switch Application menu
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Using Tabs and Command Ribbons
Using Tabs and Command Ribbons 

Tabs

When you click a tab, groups of commands or sing le commands appear 
that are specif ic for that tab. The tabs that are displayed change 
depending on what licenses you have, and what application is selected 
(such as CGH, ChIP, CH3). 

Figure 5 Tabs for CH3 interactive analysis

The following table summarizes the capabilities in the interactive tabs of 
the CH3 application of Agilent Genomic Workbench:

Tabs CH3 Capabilities

Preprocessing Combine (fuse) array designs

Analysis Calculate a moving average on log ratio data

Calculate a moving average on ZScores generated by probe 
methylation algorithm

Apply probe methylation algorithm

Apply BATMAN algorithm

Reports Generate probe report

Generate BATMAN report
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Getting Started 1
Commands
Commands

The area where comman ds appear is called a command ribbon. The 
command ribbon that appears when you click the Home tab for CH3 is 
shown below. The commands that appear in t he command ribbon change 
depending on what application module is selected, and wh ich tab in t hat 
application module is se lected.

Figure 6 Home command ribbon for CH3 interactive analysis

For a c omplete description of all of the command ribbon s and commands 
you see in A gilent Genomic Workbench, see “Command Ribbons” on 
page 124.
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Using the Navigator to Search for Data
Using the Navigator to Search for Data

This section giv es you instructions on ho w to search for design files, 
extracted FE dat a, experiments and other information in t he Navigator of 
Agilent Genomic Workbench. The Navigator contains different panes when  
you select the Sample Manager tab. See the Sample Manager User Guide 
information on t he Navigator contents.

Figure 7 Navigator panes

The Navigator shows the array data, experiments, and ot her content 
stored in A gilent Genomic Workbench that is available to the user. It 
contains the following panes:

Search pane

Data pane

Experiment pane

My Entity List pane
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Using the Navigator to Search for Data
Pane Comments

Search Lets you search within any pane of the Navigator for a specific 
item (array or build, for example). You must type the entire array 
name or term; otherwise, use asterisks (*) as wild cards for 
unspecified strings. For example, type *1234* to find any item that 
contains “1234”.

Data Contains microarray data files, organized by application, then by 
design and genome build. 

Shows all probe groups and microarray designs that are available 
to you, organized by folders. In general, you can:

• Expand or collapse folders to show or hide content.
• Right-click the name of a folder or item to open a shortcut menu 

that lets you take action on the item.
See “Data pane – icons, special text, and buttons” on page 140 
and “Data pane – actions and shortcut menus” on page 140.

Experiment Contains Agilent Genomic Workbench experiments. Experiments 
are organizational units that contain links to microarray data and 
design files. In data analysis modules, experiments also contain 
saved results.

My Entity List Contains gene lists and tracks:
• Gene Lists are collections of genes of interest. You can create 

them within the program, import and export them, and apply 
them to Gene View and Chromosome View.

• Tracks are collections of annotation or other information that 
map to specific genomic locations. You can import, export, and 
combine tracks, and display them in Gene View with your array 
data and analysis results.

My Networks Contains the biological networks/pathways that you found using 
Network Search or that you create using a literature search in 
eArrayXD. For more information, see the eArrayXD Users Guide.
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To search the Navigator
To search the Navigator

You can sear ch one or all of  the panes of t he Navigator for items that 
match a specific search term. Figure 8 shows the search pane of the 
Navigator, and i dentifies a couple of its elements.

Figure 8 Search pane of the Navigator

1 At the top of the Navigator, in the Pane list, select the pane to search. 
To search in all panes, select All Panels. If t he pane l ist is not visible, 
click  to show it.

2 In the search term box, type the desired search term. The search term 
is not case sensitiv e, but it must contain the complete entry that you 
want to find. You can use asterisks (*) t o represent one or more 
unspecified characters. For example, type *12345* to find any item that 
contains “12345”.

3 Click .

The program searches the selected pane(s) for items that match your 
search term. If it f inds matching items, the program expands the 
appropriate folders, and displays the names of the matching items in 
red. The f irst matching item is highli ghted in yellow.

4 Do any of t he following:

• To highlight the next mat ching item, if one is available, click 
.

• To highlight the previous matching item, click .

5 After you complete the search, click  to clear the results of the 
search, as w ell as y our search term.
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Using the Genomic Viewer to Display Data
Using the Genomic Viewer to Display Data

What is the Genomic Viewer?

Genomic Viewer is the graphics and tabular display section of t he Agilent 
Genomic Workbench main window. In t he Genomic Viewer, extracted data 
and analysis results are t abulated and displa yed next to depictions of t he 
genome, selected chromosome, and se lected genes of the species whose 
array data you are analyzing.

There are four main views in the Genomic Viewer, as sho wn in Figure 9.

• Genome View – A graphical representation of the entire genome for the 
selected species. Use t his view to select t he chromosome to show in the 
other views.

• Chromosome View – A graphical representation of the selected 
chromosome, displayed with cytobands and a plot area. Click or drag 
the mouse to select a region to display in the Gene View.

• Gene View – A more detailed view of the chromosomal region selected 
in the Chromosome View.

• Tab View – Displays design annotation and log ratio data related to the 
chromosome you select in Chr omosome View

For more information on the Genomic Viewer and its vie ws, see 
Chapter 5, “Methylation (CH3) Anal ysis Reference”.
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What is the Genomic Viewer?
Figure 9 Genomic Viewer in vertical orientation

Genome View

Chromosome View

Gene View
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To change the size of and detach panes from the Agilent Genomic Workbench main window
To change the size of and detach panes from the Agilent Genomic 
Workbench main window

• To change the size of a pane in the main window, drag one of its insi de 
borders.

• To detach a pan e from the main window and open it in a separat e 
window, click its Detach button .

Figure 10 Changing the size of and detaching panes

Click here
to detach View

Drag a border to 
to resize pane
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To maximize and reattach panes to the Agilent Genomic Workbench main window
To maximize and reattach panes to the Agilent Genomic Workbench 
main window

• To display a vie w full- screen in a separat e window, click its Maximize 
button.

• To reattach a vie w in a separat e window to the main window, click its 
Close button.

Figure 11 Maximizing and reattaching panes

Click here to
reattach View

Click here
to maximize View
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General Instructions for Displaying Microarray Data/Results
General Instructions for Displaying Microarray Data/Results

An experiment is
the folder that

holds data from
any array set you

select for the
experiment. The
folder also holds
analysis results.

You set up experiments to display all data and results in t he Genomic 
Viewer. To set u p an ex periment you:

• Import data

• Create a ne w experiment

• Add the imported data to the experiment

• Select the experiment to display data

For step- by- step instructions on how to display data, see the Data 
Viewing User Guide.

Figure 12 Typical pathway for displaying microarray data/results
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General Instructions for Setting Options for CH3 Interactive 
Analysis

Figure 3 shows the pathway for setting up an experiment and analyzing 
data interactively with the CH3 application. After you import data and set  
up experiments, y ou can set up prepr ocessing and anal ysis calculations 
before you make the experiment active, or apply them afterwards. You can 
combine designs, appl y an algorithm to show probabilities that genomic 
regions are methylated or not and re port the results. When you change 
each option after experiment activation, the program recalculates the 
results. For more information on how to change anal ysis options, see 
Chapter 4, “Setting Up Methylation (CH3) Analysis”.

Figure 13 Typical analysis pathway – Interactive mode for CH3 application

Set up and select 
experiment 

Select /deselect 
arrays to include 

in reanalysis

Combine
designs 

Compare moving 
average of log 

ratio and Z-score 
data with genomic 

region tracks

Generate reports

Display and save 
results

Apply Z-score 
and/or BATMAN 
algorithms to find 

methylation 
events
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Getting Help
Getting Help

To get help within Agilent Genomic Workbench

Agilent Genomic Workbench has several help resources. All help guides 
open using Adobe® Acrobat®.

Help Resource Description/Instructions

Methylation (CH3) 
Analysis User Guide

This user guide, which you are now reading, supplies comprehensive 
help on all available CH3 tasks. You can access it easily from anywhere 
within the program.

1 In any tab of Agilent Genomic Workbench, click the Help tab.
2 On the Help Ribbon, click Application Guide.

Methylation (CH3) Analysis User Guide opens.

Other User Guides The Help tab in Agilent Genomic Workbench lets you view any of the 
available user guides that apply to the currently selected application 
type.

1 Set the desired application type. See “Switching Applications” on 
page 23.

2 In the Agilent Genomic Workbench tab bar, click Help.
The names of the available user guides appear in the command 
ribbon.

3 Click the desired user guide.
The selected user guide opens.

Product Overview Guide An additional guide gives an overview of the capabilities within Agilent 
Genomic Workbench and describes how to start and find help for all of 
the programs. In addition, it helps you with system administration and 
troubleshooting. 

1 In any interactive analysis tab of Agilent Genomic Workbench, click 
the Open Application tab.

2 At the upper right corner of the Open Application tab, click Product 
Overview.
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To contact Agilent Technical Support
To contact Agilent Technical Support

Technical support is available by phone a nd/or e- mail. A varie ty of useful 
information is also a vailable on the Agilent Technical Support Web site.

To learn about Agilent products and services

To view information about the Life Sciences and Chemical Analysis 
products and services t hat are a vailable from Agilent, go to 
www.chem.agilent.com.

Resource To find technical support contact information

Agilent Technical Support 
Web site

1 Go to http://chem.agilent.com.
2 Select a country or area.
3 Under Quick Links, select Technical Support.
4 Select from the available links to display support information.

Contact Agilent Technical 
Support by telephone or 
e-mail (United States and 
Canada)

Telephone: (800-227-9770)

E-mail: informatics_support@agilent.com

Contact Agilent Technical 
Support by telephone or 
e-mail (for your country)

1 Go to http://chem.agilent.com.
2 Select Contact Us.
3 Under Worldwide Sales and Support Phone Assistance, click to 

select a country, and then click Go. Complete e-mail and telephone 
contact information for your country is displayed.
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Agilent Genomic Workbench – Methylation (CH3) Analysis 
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Importing, Managing, and Exporting 
CH3 Data and Other Content

Importing Files 38

Working with Experiments to Organize Imported Data 50

Managing Content 60

Exporting and Saving Content 71

This chapter describes how to import, organize, manage, and expor t 
methylation (CH3) data and ot her content within the user int erface of 
Agilent Genomic Workbench 7.0. 
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Importing Files
Importing Files

You can use  the Home tab to import many kinds of f iles into Agilent 
Genomic Workbench. The t able below describes the kinds of files you can 
import, and the topics in this section that describe how to import them.

The Data pane of t he Navigator displays all of the content available for 
the user who is logged in.See “Navigator” on page 136 for more 
information on t he Navigator panes and ho w to use them.

Type of file Description See these topics

Microarray data files • Agilent Feature Extraction 
(*.txt) data files

• GenePix/Axon (*.gpr) data 
files

• Universal Data Files (UDFs) 
(*.txt files)

“To import Agilent FE or Axon 
data files” on page 41
“To import a UDF file” on 
page 43

Microarray design files • Agilent GEML (*.xml) design 
files

• GenePix/Axon (*.gal) design 
files

“To import Agilent GEML 
design files” on page 39
“To import Axon design 
files” on page 41

Genome builds Agilent-supplied genome 
information for human, mouse 
and rat genomes

“To import a genome build” on 
page 46

Tracks BED format annotation track 
files

“To import tracks” on page 47

Array attributes .txt files that you have created 
yourself or previously exported 
from Agilent Genomic 
Workbench

“To import array attributes” on 
page 48

Experiments ZIP format file of experiments 
exported from Agilent Genomic 
Workbench

“To import an experiment 
file” on page 49
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To select a different location for data files
To select a different location for data files

By default, the program stores microarray and experi mental data files in 
C:\Program Files\Agilent\Agilent Genomic Workbench <version>\data. If you 
want, you can s elect a different location. 

1 In the Home tab, click User Preferences.

The User Pre ferences dialog box appears. See “User Preferences” on 
page 231.

2 In the Miscellaneous tab, under Data Location, click Browse.

An Open dialog bo x appears.

3 Select a location, then click Open.

The selected location appears in t he User Preferences dialog box, in 
Data Location.

4 Click OK.

To import Agilent GEML design files

The Agilent Genomic Workbench database must contain designs that match 
the Agilent Feature Extraction data files you want to import. The design 
file must be present bef ore any extraction data files are im ported. Your 
imported GEML files contain array- specific information such as probe 
names, annotations, and chromosomal locations, and are associat ed with a 
specific genome build. To import an Agilent GEML file, use the following 
procedure.

CAUTION Do not select a location that contains a backup data folder; the current data overwrites 
the data in the folder you select.

NOTE
• Catalog design files must be downloaded from the eArray Web site.
• Designs with multiple genome builds are supported for both Catalog and custom designs. For 

Catalog designs, the design must first be downloaded from the eArray Web site. You can then 
import the design for other genome builds.
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To import Agilent GEML design files
1 In the Home tab, click Import > Design Files > GEML File.

The Import Design F iles dialog box appears. See “Import” on page 201. 
The dialog box shows only *.xml files.

2 To select a file for import, click its na me. To select additional files, hold 
down the ctrl key while you click their names.

3 Click Open.

The program validates the selected file(s), and t he Import GEML Design 
Files dialog box appears. See “Import GEML design files” on page 204.

• If a design file passes validation, the Status column shows Valid in 
green. 

• If a design and build is already in t he database, the Status shows 
Overwrite in yellow. If y ou continue, the imported design replaces the 
design in t he database.

• If a design is already in  the database, but has a different build, the 
Status shows Update in green. If you continue, this build of the design 
will be added t o the database. The existing des ign build will not be 
overwritten.

•

• If a design file fails valid ation, Corrupt appears in t he Status column 
beside it, and the program will not import the file. To remove the 
corrupt design from the list, click its Remove button .

4 Click Start Import.

The program imports the file(s). The files appear as new design folders 
in the Data folder of the Navigator with the genome build as a  node 
within the folder.

You can import two design files with the same name, but associat ed 
with different genome builds; for example, Hg17 or Hg18. If you do, the 
program creates a single design folder with two nodes, one for each 
genome build.
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To import Axon design files
To import Axon design files

You can import Axon (*.gal) microarray design files into Agilent Genomic 
Workbench. The program requires the Axon design files that match all 
Axon array data files you import.

1 In the Home tab, click Import > Design Files > Axon File.

The Import Axon Design Files dialog bo x appears. See “Import” on 
page 201. The dia log box shows only *.gal files.

2 To select a file for import, click its na me. To select additional files, hold 
down the ctrl key while you click their names.

3 Click Import.

The program validates the selected file(s), and t he Set genome build 
and species for Axon design files dialog box appears. See “Set genome 
build and spec ies for Axon design files” on page 220.

• If a design f ile passes validation, the Status column will show Valid in 
green. 

• If a design file fails valid ation, Corrupt appears in t he Status column 
beside it, and the program will not import the file. To remove the 
corrupt design from the list, click its Remove button .

4 For each d esign file, select the appropriate Species and Genome Build.

5 Click Start Import.

The program imports the file(s). The files appear as new design folders in 
the Data folder of the Data pane, organized by application (CGH, ChIP, or 
methylation, for example).

To import Agilent FE or Axon data files

You can import several types of micr oarray data files into Agilent Genomic 
Workbench:

• Agilent Feature Extraction (FE) *.txt data files

• Axon (*.gpr) data files

• Universal Data Files (UDFs) (*.txt files) See “To import a UDF file” on 
page 43 for instructions on how to import this file type.
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To import Agilent FE or Axon data files
In order to import Agilent Feature Extraction files, you must import the 
representative GEML array design f iles first. In order to import Axon data 
files, you must import the representative Axon.gal design files first. See 
“To import Agilent GEML design f iles” on page 39 or “To import Axon 
design files” on page 41.

1 In the Home tab, do one of the following:

• To import Agilent FE data files, click Import > Array Files > FE 
File.

• To import Axon data files, click Import > Array Files > Axon File.

A dialog bo x appears. On ly data files of the appropriate type appear. 
See “Import” on page 201.

2 To select a file for import, click its na me. To select additional files, hold 
down the ctrl key while y ou click their names.

3 Do one of t he following:

• For Agilent FE files, click Open.

• For Axon files, click Import.

In either case, the Agilent Feature Extraction Importer dialog box 
appears. “Agilent Feature Extraction Importer” on page 167.

4 Set the following, as needed:

s

Setting Comments

Name The names of imported arrays are often cryptic. You can give 
any array a more meaningful label.
a Double-click the name of the array.
b Edit the name, as desired.
c Press Enter.
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To import a UDF file
5 Do one of t he following:

• To import the file(s) while you wait, click OK.

• To import the file(s) in t he background, click Run in Background. 
This lets you continue while t he program imports the files.

To import a UDF file

UDF files are plain t ext files that contain array data in t ab- delimited 
format. Files must contain the following six columns of information, in 
any order. Each column must contain the following column names, as 
column headers, or y ou must “map” t he names from the file to these 
columns in Agilent Genomic Workbench:

• Probe name

• Chromosome name

• Start position

• Stop position

• Description

• Signal intensity data (The file can contain additional col umns, each 
with data from an additional array.)

Dye Flip For each array:
• Select Normal if:

• The test samples were labeled with cyanine-5 (red).
• The control samples were labeled with cyanine-3 (green).
• The imported ratio (test/control) should be reported 

directly.
• Select Flipped if:

• The test samples were labeled with cyanine-3 (green).
• The control samples were labeled with cyanine-5 (red).
• The imported ratio (control/test) should be reported with 

the ratio inverted (test/control).
The program does not combine dye-flip pairs.

Overwrite arrays with 
duplicate names

If you mark this option, the program deletes an existing array 
data file if it has the same name as one you import.

Setting Comments
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To import a UDF file
When you import a UDF file, the program creates a new design ba sed on 
the information you enter during import, and the information in t he file 
itself. This design cont ains all of t he arrays represented in the file. The 
program also creates a new experiment that contains the arrays. 

1 In the Home tab, click Import > Array Files > UDF File.

The UDF F iles dialog box appears. See “Import” on page 201. Only *.txt 
files appear in t he dialog box.

2 Select the desired UDF file, then click Open.

The Select data type for experiments dialog bo x appears. “Select data 
type for experiments” on page 219.

3 For each array, set t he following, as needed:

4 Click Continue.

The Universal Data Importer – Map colu mn headers dialog box appears. 
The main table in t he dialog box contains the first few rows of data 
from the file. Column headings that are contained in t he first line of 
the file appear at  the top of the table as a guide. See “Universal Data 
Importer -  Map Column Headers” on page 226 for more information.

5 Below each column heading, select the label that identifies the content 
of the column. Use each label exactly once, except for LogRatio, which 
you can use multiple times. Alternatively, in Select Mapping, select a 
saved column map.

These options are a vailable:

Setting Comments

Experiment Name By default, the program creates an experiment with the same 
name as the imported file. To change the name:

a Double-click the name.
b Edit the name as desired.
c Press Enter.

Data type • Select the mathematical form of the signal intensity data for 
the array. The options are ratio, log2 ratio, log10 ratio, and 
ln ratio.

Design type • Select CH3.
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To import a UDF file
6 Under Species Info, select t he species and Genome Build appropriate 
to the data in the file.

7 If you expect to import many similar UDFs in the future, follow these 
steps to save the column map:

a Under Mapping Info, click Save Mapping As.
An Input dialog bo x appears.

b Type a name for the column map, then click OK.
The name of the saved map appears in Select Mapping.

In the future, you can select this mapping and apply it to any UDF file 
that you import.

8 By default, the program creates a “V irtual Array ID” that becomes the 
Array ID attribute for the array(s) in the UDF. To create your own 
virtual Array ID, f ollow these steps:

a Under ArrayID Info, clear Use System Generated ArrayID.

b Double- click the number in Virtual ArrayID, then type the desired 
new Virtual Array ID.

For more inf ormation on Array IDs, see the Sample Manager User 
Guide.

9 Click Import.

The program validates your column mapping. A dialog box appears. If 
you need to fix the column map, the dialog box has a list of the 
missing column label(s). If t he column map is complete, a message asks 
if you want to import additional f iles with the same mapping.

10 Do one of t he following:

Label Description

ProbeName The column contains names of probes.

ChrName The column contains names of chromosomes.

Start First chromosomal location for the probe.

Stop Last chromosomal location for the probe.

Description Text annotation related to the probe.

LogRatio The column contains array data values that correspond to each probe. 
You can use this label more than once.
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To import a genome build
• If you want to import additional f iles with the same column 
mapping, follow these steps to include these files in the import:

a Click Yes.
The UDF F iles dialog box appears.

b Click the name of a file to select it for import. Hold down the ctrl 
key while you click the names of additional files.

c Click Open.

• If you do not want t o include additional file(s) in the import, click 
No.

The Program imports all requested files, and t he UDF Import Summary 
dialog box appears. This dialog box shows the imported files, the 
number of line s of dat a that were imported for each file, and the 
number of lines that were skipped, if any. If a  file name appears in red, 
the program may not ha ve imported the file. See “UDF Import 
Summary” on page 225.

11 Click OK.

In the Data pane, in the appropriate application type folder, a new 
design folder appears. The design folder contains the imported array 
data.

A new experiment appears in t he Experiments folder in the Experiment 
pane, that contains the array data. This experiment has the name of the 
imported UDF file, unless you changed it during import.

To import a genome build

In general, the program uses the genome build specified in the array 
design file, and protects it from changes. If a genome build is not available 
in the program, you can import one. 

1 In the Home tab, click Import > Genome Build.

The Import Genome Build dialog box appears. See “Import Genome 
Build” on page 205.

NOTE Use arrays from a single genome build in an experiment.
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To import tracks
2 Set the following. All are required.

3 Click OK.

To import tracks

You can import BED format track f iles into Agilent Genomic Workbench. 
Track files contain specific features correlated with chromosomal 
locations, and appl y to a specific genome build of a given species.

1 In the Home tab, click Import > Track.

The Import Track dialog box appears. See “Import Track” on page 206.

2 Set the following. All are required.

Setting Instructions

Species • Type the genome’s species of origin, as you would want it to 
appear within the program. 

Build Name • Type the name of the genome build you want to import, as 
you would want it to appear within the program. 

Refseq File This file contains information on gene locations for Gene View.

a Click Browse.
A dialog box appears.

b Select the desired file, then click Open.

Cyto-band File This file contains the graphic information on the cyto-bands 
for Genome and Chromosome Views.

a Click Browse.
A dialog box appears.

b Select the desired file, then click Open.

Setting Instructions

Species • Select the species to which the track applies.

Build Name • Select the specific genome build of the species to which the 
track applies.
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To import array attributes
3 Click OK.

The program imports the track. To display the track in Gene Vie w, and 
to manage track s, see “To show tracks in Gene View” on page 92.

To import array attributes

An array attributes file is a tab- delimited *.txt file that contains a list of 
arrays by Array ID, and values for array attributes. Attributes are pieces 
of array- specific information, such as the hybridization temperature or the 
name of an a rray set t hat contains the array. 

Although you can im port array attributes with this function, the Sample 
Manager application lets y ou import and assign array attributes more 
easily. See the Sample Manager User Guide for more information. To 
import an array attributes file

1 From the Home tab, click Import and then select ArrayAttributes.

The Import microarray attributes dialog bo x appears. See “Import” on 
page 201.

2 Select the microarray attributes file, then click Import.

The program imports the file. If the ArrayIDs in the file do not match 
the ArrayIDs of arrays in the program, a dialog bo x appears. The dialog 
box has a list of the ArrayIDs in the file that do not match. Click No to 
stop the import process, or click Yes to continue an yway. 

Track Name • Type a name for the track. 
This name identifies the track within the program, including 
the name that appears if you include the track in Gene View.

Track File a Click Browse.
A dialog box appears.

b Select the name of the track (*.bed) file that you want to 
import.

c Click Open.
The location of the file appears in Track File.

Setting Instructions
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To import an experiment file
To import an experiment file

In Agilent Genomic Workbench, an experiment is a set of link s to 
microarray data and design  files, and any associated results. An A gilent 
Genomic Workbench experiment file is a single ZIP file that contains the 
design and data files for one or more experiments. You can im port 

• Experiment files created in A gilent Genomic Workbench on anot her 
computer

• Agilent Genomic Workbench 5.0 and 6.x experiment files

1 In the Home tab, click Import > Experiments.

The Import Experiments dialog box appears. See “Import” on page 201.

2 Select the ZIP file that contains the experiment(s) y ou want to import, 
then click OK.

The program imports the experiment file. Designs appear as new folders 
in the Data pane, in t he applicable design type folder. Array data 
appears within the applicable design folder, organized by genome build. 
In addition, the experiment(s) appear in t he Experiment pane, 
containing the appropriate arrays. 

Agilent Genomic Workbench experiment f iles contain all of t he design and 
array data files for an experiment, but do not  include any analysis 
parameter settings, ar ray selections, or analysis results. To export the data 
and design files from one or more experiments, see “To export 
experiments” on page 72.
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Working with Experiments to Organize Imported Data
Working with Experiments to Organize Imported Data

This section describes how to organize im ported array data and designs 
into experiments. Experiments, shown in t he Experiment pane of t he 
Navigator, contain links to specific array data and d esign files in t he Data 
pane. After you set up an experiment, y ou can then analyze selected array 
data within the experiment. 

Because experiments only contain links to the actual data and design 
files, any number of experiments can use a given set of f iles. In the CH3 
application, experiments also ca n contain saved experiment results.

To display the array designs and data in the program

• To display the directory of dat a in the program, use t he Data pane 
(Figure 14). Double- click a folder to expand or collapse it, or click the 

 and  buttons.

Figure 14 Data pane of the Navigator
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To create a new experiment
In the Data pane, the program organizes design files by the application 
(CGH, ChIP, or met hylation, for example) to which t hey apply. It organizes 
array data files by genome build under the design with which they are 
associated.

You can right- click many elements of the Data pane to open shortcut 
menus. For more inf ormation, see “Data pane – actions and shor tcut 
menus” on page 140.

Many icons can appear in t he Data pane. See “Data pane – icons, special 
text, and buttons” on page 140 for a com plete list.

The Search pane can hel p you find specific data files or other content. See 
“To find specific content items in t he Navigator” on page 62.

To create a new experiment

In Agilent Genomic Workbench, experiments are organiza tional units that 
contain links to data and design files. To display or analyze data, you 
must first create an experiment and associate the desired data files with 
it. Because experiments only contain links to the actual data and design 
files, any number of experiments can use a given set of f iles. In data 
analysis applications (CGH, ChIP, or met hylation, for example), 
experiments can also contain saved experiment results.

1 In the Home tab, click Create Experiment.

The Create Experiment dial og box appears. See “Create Experiment” on 
page 178.

2 Type a Name and an optional Description for the experiment.

3 Do one of t he following:

• To create an empty experiment, and add data to it later, click OK.
The program creates the experiment. To add arrays to the 
experiment later, see “To add ar rays to an experiment” on page 53.
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To create a new experiment
• To create an experiment and add data to it now, follow these steps: 
(You can add or remove data from the experiment later.)

a Click Properties.
The Experiment Properties dialog box appears. See “Experiment 
Properties” on page 188.

b Under Select Design, select t he design and genome build 
associated with the desired ar ray data.
The applicable ar rays appear in Ar ray List.

c In Array List, click t he name of an array that you want in y our 
experiment. Hold down the ctrl key while y ou click the names of 
additional arrays.

d Click .
The program transfers the selected arrays to the Selected Array 
List.
The dialog box also shown other options for adding arrays. See 
“Experiment Properties” on page 188 for more information.

e Click OK.
The program creates the new experiment, and adds  data to it from 
the selected arrays.

• To create an experiment and add data to it using t he “drag and 
drop” method, follow these steps:

a To create an empty experiment, click OK.
The program creates the experiment.

b From the Data pane, expand a design to see the build and array 
data.

c Drag an array from the Data pane and dr op it ont o the 
experiment folder in t he Experiment pane.

In all cases, a folder with the name of t he new experiment appears in 
the Experiment pane of the Navigator. 
52 Methylation (CH3) Analysis Guide



Importing, Managing, and Exporting CH3 Data and Other Content 2
To add arrays to an experiment
Figure 15 Experiment pane of the Navigator

To add arrays to an experiment

After you create an ex periment, or im port one, you can add ar rays to it. 
When you add ar rays to an experiment, y ou create links between the 
experiment and the array data and design files. Because the program does 
not move the actual f iles, multiple experiments can share t he same ar rays.

1 In the Experiment pane, double- click the Experiments folder to expand 
it.

2 Right- click the name of the experiment, t hen click Show Properties.

The Experiment Properties dialog box appears. See “Experiment 
Properties” on page 188.

3 Under Select Design, select t he design file and genome build  for the 
arrays to add.

The arrays for the selected design file and genome buil d appear in 
Array List.

4 In Array List, select the arrays to add to the experiment. To select a 
single array, click its name. T o select additional ar rays, hold do wn the 
ctrl key while y ou click their names. 

5 Click .
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The program transfers the selected arrays to the Selected Array List.

The dialog box also has other options for adding arrays. See 
“Experiment Properties” on page 188 for more information.

6 Click OK.

Or, to add ar ray data to an experi ment using the “drag and drop” method,

1 From the Data pane, expand a design t o see t he build and ar ray data.

2 Drag an array from the Data pane an d drop it ont o the experiment 
folder in t he Experiment pane.

If needed, the program adds appropriate design and genome build folders 
to your experiment folder in the Experiment pane. It places the arrays you 
selected in the appropriate genome build folder.

To change the order of arrays in an experiment

When you select an ex periment, a table appears in t he Tab View of 
Genomic Viewer that contains log ratio values for arrays in t he 
experiment. See “Tab View” on page 161. You can change t he order in 
which the arrays appear the table. If you display separate scatter plots in 
Gene View and Chr omosome View for each ar ray, the array order also 
determines the order in which t hese plots appear. You can use this feature 
to organize your arrays more logically, or to make it more convenient to 
display certain arrays. It is especial ly useful if y ou have many arrays.

1 In the Experiment pane, right- click the name of the desired experiment, 
then click Edit Array Order.

The Edit Ar ray Order dialog bo x appears. See “Edit Array Order” on 
page 187.

2 In Design, select the design that contains the arrays whose or der you 
want to change.

The arrays from the selected design appear in Ar ray Name.

3 Do any of t he following:

NOTE If you add arrays to a selected experiment, and analysis options are marked (for example, 
Probe Methylation or Batman), you need to clear and then mark these options again to 
apply the analysis to the arrays.
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• To move an array up in the list, click its name, t hen click .

• To move an array down in t he list, click its name , then click .

• To sort the list based on a specific microarray attribute, select the 
desired attribute in Order by.

4 Click OK.

To change the display names for arrays in an experiment

You can change t he name displayed for arrays in an experiment, based on 
array attributes. When you change t he display names for arrays in an 
experiment, the array names are changed only for the selected experiment. 
The display names are unchanged in the Data pane and in the other 
experiments.

1 Expand the folders in t he Experiment pane until you see t he 
experiment you want to change.

2 Right- click the experiment name, and sel ect Show Properties.

3 In the Experiment Pr operties dialog box, click Display Name by and 
select an attribute to use for display of ar ray names. 

Click OK. The names of t he arrays in the experiment are changed to the 
selected attribute. If t he attribute does not exis t for an array, the Global 
Display Name is displa yed.

NOTE To change the name of an array that is displayed throughout Agilent Genomic Workbench, 
change its Global Display Name using Sample Manager. For more information, see the 
Sample Manager User Guide.
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To rename an array in an experiment

When you rename an array in an experiment, you change the array’s name 
only within the context of the selected experiment. The name of the array 
is unchanged in t he Data pane, and in ot her experiments.

1 Expand the folders in t he Experiment pane until you can see the array 
to rename.

2 Right- click the name of the desired array, then click Rename.

An Input dialog bo x appears.

3 Type the new name for the array, then click OK.

The name of the array in the tab view of the selected experiment is 
renamed. The g lobal display name of the array is not changed.

To remove arrays from an experiment

When you remove arrays from an experimen t, you only remove the links 
between the experiment and t he data files. The files are still available in 
the program for use in ot her experiments. To completely remove files from 
the program, see “To remove data or design files from the program” on 
page 64.

1 In the Experiment pane, expand folders until you can s ee the desired 
experiment, and t he array(s) that you want to remove from it.

2 In the Arrays or Calibration Arrays folder of the desired experiment, 
click the name of an array to select it for removal. Hold do wn the ctrl 
key while you click the names of additional ar rays.

3 Right- click one of the selected array names, then click Delete.

A Confirm dialog box appears.

4 Click Yes.

The program removes the links between the experiment and the 
selected array data files. If the removal of ar rays leaves a design f older 
in the experiment empty, the program removes this folder as well. 
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To select or remove calibration array(s)

After you add an array to an experiment, you can select it as a calibration 
array. The program lists calibration ar rays within the Calibration Arrays 
folder of the experiment with a s pecial icon . You can also remove the 
calibration designation from an array.

To select an array as a calibration array

1 Expand the folders of the Experiment pane until  you can see the array 
that you want t o select as a calibration ar ray.

2 Right- click the name of the desired array, then click Select for 
Calibration. To select all of the arrays of a given design in the 
experiment as calibration ar rays, right- click the genome build folder of 
the desired design, t hen click Set for Calibration.

The program selects the array as a calibration array. In t he Calibration 
Arrays folder of the applicable genome build and d esign within the 
experiment, the array appears with a special icon . 

To deselect an array from calibration 

1 Expand the folders of t he Experiment pane until you can see the 
desired array. The pr ogram lists calibration arrays in t he Calibration 
Arrays folder(s) of the applicable genome build(s) and design(s) within 
each experiment. 

2 Right- click the name of the desired array, then click Deselect from 
Calibration. 

To deselect multiple calibration arrays at once, select all  of t he desired 
arrays. Right- click one of  the arrays, then click Deselect from 
Calibration. (To select multiple ar rays, click the name of one array, 
then hold down the ctrl key and click t he names of additional ar rays. To 
select a contiguous block of ar rays, click t he name of the first array, 
then hold down the Shift key and clic k the name of the last one.)

The program removes the array(s) from calibration, and mo ves the 
arrays to the Arrays folder of t he applicable genome build and design 
within the experiment. The ico ns of t he arrays change to the standard 
(non- calibration) array icon .
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To show or hide array attributes in an experiment 

Sample attributes are pieces of information specific to an array, such as 
chip barcode or hybridization temperature. You can show or hide 
attributes for the arrays in the experiment with the Sample Attributes 
dialog box. See “Sample Attributes” on page 213.

1 Right- click the experiment whose attribut es you want t o show or hide, 
or to change.

You see the array attributes and their values that were set up in the 
Sample Manager table. See the Sample Manager User Guide. 

2 Click Sample Attributes.

3 Click Show/Hide Attributes. 

The Show/Hide Columns dialog box appears. See “Show/Hide 
Columns” on page 222.

4 Mark the check boxes for the attributes you want to show, or cle ar the 
check boxes for the attributes you want t o hide. These changes are 
applied globally for the arrays.

5 Click Save.

6 In the Show/Hide Columns dialog box, click Close.

7 Click Close.

To display or edit array attributes in an experiment

1 Right- click the experiment whose attribut es you want t o display or edit.

2 Click Sample Attributes.

NOTE You cannot hide the required attributes. These include Array ID, Global Display Name, 
Green Sample, Red Sample (for 2-color arrays), and Polarity.

NOTE You cannot create new attributes using this dialog box. To do this, you must use the Sample 
Manager tab. See the Sample Manager User Guide.
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You see the array attributes and their values that were set up in the 
Sample Manager table. See the Sample Manager Guide. See “Sample 
Attributes” on page 213.

3 Double- click the cell whose array attribute value you want t o change.

4 Click Save Changes.

5 Click Close.

To display or edit the attribute values of a specific array

1 Array attributes are pieces of information specific to an array, such as 
chip barcode or h ybridization temperature. In t he Navigator, you can 
display or chang e attributes for each ar ray.Expand the folders of the 
Data pane or t he Experiment pane until y ou can see the array of 
interest.

2 Right- click the name of the array, then click Show Properties.

The Microarray Properties dialog box appears, wit h a list of ar ray 
attributes. See “Microarray Properties” on page 208. You can also edit 
the attributes of a specific array from this dialog box. In addition, if the 
array is an A gilent array, you can see header and f eature information 
sent from the Agilent Feature Extraction pr ogram.

3 When you are f inished, click Close.

NOTE You cannot change Array ID, Polarity, Extraction Status, or IsMultiPack attributes for 
extracted or UDF arrays.

NOTE You use the Sample Manager tab to organize, create, import, and export array attributes. 
See the Sample Manager User Guide.
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Managing Content

This section describes how to create, find, rename, update, combine, 
and/or remove content such as dat a, gene lists, and track s, stored in 
Agilent Genomic Workbench. To display the data, gene list and track 
content, see Chapter 3, “Displaying CH3 Dat a and Ot her Content”.

To display a list of the content stored in the program

The Data and My Entity List panes of the Navigator show the content 
stored in A gilent Genomic Workbench. For more information on t he 
Navigator and its cont ents, see “Navigator” on page 136.
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Figure 16 Navigator panes

Data pane – Shows all of t he design and ar ray data files stored in t he 
database. For more information, see “To display the array designs and 
data in the program” on page 50. 

My Entity List pane – Sho ws the gene lists and tracks stored in the 
program. To display the names of gene lists or tracks available in the 
program, double- click the names of folders to expand or collapse them, or 
click the  or  buttons.
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To find specific content items in the Navigator

At the top of the Navigator is a search pane that can help you find 
specific content items. See “Search pane” on page 138.

1 Type a search term in the box at the top of the Navigator. The search 
term is not case- sensitive, but it must ref lect the entire name of t he 
content item that you want to find. You can use asterisks (*) as 
wildcards to represent a group of unspecified characters. For example, 
if you type *1234*, the search will find all it ems that contain “1234” in 
the name.

2 By default, the program searches all panes of  the Navigator. To limit 
your search t o a spe cific pane, c lick . In the list that appears, select 
the desired pane.

3 Click .

The program searches the selected pane(s). If it f inds item(s) that 
match your search term, it expands folders so that the items are visible, 
and selects them in red. You may need to scroll down to see all the 
search results.

4 To clear the results of a search, click .

To display the properties of a specific design

Design properties include general information about a design, such as its 
name, application type, and associated species. They also include a list o f 
the names and chr omosomal locations of probes.

1 Expand the folders of the Data pane until you can see the genome build 
folder(s) within the desired design folder.

2 Right- click the desired genome build folder, then click Show Properties.

The Design Properties dialog box appears. See “Design Properties” on 
page 183.
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To update probe annotation in design files

Agilent regularly makes updates to probe annotations on its eAr ray Web 
portal. If you have imported Agilent array designs into Agilent Genomic 
Workbench, and you are a registered eArray user, you can download the 
updated design files from within Agilent Genomic Workbench. For more 
information about eAr ray, go to https://earray.chem.agilent.com and click 
Help. 

1 In the Home tab, click User Preferences.

The User Pre ferences dialog box appears.

2 In the Miscellaneous tab, under eArray User Details, type your eArray 
Username and Password. See “User Preferences” on page 231. 

3 Click OK.

4 Expand the folders of t he Data pane until you can see the design that 
you want t o update.

5 Right- click the desired design, then click Update from eArray. This 
option appears only for Agilent designs.

A confirmation dialog box appears.

6 Click Yes.

The program downloads an updated design, if one is a vailable.

To rename an array in the Data pane

This topic describes how to rename an array in the Data pane, which 
changes the Global Display Name for the array. If you rename an  array in 
this way, and subsequently add the array to an experiment, t he array 
appears in t he experiment wit h the new name. It also changes t he array 
name in any experiment to which it is already linked. To rename an ar ray 
only within the context of a specific experiment, see “To rename an ar ray 
in an expe riment” on page 56.

1 Expand the folders of t he Data pane until you can see the array you 
want to rename.

2 Right- click the name of the array, then click Rename.

An Input dialog bo x appears.
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3 Type a new name f or the array, then click OK.

The program renames the array.

To remove data or design files from the program

You can delete array design and dat a files from the program when you are 
finished with them.

1 If an array that you want to delete is associated with an experiment, 
first delete it fr om the experiment. See “To remove arrays from an 
experiment” on page 56.

2 In the Data pane, ex pand folders until you can se e the design folder or 
array that you want t o delete.

3 Do one of t he following:

• For array data files, click the name of the first array, then hold down 
the ctrl key while you click t he names of additional  arrays within the 
same design. 

• For array design folders, click the name of the first design folder, 
then hold down the ctrl key while y ou click the names of add itional 
ones. This selects the designs and all ar ray data files within them for 
deletion.

4 Right- click the name of a selected design folder or ar ray data file, then 
click Delete.

A confirmation dialog box appears.

5 Click Yes.

The program deletes the selected files.

CAUTION When you delete files, you permanently remove them from Agilent Genomic 
Workbench. To restore deleted files, you must import them again.
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To create a gene list

When you create a ge ne list, you create a list of  the genes in a co ntiguous 
chromosomal region that you define. To create a list of genes in multiple 
regions, create multiple gene lists, and combine them. See “To add on e 
gene list to another” on page 67.

1 Follow these steps to define a chromosomal region for your gene list. If 
you know the exact st art and end l ocations of t he desired chromosomal 
region, skip to step 2.

a In Genome View, select the desired chr omosome.
The selected chromosome appears in Chr omosome View. See 
“Chromosome View” on page 154.

b In Chromosome View, in the plotting area to the right of the 
chromosome, drag the pointer over the chromosomal region of 
interest.
The program draws a blue bo x around the region, and displays the 
region in greater detail in Gene Vie w.

c In Gene Vie w, adjust the view so only the genes of interest appear. 
For a description of t he adjustment commands a vailable in Gene 
View, see “Gene View” on page 156.

2 Right- click anywhere within the log ratio plotting area in Gene Vie w, 
then click Create Gene List.

The Create Gene List dialog  box appears. See “Create Gene List” on 
page 180.

3 In the dialog box set the Name, Description and Color.

4 In the dialog box select the chromosomal region for the new gene list.

5 Click OK.

The new gene list appears in the Gene List folder in the My Entity List 
pane of the Navigator.
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To import a gene list

A gene list f ile is a plain t ext (*.txt) file that contains one gene name per 
line. When you import a gene list into Agilent Genomic Workbench, it 
appears in t he Gene List f older in the My Entities List pane. You can use 
the gene list to highlight specific genes, or to show or hide the appearance 
of genes and dat a, in Gene and Chr omosome Views. See “To show gene 
lists in Gene Vie w” on page 90.

1 In the My Entities List pane, double click  the Entities folder to expand 
it.

2 Right- click the Gene List folder, then click Import Gene List.

An Import dialog box appears. See “Import” on page 201.

3 Select the desired gen e list f ile. To select additional gene  list files, hold 
down the ctrl key and click their names.

Click OK.

To display the genes in a gene list

You can displa y the genes in a gen e list as a table.

1 Expand the folders in t he My Entity List pane until you can see the 
desired gene list.

2 Right- click the gene list, then click View In Table.

The Gene List dialog box appears, with a table that contains the names 
of the genes in the gene list. You can also use this dialog box to edit 
the description of the gene list and its display color. See “Gene List” on 
page 199.

You can also create gene lists. For more inf ormation, see “To create a 
gene list” on page 65.
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To add one gene list to another

You can add one gene list (a source gene list) to another (the target gene 
list). The program appends the source gene list to the end of the target 
gene list, and lea ves the source gene list unch anged.

1 Expand the folders in t he My Entity List pane until you can see the 
gene lists t hat you want t o combine.

2 Right- click the desired source gene list, t hen click Add to Gene List.

A dialog bo x appears. F or more information, see “Add Gene List 
<name> to” on page 166.

3 In Select target gene list, select t he desired target gene list.

4 Click OK.

To rename a gene list 

The name of a gene list identifies it within the Gene List folder of the My 
Entity List pane. You can r ename gene lists.

1 Expand the folders of t he My Entity List pane until you can see the 
gene list t hat you want t o rename.

2 Right- click the desired gene list, then click Rename.

An Input dialog bo x appears.

3 Type a new name f or the gene list, then click OK.

To delete gene list(s)

1 In the My Entity List pane of the Navigator, click to expand the Gene 
List folder.

2 Click the name of a gene list to delete. Hold down the ctrl key while 
you click the names of additional gene lists. 

3 Right- click one of the selected gene lists, then click Delete.

A confirmation dialog box appears.

4 Click Yes.
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To display the details of a track

You can displa y a table that contains the values for a list of track 
attributes.

1 In My Entity List pane, expand the Tracks folder to see the track.

2 Right- click the name of the track, then click View Details.

3 Data describing the track appear in a Track table. See “Track” on 
page 223.

To combine tracks

You can creat e a track that contains elements from two or more existing 
tracks. The existing tracks must be available in Agilent Genomic 
Workbench, and they must be associated with the same genome build.

1 In the My Entities List pane, double- click the Entities folder to expand 
it, if n ecessary.

2 Right- click the Tracks folder, then click Combine Tracks.

The Combine Tracks dialog bo x appears. See “Combine Tracks” on 
page 172.

3 In Name, type a name for the combined t rack. The pr ogram uses this 
name to identify the track in t he Tracks folder, and to label t he track if 
it appears in Gene Vie w.

4 Click New Condition.

A new row appears in t he Track/Operator list.

5 Under Track, select t he first track to combine.

6 Click New Condition, then select anot her Track/Operator pair. You can 
set up as man y Track/Operator pairs as you like, but y ou must set up 
at least two. When you add a track, t he program automatically assigns 
the AND operator to the previous track.

To remove the bottom row from the list, click Delete Condition. To 
delete all rows from the list, and erase any entry in Name, click Reset.

7 Under Operator, select one of the following:
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8 Click Save.

Your combined track appears in t he Tracks folder of t he My Entities 
List pane. The Com bine Tracks dialog box remains open f or you to 
create another combined track.

9 Click Close.

To rename a track

The name of a track identifies it both within the Tracks folder of the My 
Entity List pane, and in Gene Vie w when you select Show In UI for the 
track. You can rename tracks.

1 Expand the folders of t he My Entity List pane un til you can see the 
track that you want t o rename.

2 Right- click the desired track, then click Rename.

An Input dialog bo x appears.

3 Type a new name f or the track, then click OK.

Operator Comments 

AND Creates a combined track out of 2 tracks that will contain elements that appear 
in both tracks

OR Creates a combined track out of 2 tracks that will contain elements that appear 
in either of the tracks

MINUS Removes the elements of the second track from the first track.
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To delete tracks

1 In the My Entity List pane of t he Navigator, expand the Tracks folder.

2 Click the name of a track to delete. Hold down the ctrl key while you 
click the names of additional track s. 

3 Right- click one of the selected tracks, then click Delete.

A confirmation dialog box appears.

4 Click Yes.
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Exporting and Saving Content

This section describes how to export several kinds of files from the 
program. 

To export array attributes

You can expor t selected array attributes for any imported arrays. You first 
select the arrays and then the attributes for the selected arrays. You can 
export array attributes from the Home t ab or from the short- cut menu for 
an experiment.

1 Click Home > Export > Array Attributes.

OR

In the Experiment pane of t he Navigator, right- click an experiment of 
interest, and click Export Attributes.

The Export Array Attributes dialog box appears wit h the Array tab 
displayed. See “Export Array Attributes” on page 191.

If you opened this dialog box by right- clicking an experiment, only 
those arrays selected for the experiment appear in the Selected Array 
List. You can add or subtract fr om the list.

2 Under Select Design, sele ct the design file and genom e build for the 
arrays to add.

The arrays for the selected design file and genome buil d appear in 
Array List.

3 In Array List, select the arrays whose attributes you intend to export. 
To select a single array, click its na me. To select additional ar rays, hold 
down the ctrl key while you click their names. 

4 Click .

The program moves the selected arrays to the Selected Array List.

5 Click Next to select attr ibutes for the selected arrays.

The Export Array Attributes dialog box appears wit h the Attribute tab 
displayed. See “Attribute Tab” on page 193.

All of the attributes for the arrays are already located in t he Selected 
Attribute List. 
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6 Move any attributes you don’t want t o export to the Available List.

a In the Selected Attributes List, select those attributes you do not 
intend to export.

b Click .

7 Click OK.

The Export dialog box appears. See “Export” on page 190.

8 Select the folder in whic h to save the attributes, and cli ck Export.

The attributes are saved to the selected folder as a .txt file.

To export experiments

You can expor t experiments as a ZIP file to transfer them to another 
computer. Exported experiments contain the associated design and ar ray 
data files, only. The program does not expor t information about array 
selections, or an y analysis parameters or results.

1 In the Home tab, click Export > Experiments.

The Export Experiments dialog box appears. See “Export 
Experiments” on page 195.

2 Mark the experiments that you want to export. To export all 
experiments, click Select All.

3 Click OK.

An Export dialog box appears. See “Export” on page 190.

4 Select a location and type a na me for the exported ZIP file.

5 Click Export.

The program exports all sel ected experiment(s) together as a sing le ZIP 
file. 
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To export a gene list

You can export a gene list as a text file that contains one gene per line.

1 In the My Entity List pane, in t he Gene List folder, right- click the gene 
list that you want to export, then click Save As.

A Save As dialog bo x appears.

2 Select a location and type a name for the file.

3 Click Save.

A message appears when the operation is com plete.

4 Click OK.

To export tracks

You can export selected tracks as a BED format track file. You can t hen 
import this file into Agilent Genomic Workbench on anot her computer, or 
into a genome browser that accepts BE D format files.

1 In the Home tab, click Export > Tracks.

The Export Tracks dialog bo x appears. See “Export Tracks” on 
page 196.

2 Mark the tracks to export. To select al l tracks for export, click Select 
All.

3 Click OK.

An Export dialog box appears.

4 Select a location and type a name for the exported track f ile, then click 
Export.

The program exports the track(s) as a single BED f ormat track f ile.
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To copy what you see in the main window

You can cop y panes of t he main windo w to the clipboard as images, and 
then paste them into a new document in anot her program (such as Word, 
or PowerPoint). The images cont ain only what actually appears on your 
screen — regions to which you must scr oll are no t included.

1 In the View tab, click Copy.

2 In the shortcut menu that appears, click the name of the pane that you 
want to copy. You can copy any view, or t he Navigator. To copy all of  
the panes, click All.

The program copies the selected pane(s) to the clipboard.

3 Open a document in a program that accepts images. In t hat program, 
click Edit > Paste, or t he appropriate paste command.

To copy the list of array colors for an experiment

You can copy the list of arrays in an experiment, and the colors assigned 
to them, to the clipboard as an image. You then paste the image into a 
document in another program such as Word or PowerPoint.

1 In the Experiment pane, expand the Experiments folder.

2 Right- click the name of the desired experiment, then click Edit Array 
Color.

The Edit Ar ray Color dial og box appears. See “Edit Array Color” on 
page 186.

3 In the dialog box, click Edit > Copy.

The program copies the names of the arrays and their colors to the 
clipboard as an image.

4 Open a program that accepts images. Click Edit > Paste, or t he 
appropriate paste command f or the specific program.

NOTE To adjust how data is displayed in the panes, use the View Preferences dialog box. See 
“View Preferences” on page 236 for more information.
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To save data and design information from an experiment
To save data and design information from an experiment

You can save the data and design information from a sing le design in an 
experiment as a t ab- delimited text file.

1 In the Experiment pane, expand the Experiments folder until you see 
the genome build(s) for the design you want t o export.

2 Right- click the name of the desired genome build, then click Save As 
Text File.

A dialog bo x appears.

3 Select a location and type a name for the file, then click Save.
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To save data and design information from an experiment
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You can also manage all of the colors for all of the arrays in an experiment. 
Right-click the desired experiment, then click Edit Array Color. For 
more information, see “Edit Array Color” on page 186.Displaying Array 
Data 82

Displaying Content (Gene Lists/Tracks) 90

Searching for Probe and Gene Information 98

This chapter shows you how to display log ratio data from imported 
feature extraction dat a files, as well as gene and track cont ent, in the 
Genomic Viewer. It also  has instr uctions on how to customize the display 
of data and content to meet your needs.

To learn about t he options f or the main win dow and t he dialog boxes for 
displaying data, see Chapter 5, “Methylation (CH3) Anal ysis Reference”.
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Selecting an Experiment
Selecting an Experiment

An experiment is a set of link s to microarray data and design f iles, and 
any associated results. You can se e a list of the experiments in the 
Experiments pane of t he Navigator. See “Navigator” on page 136 for more 
information.

When you select an ex periment and the Preprocessing and Ana lysis 
options have not been tur ned on or set t o apply, the program shows the 
log ratio data of select ed arrays in the active experiment, if certain 
options have been s et. See “To locate and display data (or results) wit hin 
the Views” on page 86 for more information.

When you select an ex periment and Preprocessing and Anal ysis options 
have been turned on or set t o apply, the program automatically begins t he 
analysis of the selected array data with current settings and displays its 
results. 

This section describes how to select an experiment, select or deselect 
arrays for further analysis, and anal yze arrays one at a time. 

To select an experiment

When you select an experiment, the program begins the analysis with the 
current settings. You can eit her set the Preprocessing and Analysis 
parameters before you select the experiment or change t he settings one at 
a time af ter the first analysis and reanalyze. Every time you change a 
Preprocessing or Anal ysis setting for an active experiment, the program 
recalculates results.

1 If necessary, do one of the following to add the desired experiment to 
the Experiment P ane in t he Navigator:

• Create a ne w experiment and add dat a to it. See “To create a new 
experiment” on page 51.

• Import a saved experiment f ile. See “To import an exp eriment 
file” on page 49. 

2 In the Navigator, double- click the name of the experiment.

The Experiment Selection dialog box appears.

3 Click Yes.
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To select or deselect arrays in the experiment
In the Experiment pane of t he Navigator, the name of the experiment 
turns blue. The name also appears in the title bar of t he main window. 
Tables of data and design inf ormation appear in Tab View. 

If you have selected to show the results of an algorithm calculation, then 
results appear for the first array when you select the experiment, if you 
have not selected any other arrays. 

You can select or deselect arrays in the experiment before or after you 
select the experiment. Every time you select or deselect an array in a 
selected experiment or ch ange a setting, the program reanalyzes the new 
data set with the changed settings . See “To select or deselect arrays in the 
experiment” on page 79.

When you select the experiment after deselecting it o r selecting another 
one, the experiment is sim ply restored if the settings in t he UI haven’t 
changed. If they have changed, the program reanalyzes all of t he arrays 
assigned when the experiment was last selected.

To select or deselect arrays in the experiment

To include ar rays for display and anal ysis, you select them from the 
arrays available, either in an inactive experiment or the selected one. 
When you first create an experiment, t he program automatically sets the 
first array in t he experiment for analysis. If y ou do not select additional 
arrays for analysis, only the first one is anal yzed when the experiment is 
selected.

To select the arrays for analysis before experiment selection:

1 Hold down the Shift key to highlight contiguous arrays or hold down the 
ctrl key to highlight noncontiguous ar rays.

2 Right- click the highlighted arrays, and cli ck Select.

Even though the selected arrays do not chang e color, they will change 
color after activation.

In the Navigator, the color or an array’s icon has the following meaning 
after experiment selection:

Array is not sel ected.
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To select or deselect arrays in the experiment
Array is select ed. The specif ic color matches the color of the column 
headings for the array in Tab View. In addition, the program displays 
aberration results and moving averages related to this array in this color. 
To configure a custom color for the array, see “To change the display color 
of an ar ray” on page 81.

To select or deselect arrays in a selected experiment:

1 In the Navigator, expand the folders of the selected experiment.

2 Click the name of an ar ray you want t o include in the display. 

To include additional arrays, hold down the ctrl key while you click 
their names. To include a contiguous block of arrays, click the name of 
the first array in the block, then hold down the Shift key while you click 
the name of the last one.

3 Right- click the name of one of the highlighted arrays, then click Select.

4 After you select t he arrays, if y ou have Analysis options selected 
(Methylation or Batman, for example), clear the options and t hen mark 
them again. The program re- analyzes the data set within the 
experiment and di splays the data in Genome, Chromosome, and Gene 
Views. You can see the data and results f or just t he selected arrays in 
the Selected Arrays tab in Tab View.

To show analysis results if they do not appear, see “To display results 
of analysis” on page 111.

To customize the appearance of t he results in Genome, Chromosome, 
and Gene Vie ws, see “To change scatt er plot appearance” on page 84.

You can also use t he headings of columns in Ta b View that contain array 
data to select and deselect ar rays.

• Click a column heading t o select t hat array only.

• Hold down the ctrl key while y ou click a column heading t o select or 
deselect an array without changing the status of ot her arrays.

• Right- click a column heading to open a shortcut menu with options 
that let you select or deselect that array, or all arrays.

For more information on Tab View, see “Tab View” on page 161.
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To change the display color of an array
To change the display color of an array

The color assigned to an array sets the color of its icon when y ou select 
the array within an experiment. It also changes t he colored square in the 
array’s column heading in Tab Vi ew. 

1 In the Experiment pane, in t he Experiments folder, expand the folder of 
an experiment until y ou can see t he array whose color you want to 
edit.

2 Right- click the desired array, then click Edit Array Color.

The Select Color dial og box appears. The dialog  box offers three 
different ways to choose the desired color. See “Select Color” on 
page 216.

3 Select the desired color in one of the following ways:

Samples of t he color in dif ferent contexts appear under Preview. The 
upper half of the color sample on the right shows the original color for 
comparison.

4 Adjust the color as desired, t hen click OK.

Dialog box tab Instructions

Swatches • Click the desired color swatch.

HSB 
(Hue/Saturation/Brightness)

Type or adjust the values in H (Hue), S (Saturation), and B 
(Brightness), or alternately, follow these steps:

a Select H, then drag the slider to select a hue based on the 
color strip to its right.

b Click an appropriate location in the large color box to the 
left of the slider to set the saturation and brightness levels 
of the color.
Both the HSB and equivalent RGB values of the color 
appear in the dialog box. Note these values; they will be 
useful if you need to duplicate this color in the future.

RGB (Red/Green/Blue) Do any of the following. Note the final RGB Values; they will be 
useful if you need to duplicate this color in the future.

• Drag the Red, Green, and Blue sliders.
• Type or adjust values in the boxes to the right of the sliders.
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To display the scatter plots
You can al so manage all of t he colors for all of t he arrays in an 
experiment. Right- click the desired experiment, then click Edit Array 
Color. For more inf ormation, see “Edit Array Color” on 
page 186.Displaying Array Data

After you select an experiment, y ou can change how data appear wit hin 
the Views or change the appearance of the Views that contain the data (or 
results).

To display the scatter plots

By default, display of scatter plots is turned On. If you do not see the 
scatter plot(s), do one of the following:

1 From the View tab, click View Preferences. See “View Preferences” on 
page 236 for more inf ormation.

2 In the View Preferences dialog box, under Data Visibility, select All 
views and then mark the box next to Scatter Plot. 

OR

1 Right- click in any of the views, and se lect View Preferences. See “View 
Preferences” on page 236 for more information.

2 In the View Preferences dialog box, under Data Visibility, select All 
views and then mark the box next to Scatter Plot. 
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To show or hide data in the scatter plots
To show or hide data in the scatter plots

1 In the Gene View, move the mouse cursor over the arrow next to 
Scatter Plot, and do any of the following:

2 Click X to close the Scatter Plot window.

To customize scatter plot ranges and colors

In order to make it easie r to see significant results, you can cu stomize the 
display of scatter plot data. For each data type (Z- Score, Log Ratio,  probe 
score) you can set custom ranges and colors for the display. For channels, 
you can set custom colors only.

Add and customize a range

1 In Gene View, move the mouse pointer over Scatter Plot to display the 
options.

2 Mark the check box under Methylation Results or Log Ratios.

3 Select a data type from the Color by list.

4 Click Configure Color and Ranges.

To do this Follow these steps

Show or hide the Methylation 
Results plot and color the results 
by Z-Score values 

• To show the data points – Mark the Methylation Results 
check box and select Z-Score Values from the list. 

• To hide all data points – Clear the Methylation Results 
check box.

Show or hide Log Ratio values in 
the Log Ratios plot

• To show the data points – Mark the Log Ratios check box 
and select Log Ratio Values from the list. 

• To hide all data points – Clear the Log Ratios check box.

Show or hide log ratios and 
color-code them by Probe Score 
values in the Log Ratios plot

• To show the data points – Mark the Log Ratios check box 
and select Probe Score Values from the list.

• To hide the data points, Clear the Log Ratios check box.

Change the ranges and colors for 
all scatter plots

• Click Configure Color and Ranges to enter ranges and 
change colors. See “Configure Coloring Ranges and 
Shades” on page 174 for more information.
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To change scatter plot appearance
The Configure Coloring Ranges and Shades dialog box appears where 
you set ranges and colors f or any of the data types. For more 
information, see “Configure Coloring Ranges and Shad es” on page 174.

5 In the Configure Coloring ranges and Shades dialog box, click the 
Methylation Results or Log Ratios tab and then select the data type to 
configure.

6 Enter minimum and maximum numbers to define a range for the data 
type. 

7 Click Color to open the Select Color dialog box. Use the tabs to select 
a color for the range. See “Select Color” on page 216 for more 
information.

8 Click OK to close the Select Color dialog box and retur n to the 
Configure Coloring ranges and Shades dialog bo x.

9 Click Add Range to add the custom range to the range list.

10 When you are done, click OK to close the dialog box.

Edit or remove a range

1 In the Configure Coloring ranges and Shades dialog box, click the 
Methylation Results or Log Ratios tab and then select the data type to 
configure.

2 In the range lis t, mark t he Edit/Delete box to select the range. You can 
mark more than one range.

3 Click Edit Range to change the minimum and maximum values, or to 
change the color for the selected range.

4 Click Delete Range to delete the selected range.

5 Click OK to close the dialog box.

To change scatter plot appearance

You use the View Preferences dialog box to change t he appearance of the 
scatter plots in Chr omosome and Gene vie ws.

1 Right- click any part of a scatter plot, then click View Preferences. 

Or, click the View tab, and t hen click View Preferences.
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To change scatter plot appearance
The View Preferences dialog box appears. See “View Preferences” on 
page 236.

2 Do any of t he following:

3 Click OK.

To do this Follow these steps

Show or hide the scatter plot a In the View tab under Data Visibility, in View, select All 
Views.

b Do one of the following:
To show the scatter plot, mark Scatter Plot.

To hide the scatter plot, clear Scatter Plot.

c Click OK.

Change the symbol that 
appears for data points

You can select the symbol separately for each design type.
a In the View tab, under Rendering Patterns, select the 

desired Design type.
b Under Styles, for each data type, select the desired symbol.
c Click Apply.

Show a separate scatter plot 
in Gene and Chromosome 
Views for each selected array

a In the View tab, under View Alignment, under Rendering 
Style, select Stacked.

b Click Apply.

Show one scatter plot that 
contains data for selected 
arrays

a In the View tab, under View Alignment, under Rendering 
Style, select Overlaid.

b Click Apply.

Enable ToolTips for the 
scatter plot in Gene View

ToolTips show information about an individual data point when 
you place the pointer over it.
a Click the View tab.
b Under Data Visibility, in View, select Gene View.
c Mark Scatter Tool Tip.
d Click Apply.
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To print the scatter plot
To print the scatter plot

You can print t he scatter plot as it appears in Genome, Chr omosome, and 
Gene views. Each view selected in t he analysis is pr inted on separate 
pages. Chromosomes and genes  appear on the printed pages, but tracks do 
not.

1 In the Home tab, click Print.

The Print dia log box appears.

2 Set print options, t hen click OK.

To create custom scales for Views

You can customize the scale used for display in the Chromosome View and 
Gene View. Custom scales are applied t o both views.

1 Click the View tab and then click View Preferences.

2 In the View Preferences dialog box, under Configure Scales, mark the 
box next t o Apply for Methylation Results and/or  Log Ratios.

3 In Range, type a value to use for the range. The range you type changes 
the scale for the display of t he selected data.

To locate and display data (or results) within the Views

To look through the data of the selected arrays, do any of the following. In 
general, all views are synchronized; if y ou select a location or region in 
one view, the other views move there as well.

To do this Follow these steps

Select a specific chromosome 
to display

• In Genome View, click the chromosome. 
All other views switch to the selected chromosome.

Display data in a region of the 
selected chromosome

• In Chromosome View, drag the pointer over the region.
Gene View expands (or shrinks) to show only the selected 
region. Tab View scrolls to the new cursor location.
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To locate and display data (or results) within the Views
Zoom in and out in Gene View • Click  to zoom in.

• Click  to zoom out.

Scroll through the selected 
chromosome

• Click  to scroll up.

• Click  to scroll down.
Note: These arrows will appear side by side for horizontal 
orientation.

Re-center Gene View or 
Chromosome view

Click anywhere in Chromosome View, or anywhere within the 
scatter plot in Gene View. 
The location you click becomes the new cursor location.

Move all views to a specific 
genomic location

a Click Home > Go To Gene/Genomic location.
A dialog box appears.

b Under Genomic Location, select a Chromosome, and type a 
Base Position.

c Click Go.
All views move to the selected location.

Display the location of a 
specific gene in the center of 
all Views

a Click Home > Go To Gene/Genomic location.
A dialog box appears.

b Under RefSeq by Symbol, either select the gene (if 
available) or type the name of the gene.

c Click Go.
All views move to the location of the selected gene.

Display the data selected in 
Tab View in the center of 
Chromosome and Gene Views

• In Tab View, click any entry in any table, except a column 
heading.
Chromosome and Gene views: The genetic location of the 
selected data appears in the center of Chromosome and 
Gene Views.

Scroll to a specific column in 
Tab View (for the selected 
chromosome)

a In Tab View, right-click any column heading, then click 
Scroll To Column.
The Scroll to Column dialog box appears. See “Scroll to 
Column” on page 214.

b In Select Column, select the column.
c Click OK.

To do this Follow these steps
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To locate and display data (or results) within the Views
Zoom in and out in Gene View • Click  to zoom in.

• Click  to zoom out.

Scroll through the selected 
chromosome

• Click  to scroll up.

• Click  to scroll down.
Note: These arrows will appear side by side for horizontal 
orientation.

Re-center Gene View or 
Chromosome view

Click anywhere in Chromosome View, or anywhere within the 
scatter plot in Gene View. 
The location you click becomes the new cursor location.

Move all views to a specific 
genomic location

a Click Home > Go To Gene/Genomic location.
A dialog box appears.

b Under Genomic Location, select a Chromosome, and type a 
Base Position.

c Click Go.
All views move to the selected location.

Display the location of a 
specific gene in the center of 
all Views

a Click Home > Go To Gene/Genomic location.
A dialog box appears.

b Under RefSeq by Symbol, either select the gene (if 
available) or type the name of the gene.

c Click Go.
All views move to the location of the selected gene.

Display the data selected in 
Tab View in the center of 
Chromosome and Gene Views

• In Tab View, click any entry in any table, except a column 
heading.
Chromosome and Gene views: The genetic location of the 
selected data appears in the center of Chromosome and 
Gene Views.

Scroll to a specific column in 
Tab View (for the selected 
chromosome)

a In Tab View, right-click any column heading, then click 
Scroll To Column.
The Scroll to Column dialog box appears. See “Scroll to 
Column” on page 214.

b In Select Column, select the column.
c Click OK.

To do this Follow these steps
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To locate and display data (or results) within the Views
Search for a specific column 
entry in Tab View, and move 
the cursor there

a In Tab View, right-click any entry except a column heading, 
then click Find in column.
The Find in column dialog box appears. See “Find in 
column” on page 197.

b Set the search parameters, then click Find Next.
The program searches the column using your search 
parameters, and highlights the row of the first entry that 
matches. The cursor moves to the location defined in the 
highlighted row.

Display the exact 
chromosomal location of the 
cursor

At the bottom of the main window, look at the first cell of the 
Status bar. The location appears as the chromosome followed 
by the base position. For more information on the status bar, 
see “Status Bar” on page 165.

To do this Follow these steps
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Displaying Content (Gene Lists/Tracks)
Displaying Content (Gene Lists/Tracks)

To show gene lists in Gene View

A gene list is a set of genes of interest. Within the program, you can 
highlight the genes in the gene list in  Gene Vie w, or limit the display of 
data, genes, and track s to the regions selected by a gene list.

You can im port gene lists into Agilent Genomic Workbench, and y ou can 
also create them in the program and export them. See “To import a gene 
list” on page 66, and “To export a gene list” on page 73.

In Gene Vie w, the names of all genes nor mally appear in g ray. When you 
apply a g ene list, the program highlights the listed genes in their defined 
display color. You can also l imit the genes and/or dat a that appear in 
Gene View and Chromosome View to only the listed genes.

1 In the My Entity List pane of t he Navigator, expand the Gene List 
folder. If the gene list does not appear, create or import it. See “To 
create a gene list” on page 65, or “To import a gene list” on page 66.

2 Right- click the gene list, then do one  of the following to apply it:

• To show all genes and all dat a, and highlight the listed genes in their 
display color, click Highlight.

• To show only the listed genes and only the data for those genes, click 
Show only. 

Gene and Chromosome views change ac cordingly. In t he My Entity List 
pane of the Navigator, the name of the gene list appears in italics. 

To remove the effects of a gene list, right- click the active gene list in 
the Navigator, then click Show All.
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To select gene list display color

In Gene Vie w, the names of all genes nor mally appear in g ray. When you 
apply a g ene list, the program highlights the listed genes in their defined 
display color. You can cu stomize this color.

1 In the My Entity List pane of t he Navigator, expand the Gene List 
folder.

2 Right- click the name of the gene list whose color y ou want t o change, 
then click View in Table.

The Gene List dialog box appears.

3 Under Color, click Color.

A dialog bo x appears. 

4 Select the desired color.

The dialog box offers three different ways to select the color. See “To 
select gene list displa y color” on page 91.

5 Adjust the color as desired, t hen click OK.

6 In the Gene List dialog box, click OK.

To display a gene list as a table

You can display the description of a gene list and the names of the genes 
in it.

1 In the My Entity List pane of t he Navigator, in t he Gene List folder, 
right- click the desired gene list, then click View in Table.

The Gene List dialog box appears. See “Gene List” on page 199. The 
names of t he genes appear in Gene Names. You can also use this dialog 
box to edit the description of the gene list, or to change its display 
color. To change the display color, see “To select gen e list display 
color” on page 91.

2 When you are f inished displaying the list, click OK.

You can also export a gene list. See “To export a gene list” on page 73.
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To change the appearance of genes in Gene View
To change the appearance of genes in Gene View

You use the User Preferences dialog box to change the appearance of the 
genes in Chromosome and Gene views.

1 Right- click any part of the Gene View, then click User Preferences. 

The User Pre ferences dialog box appears.

2 Click Tracks.

See “Tracks tab” on page 231.

3 Do one or mor e of t he following:

4 Click OK.

To show tracks in Gene View

Tracks contain information for specific genomic locations. A multitude of 
tracks from diverse sources is available for many species. You can display 
tracks next t o genes and micr oarray data in Gene Vie w.

1 Select and show microarray data. See “To select an experiment” on 
page 78.

2 In the My Entity List pane, open the Tracks folder.

3 Right- click the track y ou want to display, and click Show In UI.

To do this Follow these steps

Show or hide genes in Gene 
View

a Under Visualization Parameters:
To show genes – Under Genes, mark Show Gene Symbols.

To hide genes – Under Genes, clear Show Gene Symbols.

b Click Apply.

Change the display font for 
genes (and track annotations) 
in Gene View

a In the Gene Symbols tab, under Font, select a new Font, 
Font Style, and Font Size.

b Click Apply

Change the display angle for 
genes (and track annotations) 
in Gene View

a Under Visualization Parameters, under Genes, in 
Orientation (Degrees), type a new orientation in degrees. 
0º is horizontal.

b Click Apply.
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To change the appearance of tracks
Or, you can do this:

1 In Gene View, right- click anywhere within the scatter plot, then click 
User Preferences.

The User Pre ferences dialog box appears. See “User Preferences” on 
page 231.

2 Click Tracks.

3 Mark the Show In UI check box of each trac k.

4 Click OK.

The program displays the selected tracks in Gene View. 

To change the appearance of tracks

In the Tracks tab of the User Preferences dialog box, you can change the 
appearance of track s as described in t he table below.

To do this Follow these steps

Include track information in 
reports

a In the list of tracks, in the Show in Report column, mark the 
check boxes of the desired tracks.

b Click Apply.
Doing this adds a column with the hits from the track file. For 
each aberrant interval, it reports the entries from the track file 
for that interval in that separate column.

Show or hide annotations in 
all tracks

• To show annotations in all tracks: under Tracks, mark Show 
Annotations.

• To hide annotations in all tracks: under Tracks, clear Show 
Annotations.

Display all selected tracks as 
a single track

• Under Tracks, mark Show Overlaid.
The program combines the annotations of all selected 
tracks into a single track named Overlaid Track.

• To show tracks individually again, clear Show Overlaid.

Display the parameters and 
the list of annotations of a 
track 

• In the list of tracks, for the desired track, click Details.
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To show track information in reports
To show track information in reports

1 In the list of tracks, in the Show in Report column, mark t he check 
boxes of t he desired tracks.

2 Click Apply.

Doing this adds a column with the hits from the track file. For each 
aberrant interval, it reports the entries from the track file for that interval 
in that separate column.

Change the display font for 
track annotations (and genes)

a Under Font, select a new Font, Font Style, and Font Size for 
track annotations.

b Click Apply.
The program changes the display font of track annotations 
and genes in Gene View.

Change the order in which 
tracks appear in Gene View.

The order of tracks in the Gene Symbols tab controls the 
left-to-right order of tracks in Gene View.

a Click the name of the track you want to move.
b Do any of the following:

• To move the track up in the list of tracks (and farther left 
in Gene View), click its name, then click Up.

• To move the track down in the list of tracks (and farther 
right in Gene View), click its name, then click Down.

c Click Apply.

Change the display angle of 
track annotations (and genes)

• Under Genes, in Orientation, type a new orientation (in 
degrees). 0º is horizontal.
The program changes the display angle of track annotations 
and genes in Gene View.

To do this Follow these steps

NOTE The annotations that are displayed in tab view are taken from the design file. This may 
include names of genes and other annotations. The positions of these genes may also be 
supplied as a separate Gene track and may contain unnecessary information.
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To limit data to the genomic boundaries of the track
To limit data to the genomic boundaries of the track

1 In the list of tracks in My Entity List, right- click the track whose 
boundaries you want to use to limit the display of the data.

2 Mark Genomic Boundaries.

You can remove the boundaries by clearing the check box.

To display a track in UCSC Browser

1 In the My Entity List pane, expand t he Tracks folder and f ind the track 
you want t o view in the UCSC browser.

2 Right- click the track name, and click Show in UCSC.

The UCSC Browser appears, if you are co nnected to the Internet 
(Figure 17). You may have to enable pop ups or  set your other browser 
preferences on t he UCSC br owser Web site.

3 Follow the instructions on t he web site for what you want to do.

To upload a track to UCSC Browser

1 Right- click Gene Vie w, and click Upload Track to UCSC.

2 The Upload Track to UCSC dialog box appears.

Complete the dialog to define the track you wish t o upload. See 
“Upload Track to UCSC” on page 229.

The UCSC Browser appears, if you are co nnected to the Internet 
(Figure 17). You may have to enable pop ups or  set your other browser 
preferences on t he UCSC br owser Web site.

3 Follow the instructions on t he web site for what you want to do.
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To upload a track to UCSC Browser
Figure 17 Track displayed in UCSC browser
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To change the graphical display to a different genome build

The default graphical display for Genome, Chromosome and Gene Views 
represents human genome build 18. 

• To change the graphical display to a di fferent genome build, select an 
experiment whose data are base d on a design file of a different genome 
build.

The display automatically changes when you select an experiment that 
contains a design file with a different genome build, such as human 
genome build 17, or a mouse or rat ge nome build.

If a genome build is not available for the design file you import, you must 
import the genome build first. See “To import a g enome build” on page 46.

The program will not let you add arrays that belong t o one genome buil d 
to an experiment that contains arrays of a different genome build.

See also “To create a new experiment” on page 51, “To add arrays to an 
experiment” on page 53, and “To select an experiment” on page 78.
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Searching for Probe and Gene Information

To search Tab View for specific probe information 

You can find a specific entry in a column of a d ata table in Tab View. For 
more information on Tab Vie w, see “Tab View” on page 161.

1 In Tab View, right- click anywhere in the column you want to search, 
then click Find in column.

The Find in col umn dialog box appears. The search column also 
appears in t he title bar of the dialog box.

2 Set the search parameters, as described  below.

3 Click Find Next.

If the program finds a match, it highl ights the row that contains the 
matching entry, and res ets the cursor to the corresponding position. 
You can click Find Next as man y times as y ou want, and the program 

NOTE The Find in column function works within the selected chromosome.

Parameter Comments/Instructions

Find in column • Type the text you want to find (the search term). This can be an entire 
entry, or part of one.

Direction • Select one of these options:
• Up – Search the column upwards from the current cursor location 

(the highlighted row of the table).
• Down – Search the column downwards from the current cursor 

location (the highlighted row of the table).
Tip: Click a row in Tab View to highlight it.

Conditions • Mark any of these, as desired:
• Match Case – Find entries that match upper and lower case 

characters in the search term.
• Match whole word – Find an entry only if the entire entry matches 

the search term.
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continues to search for additional ma tching entries in t he column. If it 
finds no mat ch, the message: String not found appears in black in t he 
lower part of t he dialog box.

4 When you complete your search, click Cancel to close the dialog bo x.

To search Agilent eArray for probe information

You can use the chromosomal region that appears in Gene Vie w, or 
another chromosomal region as the basis for a probe search on the Agilent 
eArray Web site. eArray is a powerful microarray design system for CGH, 
ChIP and gene ex pression applications. It contains a massive database of 
validated, annotated probes, and a full co mplement of tools for custom 
microarray design. 

Before you can sear ch for probes in eArray, you must regist er for an 
eArray account if y ou do n ot already have one. For more information, go 
to https://eArray.chem.agilent.com. Provide your eArray user name and 
password in t he Miscellaneous tab of t he User Preferences dialog box. See 
“User Preferences” on page 231.

1 In Gene View, right- click anywhere in t he plotting area, then click 
Search probes in eArray.

The Search probes in eArray dialog box appears. See “Search Probes in 
eArray” on page 215.

2 Do one of the following to define the chromosomal region for your 
search:

• To set the region to the one that currently appears in Gene View, 
select For complete gene view.

• To set t he region numerically, select User Defined, then select a 
Chromosome and type Start and Stop locations f or the desired 
region.

3 Click OK.

The eArray Web portal opens in y our internet browser. 
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To search the Web for information on probes in Tab View

You can use  any entry in a table in Tab View as t he basis for a Web 
search. 

1 In Tab View, right- click any data table entry other than a column 
heading. 

2 Click one of  the available sites.

If the site of interest does not appear in the shortcut menu, you can 
create a custom search link. See “To create a custom Web search link” 
below.

The selected site opens in your Internet browser. The pr ogram sends 
the table entry to the site as a search string.

To create a custom Web search link

If you need t o search a dif ferent database or site based on dat a table 
entries, you can create your own custom search link. When you right- click 
a table entry in Tab Vie w, a shortcut menu opens, and your custom link 
appears in it. If  you select this link, Agilent Genomic Workbench opens the 
site in your Web browser and send s the table entry to the site as a search 
string.

1 Right- click any data table entry in Tab View, except a co lumn heading, 
then click Customize Link.

The Customize Search link dialog box appears. See “Customize Search 
Link” on page 182.

2 Click New.

3 In the Input dialog box, in URL name, type a name f or the link.

This name will appear in t he shortcut menu that opens when you 
right- click a data table entry.

4 Click OK.

5 In URL, type t he complete URL needed to send a search string to the 
site. Use <target> as t he query string value. 

For example, this URL sends select ed table entries to Google.com:
http://www.google.com/search?hl=eng&q=<target>

6 Click Update, then click Yes.
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To update or delete a custom Web search link

1 Right- click any data table entry in Tab View other than a column 
heading, then click Customize Link.

The Customize Search link dialog box appears.

2 In URL Name, select the custom search link to update or delet e.

3 Do one of t he following:

4 Click Close.

To do this Follow these steps

Update a Web search link a Edit the URL name and the URL as needed.
b Click Update.

A Confirm dialog box appears.
c Click Yes.

Delete a Web search link • Click Delete.
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Setting Up Methylation (CH3) Analysis

Working with Methylation Options 104

Changing Preprocessing and Analysis options 105

Displaying results and generating reports 111

This chapter gives instructions on how to set up t he analysis functions for 
Methylation (CH3) Analysis experiments. These include the Preprocessing, 
Analysis and Repor ts tabs.
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Working with Methylation Options
Working with Methylation Options

For a detailed description of the Methylation (CH3) analysis tabs and their 
commands – Prepr ocessing, Analysis, Reports – see Chapter 5, 
“Methylation (CH3) Analysis Reference”.

Figure 18 Tabs available in the CH3 application

Table 1 de scribes the sections in t his chapter and the tasks you do d uring 
interactive analysis.

Table 2 Methylation analysis topics

Subject See these topics

Changing Preprocessing 
and Analysis options

“To combine (fuse) arrays” on page 105

“To set up a moving average (Log Ratio) calculation to smooth the 
data” on page 107

“To set up a moving average (ZScore) calculation to smooth the 
data” on page 108

“To apply methylation (CH3) event detection” on page 109

“To apply BATMAN (Bayesian Tool for Methylation Analysis)” on 
page 110

Displaying results and 
generating reports

“To display results of analysis” on page 111

“To upload a track to UCSC” on page 113

“To save a result” on page 114

“To restore a saved result to the display” on page 115

“To generate a probe report” on page 115

“To generate a Batman report” on page 118
104 Methylation (CH3) Analysis Guide



Setting Up Methylation (CH3) Analysis 4
Changing Preprocessing and Analysis options
Changing Preprocessing and Analysis options

To combine (fuse) arrays

If you have two arrays that use different design files, you can combine 
(fuse) them into one larger virtual array. You do this to increase the 
coverage of t he genome in your design. If f or example, you have a catalog 
array, you can design another array to add pr obes between the catalog 
probes to increase the density of coverage. With the Fuse function, you 
can combine the array data to see all t he probe data in t he display at 
once. The program cannot combine arrays from more t han two different 
design files.

Requirements for fusing arrays:

• Each array has a different design f ile.

• All of the arrays are of the application type. (F or this application, 
CH3.)

• None of the arrays are fused arrays.

• The samples you hybridize to the arrays are all aliquots from the 
same preparation. 

• (Preferred) Hybridization and labe ling occur for all samples together 
under the same conditions.

1 Create and sel ect a ne w experiment. See “To create a new 
experiment” on page 51 and “To select an experiment” on page 78.

2 Add the arrays to be combined to the experiment. See “To add arrays 
to an experiment” on page 53.
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To combine (fuse) arrays
3 Assign the same value to the ArraySet attribute of every array you 
want to combine. Follow these steps for each ar ray:

a In the Experiment pane of the Navigator, right- click the name of the 
array, then click Show Properties. 
The Microarray Properties dialog box appears.

b Next to the ArraySet attribute, under Value, click .
A text box appears.

c Type a value in t he text box. Type the same value for the ArraySet 
attribute of e very array.

d Click Close.

4 In the Preprocessing tab, under Combine, click Fuse.

The Array Set dialog box lists the arrays to be combined. See “Array 
Set” on page 169.

5 Set any of t hese options, as desired:

• Select Normalization – Select None or Centralization. Centralization 
adds or subtracts a co nstant value from each log rati o measurement. 
This recenters the log ratio  values, and makes sure t hat the 
zero- point reflects the most common ploidy st ate.

• Remove arrays from experiment after fuse – To delete the initial 
individual arrays from the experiment, mark this option so that the 
experiment will not contain duplicate data.

6 Click Continue. 

The program combines the arrays. The new array appears in t he 
Experiment pane of the Navigator in a new design f older within the 
active experiment. The f older name contains the names of bot h designs.

NOTE Double-check the values in the ArraySet Attribute column of the dialog box. Agilent 
Genomic Workbench combines all of the array pairs that have the same value for this 
attribute.
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To set up a moving average (Log Ratio) calculation to smooth the 
data

With the Moving Average tool, a moving average is com puted for each 
point in the data set using a sliding window of f ixed size, centered on that 
point. This algorithm uses the pre- algorithm probe log ratios to calculate a 
moving average line plot. See “Visualization algorithms” on page 245.

1 In the Analysis tab, under Moving Average, mark o r clear Show to 
show or hide  the Moving Average Line Plot.

2 In Algorithm, select Linear or Triangular.

• Linear – The linear a lgorithm calculates a st andard, unweighted 
average using every probe Log Ratio score within a specified window 
size (specified by either a number of adjacent measurements or a 
positional range). This average is applied sequentially to every point 
by moving the window along t he chromosome. See “Moving average 
(linear smoothing)” on page 261.

• Triangular – The tria ngular algorithm calculates a weighted average 
using every probe Log Rati o within a specified window size. The 
triangular algorithm is more sensitive to localized v ariations in t he 
data. See “Triangular smoothing” on page 262.

3 In Line width, select the thickness (in pi xels) of the Moving Average 
Line Plot.

The range is 1- 5 pixels.

4 In Window, select the size of the moving average window. 

Moving averages are computed with windows of sizes based on either a 
specific length of base- pairs (5 Kb to 50 Kb or .1 Mb to 50 Mb) or a 
fixed number of dat a points (1 pt. to 60 pt.).

NOTE • If the original arrays change, you can manually update the combined array. Fuse the 
same set of arrays again. 

• If you want to combine many arrays, consider importing an array attributes file. See “To 
import array attributes” on page 48.

• When you combine (fuse) arrays, the centralization algorithm (if selected) is applied to 
the individual arrays before they are combined.
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To set up a moving average (ZScore) calculation to smooth the data

The Moving Average (ZScore) applies a moving average to each point in 
the combined methylation Z- score data set using a sliding window of fixed 
size, centered on that point. This algorithm uses t he post algorithm 
combined Z- scores to calculate a moving average line plot. See “Overview 
of Methylation Detection and Visualization Algorit hms” on page 244.

1 In the Analysis tab, in the Moving Average (ZScore) group, mark or 
clear Show to show or hide  the Moving Average Line Plot.

2 In Algorithm, select Linear or Triangular. See “Visualization 
algorithms” on page 245.

Linear – The linear algorithm calculates a standard, unweighted average 
using every combined Z- score within a window size (that is defined by 
either a number of adjacent measurements or a positional range). This 
average is applied sequentiall y to every point b y moving the window 
along the chromosome. See “Visualization algorithms” on page 245.

Triangular – The tria ngular algorithm calculates a weighted average 
using every combined Z- score within a specified window size. The 
triangular algorithm is more sensitive to localized variations in the data. 
See “Triangular smoothing” on page 262.

3 In Line width, select the thickness (in pi xels) for the Moving Average 
Line Plot.

The range is 1- 5 pixels.

4 In Window, select the size of the moving average window, or typ e the 
size of t he window. 

Moving averages are computed with windows of sizes based on either a 
specific length of base- pairs (5 Kb to 50 Kb or .1 Mb to 50 Mb) or a 
fixed number of dat a points (1 pt. to 60 pt.). 

The window can be set manuall y to as l ow as .5 Kb (type .5 Kb).
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To apply methylation (CH3) event detection

The purpose of a methylation detection algorithm is to identify 
methylation sites located within genomic regions such as pro moters, CpG 
islands, etc. It is u sed in conjunction with CpG Island tracks that either 
already exist in t he program’s database or that you import.

1 Set up genomic region tracks (such as CpG islands) in Ge ne View.

See “To import tracks” on page 47 for instructions on how to import 
and display these tracks in Gene View and in t he report.

2 Select the experiment now, or after step 3.

See “To select an experiment” on page 78.

3 Click Analysis. 

4 Under Probe Methylation Select ZScore, select the algorithm, and then 
mark Apply. 

The Probe Methylation Status Setup dialog box appears. 

See “Probe Methylation Status Setup” on page 211.

5 To select a Tm (melting temperature) mapping file, click Browse and 
find the folder containing the file.

6 Select the file, and click Open.

7 Click Continue.

The algorithm is automatically applied if you’ve already selected the 
experiment, or is applied when you select it. To learn how the algorithms 
work see “Methylation Detection and Measurement Algorithms” on 
page 246.

The Z- score or BATMAN score results appear in a second ch annel of Gene 
View next t o the log ratio data. You can no w calculate a moving average 
for the Z- scores. See the next topic.
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To apply BATMAN (Bayesian Tool for Methylation Analysis)

When BATMAN is selected, a Bayesian tool is used to calculate 
methylation results (B ATMAN). The B ATMAN algorithm reflects the 
underlying distribution of CpG dinu cleotides by calculating a Gaussian 
distribution of methylated sites to give the observed probe signal. The 
signal used in BATMAN is either the probe log ratio or the methylation 
detection algorithm Z-  score. For more information on the BATMAN 
algorithm, see “Bayesian tool for methylation analysis (BATMAN)” on 
page 256.

1 In the Analysis tab, under Batman, mark the check box to enable the 
Batman algorithm.

The Batman Parameter Setup dialog box is dis played. See “Batman 
Parameter Setup” on page 170.

2 Complete the Batman Parameter Setup and click Continue to apply the 
calculations and show results in t he views.
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Displaying results and generating reports

The section shows you how to make sure the analysis results are displayed 
automatically after you select an experiment. To learn more about what 
the results mean, see “Visualization algorithms” on page 245.

To display results of analysis

After you set up an experiment and anal yze it, t he program displays the 
results automatically in Genome, Chromosome, and Gene Views if the 
display is tur ned on. Figure 19 and Figure 20 show examples of results 
displayed in the Gene View. To customize the way the results appear, see 
Chapter 3, “Displaying CH3 Dat a and Ot her Content”.

Results for probe methylation and log ratios compared to a CpG Island track

Figure 19 Gene View, showing Z-score data next to log ratios and a CpG Island track
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Results for moving averages within genomic boundaries of CpG Island track

If the analysis results do not appear in any of the Views

Check these four potential problem areas, in or der:

• Make sure you have marked the Apply check box. Under Analysis, mark 
Apply for Probe Methylation and/or Batman.

• Make sure you have selected the experiment or se lected the arrays of 
interest. See “To select an experiment” on page 78.

• Make sure you have turned on t he display for the moving averages or 
the Z- score algorithm. Do the following:

1 Right- click any of t he Views, and click View Preferences. 

2 Click the View tab.

3 Under Data Visibility, in View, select All views, then mark any of 
the check boxes for the information to display.

Figure 20 Gene View, showing moving averages within genomic boundaries of tracks
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You can also select a single View.

4 Click OK.

• Make sure you are looking in the correct region of Chromosome View.

See Chapter 3, “Displaying CH3 Dat a and Other Content” to find out how 
to display the Scatter Plot and how to search the View displays to see 
results.

To upload a track to UCSC 

The program lets you upload methylation results t o the UCSC Web site for 
further review.

1 Right- click in Ge ne View and select Upload track to UCSC.

The Upload Track to UCSC dialog box appears. See “Upload Track to 
UCSC” on page 229.

2 Complete the dialog bo x, (mark Methylation Score under Select Track 
Source) and clic k OK.

The track is uploaded to the UCSC Web site (Figure 21). Enable pop 
ups or set preferences on the UCSC Web site, if necessary.

3 Follow the instructions on the UCSC Web site to review your data.
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To save a result
Figure 21 Uploaded track in UCSC browser

To save a result

The program lets you save the current result of the active experiment. You 
can run many different analyses in t he same experiment, and save each 
one. Later, you can rest ore any of y our saved results.

If you are saving a result for the first time for the experiment:

1 In the Experiment pane of t he Navigator, right- click the experiment, 
and click Save Experiment Result, or

Click Home > Save Experiment Result.

A dialog box asks if y ou want t o save the results of t he current 
experiment.

2 Click Yes.

The Save experiment result dialog box appears. 

3 Type a name for the result, then click OK.
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If you have already saved at least one result for the experiment:

1 In the Experiment pane of the Navigator, expand the folders of the 
current experiment.

The currently selected result, if an y, appears in blue in the Results 
folder.

2 Click Home > Save Experiment Result or

Right- click the experiment, and cl ick Save Experiment Result.

A dialog box asks if y ou want t o select one of the following actions:

• To replace t he current result wi th another saved result, click 
Overwrite Current Result.

• To add the current results to the list of experimental results, click 
Create New Result.

• To change vie ws to another result without changing the current 
result, click Continue Without Saving.

To restore a saved result to the display

1 If necessary, select the experiment that contains the result that you 
want to see. See “To select an experiment” on page 78.

2 In the Experiment pane of the Navigator, expand the folder of the 
active experiment, t hen expand its Results folder.

3 Right- click the desired result, then click Restore result.

The restored result appears in Ge nome, Chromosome, and Gene Views.

To generate a probe report

The probe report includes the following information either for single 
chromosomes or t he complete genome:

• Log ratio for each event

• Number of probes

• Start and st op of each e vent
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• Whether the probe is in a CpG island, a p romoter, or inside a g ene 
boundary

• Probable gene f or the probe

1 Click Reports, then click Generate Report.

The Probe Methylation Report Setup dialog box appears. 

2 To select if y ou want a repor t to include the results f or the whole 
genome or f or individual chromosomes, click either Complete Genome 
or Per- Chromosome.

3 Click Browse to find the folder for containing the report(s).

4 Type the report name, and click Open.

The report file name has the extension .xls.

5 Click OK.

6 When asked if y ou want t o display the report, click Yes.

If you selected Complete Genome, an Ex cel spreadsheet appears containing 
all the data:
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If you selected Per- Chromosome, the text files for the individual 
chromosomes appear in the folder you selected.

Figure 22 Excel methylation report for Complete Genome
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To generate a Batman report

The Batman report includes the following information either for single 
chromosomes or for the entire genome: 

• Cytoband name

• Chromosome name

• Probe name

Figure 23 List of text methylation reports for each chromosome
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• Start and St op of each e vent

1 Click Reports and t hen select Generate Batman Report.

The Batman Report Dialog dialog bo x opens. See “Batman Report 
Dialog” on page 171.

2 To select if y ou want a repor t to include the results f or the whole 
genome or f or individual chromosomes, click either Complete Genome 
or Per- Chromosome.

3 Click Browse to find the folder for containing the report(s).

4 Type the report name, and click Open.

The report file name has the extension .xls.

5 Click OK.

6 When asked if y ou want t o display the report, click Yes.

If you selected Complete Genome, an Ex cel spreadsheet appears containing 
all the data:
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Figure 24 Excel Batman report for complete genome

If you selected per- chromosome for the report output, the text files for the 
individual chromosomes appear in t he folder you selected.
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Agilent Genomic Workbench CH3 Application Main Window 122

Switch Application Menu 123

Command Ribbons 124

Navigator 136

Genomic Viewer 152

Status Bar 165

Dialog Boxes 166

Report Format 240

This chapter describes the parts of the Agilent Genomic Workbench main 
window that you use t o import, organize, manage, export and display 
array data and other content. It also describes the tab commands, 
shortcut menus, and dialog boxes that can appear. 
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Agilent Genomic Workbench CH3 Application Main Window

The main window of t he CH3 Application contains the major components 
illustrated in Figure 25.

Figure 25 Agilent Genomic Workbench 7.0 – CH3 application main window

Cursor
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Switch Application
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Switch Application Menu 

Figure 26 Switch Application menu

The Switch Application menu lets you change to the other data display 
and analysis application type in DN A Analytics. Mark the desired 
application type.

CGH (Separate license required) Imports, displays, and anal yzes array- based 
comparative genomics hybridization (aCGH) data in both an int eractive 
“analyze as you go” mode, and an automated workflow mode.

ChIP (Separate license required) Imports, displays, and anal yzes ChIP- on- Chip 
microarray data in bot h an interactive “analyze as you go” mode, and an 
automated workflow mode.

CH3 (Separate license required) Imports and displa ys data from 
microarray- based studies of genomic methylation patterns.

SureSelect Target
Enrichment

Use the Quality Analyzer function for SureSelect Target Enrichment. See 
the SureSelect Quality Analyzer User Guide for more information.
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Command Ribbons

When you click a t ab, groups of commands or single commands appear a t 
the top of the tab. This group of commands is called a command ribbon. 
The interactive tabs of t he CH3 Applicati on include Home, Preprocessing, 
Analysis, Reports, View, and Help ( Figure 27). This section provides 
descriptions of t he commands for each of these tabs, as well as for the 
Help tab. Descriptions of the remaining tabs are located in t he following 
guide:

• Sample Manager — Sample Manager User Guide

Figure 27 Tab bar with command ribbon

Home command ribbon 

The Home command ribbon displays the functions that let you import, 
manage, export and di splay CH3 data and cont ent for further CH3 
analysis.

Figure 28 Home command ribbon

User Preferences Opens the User Preferences dialog box with the following tabs:
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Home command ribbon
Import Opens a menu of f ile types that you can import:

Tab Description

Tracks Opens a dialog box that lets you manage which tracks to display in 
Genomic Viewer and how they appear. See “User Preferences” on 
page 231.

Miscellaneous Opens a dialog box where you can select a new location for your 
data files and set up access to the eArray web site. See “User 
Preferences” on page 231.

License Opens a dialog box where you can enter an Agilent Genomic 
Workbench application license, if you purchase one after using the 
unlicensed version. See “User Preferences” on page 231.

Option Description

Array Files Opens a menu with these options:
• FE File – Opens the Import FE Files dialog box, where you can 

select an Agilent Feature Extraction array data file to import. 
See “Import” on page 201 and “To import Agilent FE or Axon 
data files” on page 41.

• Axon File – Opens the Import Axon Files dialog box, where you 
can select Axon (*.gpr) files for import. See “Import” on 
page 201 and “To import Agilent FE or Axon data files” on 
page 41.

• UDF File – Opens the UDF Files dialog box, where you can select 
a Universal Data File (UDF) to import. See “Import” on page 201 
and “To import a UDF file” on page 43.

Design Files Opens a menu with these options:
• GEML File – Opens the Import Design Files dialog box, where 

you can select Agilent GEML-based (*.xml) array design files for 
import. See “Import” on page 201 and “To import Agilent GEML 
design files” on page 39.

• Axon Design File – Opens the Import Axon Design Files dialog 
box, where you can select Axon (*.gal) array design files for 
import. See “Import” on page 201 and “To import Axon design 
files” on page 41.

Genome Build Opens the Import Genome Build dialog box, where you can import 
Agilent-supplied genome build files. See “Import Genome 
Build” on page 205 and “To import a genome build” on page 46.
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Home command ribbon
Export Opens a menu that lets y ou export several kinds of f iles.

Create
Experiment

Opens the Create Experiment dialog box, where you can create a new, 
empty experiment and add data to it. S ee “Create Experiment” on 
page 178 and “To create a new experiment” on page 51.

Save Experiment
Results

Opens a confirm dialog box. Click Yes and t he Save experiment result 
dialog box opens where you enter a name and description for the results 
to save.

Array Attributes Opens the Import microarray attributes dialog box, where you can 
select a microarray attributes file. See “Import” on page 201.

Track Opens the Import Track dialog box, where you can select a BED 
format track file for import, and create a display name for the track. 
See “Import Track” on page 206 and “To import tracks” on page 47.

Experiments Opens the Import Experiments dialog box, where you can select a 
ZIP format experiment file for import. See “Import 
(experiments)” on page 203 and “To import an experiment file” on 
page 49.

Option Description

Option Description

Experiments Opens the Export Experiments dialog box, where you can select 
one or more experiments for export as a single ZIP file. See “Export 
Experiments” on page 195 and “To export experiments” on 
page 72.

Tracks Opens the Export Tracks dialog box, where you can select one or 
more tracks to export as a single BED format file. See “Export 
Tracks” on page 196 and “To export tracks” on page 73.

Array Attributes Opens the Export Array Attributes dialog box, where you can select 
arrays and their attributes for export. See “Export Array 
Attributes” on page 191.
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Go to
Gene/Genomic

Location

Moves the cursor to the location in Chromosome and Gene Views that you 
select. See “Go To Gene/Genomic Location” on page 200.

Print Opens the Print window to print t he display.

Exit Closes the program.
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Preprocessing command ribbon

The Preprocessing ribbon has a single command you use t o prepare for 
CH3 analysis: Fuse. 

The Fuse command lets y ou combine multiple array designs int o a larger 
virtual combined design. It also lets y ou combine both intra-  and 
inter- array replicate probes. 

Click to open the Array Set dialog box, where you can sele ct the names of 
arrays that are combined, set options, and combine designs t ogether to 
form a larger virtual design. See “Array Set” on page 169, and “To 
combine (fuse) arrays” on page 105.

Figure 29 CH3 Preprocessing command
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Analysis command ribbon

The Analysis ribbon contains the commands you use for CH3 anal ysis. 

Moving Average (Log Ratio)

The settings under Mo ving Average(Log Ratio) contr ol the calculation and 
display of line plots t hat represent smoothed log ratio dat a for each 
selected array. These plots can appe ar in Genome, Chromosome, and Gene 
views.

Show Mark this check box to show moving average line plots, o r clear the check 
box to hide them. You turn the display of moving average line plots for 
specific views on or of f from the View tab by selecting View Preferences. 

In View Preferences, under Data Visibility, select the desired view, then 
mark or cle ar Moving Average. See “View Preferences” on page 236.

Algorithm Select one of t hese options:

• Linear – The l inear algorithm calculates a standard, unweighted average 
using every Log Ratio score within a defined window size (specified by 
either a number of adjacent measurem ents or a positional range). This 
average is appl ied sequentially to every point by moving the window 
along the chromosome.

Figure 30 CH3 Analysis ribbon

Figure 31 Moving Average (Log Ratio) command
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• Triangular – The triangular al gorithm calculates a weighted average 
using every Log Ratio within a specified window size. The triangular 
algorithm is more sensitive to l ocalized variations in the data. See 
“Overview of Met hylation Detection and Visualization Algorithms” on 
page 244.

Line width Select the desired thickness (in pixels) for the moving average line plots. 
You can select a thickness from 1 to 5 pixels.

Window Select the desired size of the moving average window. You can select 
either a specific number of base pairs (5 Kb to 50 Mb), or a specific 
number of dat a points (1 pt to 60 pt). Y ou can also type a val ue. The 
program calculates a moving average for each selected array based on a 
window of the given size centered on eac h point in the array.

Moving Average (ZScore)

The settings under Moving Average (Z- Score) control the calculation and 
display of line plots t hat represent smoothed Z- score data for each 
selected array. These plots can appe ar in Genome, Chromosome, and Gene 
views. You must appl y the Probe Methylation algorithm first.

Show Mark this check box to show moving average line plots f or the Z- score 
data, or clear t he check box to hide them. You enable or disab le the 
display of moving average line plots for selected views in Vie w 
Preferences. See “View Preferences” on page 236.

Algorithm Select one of t hese options:

• Linear – The l inear algorithm calculates a standard, unweighted average 
using every combined Z- score within a selec ted window size (specified 
by either a number of adjacent measurements or a positional range). 
This average is applied sequential ly to every point by moving the 
window along the chromosome.

Figure 32 Moving Average (ZScore) command
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• Triangular – The triangular al gorithm calculates a weighted average 
using every Z- score within a selected window size. The triangular 
algorithm is more sensitive to l ocalized variations in the data. See 
“Triangular smoothing” on page 262.

Line width Select the thickness (in pixels) for the moving average line plots. You can 
select a thickness from 1 to 5 pixels.

Window Select the size of the moving average window. You can se lect either a 
number of base pairs (5 Kb to 50 Mb), or a number of data points (1 pt 
to 60 pt). You can also type a value. The pr ogram calculates a moving 
average for each defined array based on a window of the given size, 
centered on eac h point in the array.

Probe Methylation

You apply this command to make Z- score calculations to find out whether 
a Methylation detection  array probe is  methylated or un methylated. See 
“Overview of Met hylation Detection and Visualization Algorithms” on 
page 244.

Select ZScore Select the algorithm to use for calculation of probe methylation score.

Apply Click Apply to display the Probe Methylation Status Setup dialog bo x to 
assign a melting temperature (Tm) mapping file, if necessary, to the 
experiment. See “Probe Methylation Status Setup” on page 211.

Figure 33 Probe Methylation command
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Reports command ribbon
Batman

Figure 34 Batman command

Click Apply to display the Batman Parameters Setup dialog box where you 
set the parameters for the Batman tool for calculation and display of 
methylation data. See “Batman Parameter Setup” on page 170 for more 
information.

Reports command ribbon

The Reports command ribbon lets you save all the important information 
about the Z- score statistics and CpG Island tracks that can help you find 
out whether regions of the genome are methylated or not.  You use a 
spreadsheet program or your Internet browser to open t he report files the 
program creates. This l ets you further display, analyze, and organize t he 
result.

Generate Probe
Report

Opens the Probe Methylation Report Dialog dialog box, where you can 
enter a location and a name for the probe report file and select whet her 
you want individ ual reports for each chr omosome or one report on t he 
complete genome. See “Probe Methylation Report Dialog” on page 212.

Figure 35 CH3 Report command
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The Methylation Report makes information about the results of the probe 
methylation algorithm available in .xml  format (complete genome) or in 
.txt format (individual chromosomes). You can use a spreadsheet program 
to open al l these files. See “Report Format” on page 240 for a description 
of the columns in the report. 

Generate Batman
Report

Opens the Batman Report Dialog box where y ou set t he parameters and 
select a location to save the report.

View command ribbon

The View command ribbon lets y ou change the display of data/results in 
Genomic Viewer.

View Preferences Opens the View Preferences dialog box where you customize the display of 
data and results in the Genomic Vie wer. For more information, see “View 
Preferences” on page 236.

Copy This command opens a menu wit h the options l isted below. In general, t he 
Copy command copies pane(s) of the main window to the Clipboard as an 
image. You can then paste the image into a document in another program. 
See “To copy what you see in t he main window” on page 74.

Figure 36 View command ribbon 

Option Description

All Copies all panes of the main window to the Clipboard as an image.

Navigator Copies only the Navigator to the Clipboard as an image.

Tab View Copies only Tab View to the Clipboard as an image.

Genome view Copies only Genome View to the Clipboard as an image.
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Show Opens a menu with all available elements of the main window. Mark the 
check box for the ones to display in Genomic Viewer.

View In Table

Signal Intensity Mark the check box to see the red and green raw signal intensities of the 
log ratio data in t he Tab Vi ew.

Annotation Mark the check box to show annotations in the Tab View.

Cyto band info

View In Gene
View

Mark the check box to display cytobands in the Gene View.

NonUnique Probes

Highlight Mark the check box to display non unique probes in a different color.

Custom Data

Show Mark the check box to display custom data in t he Genomic Viewer.

Help command ribbon

The Help command ribbon lets y ou display the available Agilent Genomic 
Workbench help guides, and get information about sof tware version, 
installation history, and check for software updates. Help guides are 
opened in Adobe Reader.

Figure 37 Help ribbon for CH3 application

Chromosome view Copies only Chromosome View to the Clipboard as an image.

Gene view Copies only Gene View to the Clipboard as an image.

Option Description
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Table 3 Table of Agilent Genomic Workbench Help

Help Command Action

Application Guide Opens the Agilent Genomic Workbench application user guide for the 
selected application. 

Sample Manager Opens the Sample Manager User Guide, that shows how to use the 
Sample Manager module of Agilent Genomic Workbench to organize 
microarrays and edit their attributes.

Data Viewing Opens the Data Viewing User Guide that describes how to import, 
organize, manage, export and display data and other content (experiments, 
gene lists, tracks) within Agilent Genomic Workbench. It is targeted for 
users who have no DNA Analytics application license(s).

About Opens a message with information about the version number and 
copyright of the program.
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Navigator
Navigator

This section describes the parts of t he Navigator, and the shortcut menus 
and other functionality a vailable within it.

Figure 38 Navigator panes

The Navigator (Figure 38) shows the array data, experiments, and ot her 
content stored in A gilent Genomic Workbench. It cont ains the following 
panes:

Search pane

Data pane

Experiment pane

My Entity List pane
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Pane Comments

Search Lets you search within any pane of the Navigator for a specific 
item (array or build, for example). You must type the entire array 
name or term; otherwise, use asterisks (*) as wildcards for 
unspecified strings. For example, type *1234* to find any item that 
contains “1234”. See “Search pane” on page 138.

Data Contains microarray data files, organized by application type, then 
by design and genome build. 

Shows all probe groups and microarray designs that are available 
to you, organized by folders.In general, you can:

• Expand or collapse folders to show or hide content
• Right-click the name of a folder or item to open a shortcut menu 

that lets you take action on the item.
See “Data pane – icons, special text, and buttons” on page 140 
and “Data pane – actions and shortcut menus” on page 140.

Experiment Contains Agilent Genomic Workbench experiments. Experiments 
are organizational units that contain links to microarray data and 
design files. In data analysis modules, experiments also contain 
saved results.

My Entity List Contains gene lists and tracks:
• Gene Lists are collections of genes of interest. You can create 

them within the program, import and export them, and apply 
them to Gene View and Chromosome View.

• Tracks are collections of annotation or other information that 
map to specific genomic locations. You can import, export, and 
combine tracks, and display them in Gene View with your array 
data and analysis results.

• See “My Entity List pane – Icons, buttons, and special text” on 
page 149.

My Networks Contains the biological networks/pathways that you found using 
Network Search or that you create using a literature search in 
eArrayXD. For more information, see the eArrayXD Users Guide.
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Search pane
Search pane

The Search pane lets you find all occurrences of a specific search term in 
the Data, Experiment, and/or My Entity List panes. See “To find specific 
content items in t he Navigator” on page 62. It also contains several 
buttons that you can use to move, hide, show or resize the Navigator.

Detach button Click to move the Navigator from the main window of t he program and 
open it in a new, separate window. 

Resize buttons Click to hide, show, or expand the Navigator. 

Search term box Where you type your desired search term. Search terms are not 
case- sensitive, but they must reflect the entire name of an ar ray or other 
content item that you want to find. You can use asterisks (*) as wildcards 
to represent g roups of unspecif ied characters. For example, type *12345* 
to search for any content that contains the string “123 45”.

Pane list Lets you limit a search to a specific pane. Sel ect the name of the desired 
pane from the list. To select all panes, select All Panels. By default, the 
program searches all panes.

Figure 39 Navigator – Search pane

Search term box Detach 
button

Resize 
buttons

Pane list 
button

Search term 
clear button

Search button

Scroll buttons
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Search pane
Figure 40 Search pane selection list

(Show Pane List button, available only if the Pane list is not visible) 
Makes the Pane list visible.

(Hide Pane List button, available only if the Pane list is visible) Hides the 
Pane list.

(Search button) Searches the pane(s) selected in the Pane list for all 
occurrences of the term you typed in the Search term box. If the program 
finds a matching item, it expands the folder structure to make the 
matching item(s) visible, makes the lettering of each item red and 
highlights the item in y ellow. Note: The sear ch term is not case- sensitive, 
but it must contain the entire name of t he desired items.

Scroll buttons (Available only after a search) Lets you scroll up and do wn the lists of 
highlighted search items after a search.

(Clear button, available only after a search) Clears the search term from 
the Search term box, and resets the color of any matching item to its 
original color.
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Data pane – icons, special text, and buttons

Data pane – actions and shortcut menus

The Data pane of t he Navigator shows available content items that are 
stored on y our server for the selected application type, and an y external 
content that you imported. 

Item Comments

An unexpanded folder (domain) that contains subfolders or other items.

An expanded folder. The items that it contains are visible in the Navigator.

Expands a folder to show its contents.

Collapses a folder to hide its contents.

A methylation array design. This folder contains array data for the design, organized by 
genome build.

A CGH array design. This folder contains array data for the design, organized by genome 
build.

A gene expression array design. This folder contains array data for the design, organized 
by genome build.

A ChIP array design. This folder contains array data for the design, organized by genome 
build.

A genome build folder within a specific design folder. This folder contains arrays for the 
specific genome build and design.

A single array data file.

Data created from a multi-pack array.

red text An item that matches the search term in a search.

(Dock out button) Moves the Data pane from the Navigator, and opens it in a, separate 
window.

(Collapse button, available only if the Data pane is not collapsed) Collapses the Data 
pane, and shows its title bar at the bottom of the Navigator.

(Expand button, available only if the Data pane is collapsed) Expands the Data pane.
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• Double- click any folder to expand or collapse it.

Data Folder

• Double- click a data type f older (CGH, ChIP, Expression, or C H3) to 
expand it and displa y its contents.

• Double- click a design folder to display the genome builds for the design.

• Double- click a build folder to display the imported arrays for that build.

Design Folder

• Right- click the name of a design folder to display these options:

Genome Build Folder

• Right- click the name of a genome build f older to display these options:

Individual Arrays

• Right- click the name of an array to display these options:

Option Description

Update from eArray Updates the annotations for your array design from the eArray Web 
site. Agilent regularly updates annotations in eArray as new ones 
become available. See “To update probe annotation in design files” on 
page 63.

Note: In order to use this function, you must enter your eArray 
Username and Password in the Miscellaneous tab of the User 
Preferences dialog box. See “User Preferences” on page 231.

Delete Opens a Confirm dialog box. If you click Yes, the program permanently 
deletes the design and all arrays associated with it.

Option Description

Show Properties Opens the Design Properties dialog box. See “Design Properties” on 
page 183.

Delete Opens a Confirm dialog box. If you click Yes, the program permanently 
deletes all of the arrays in this genome build folder.
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• Drag an array from the Data pane to an experiment f older in t he 
Experiment pane t o associate it wi th an experiment. You can drag 
multiple arrays at once fr om one genome build in a design. Hold down 
the ctrl key and click the additional arrays to select them. You can also 
select a contiguous block of ar rays; click the first array in the block, 
then hold down the Shift key and cli ck the last one.

Option Description

Show Properties Opens the Microarray Properties dialog box. See“Microarray 
Properties” on page 208 and “To display or edit the attribute values of 
a specific array” on page 59.

Rename Opens an Input dialog box, where you can type a new name for the 
array. Click OK to rename the array.

Delete Opens a Confirm dialog box. If you click Yes, the program permanently 
deletes the array.
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Experiment pane – icons, special text, and buttons

Item Comments

Click to expand a folder and display its contents.

Click to collapse a folder and hide its contents.

A folder that contains files or other folders. 

A methylation array design. This folder contains array data for the design, organized by 
genome build.

A CGH array design. This folder contains array data for the design, organized by genome 
build.

A gene expression array design. This folder contains array data for the design, organized 
by genome build.

A ChIP array design. This folder contains array data for the design, organized by genome 
build.

A genome build folder within a specific design folder. This folder contains arrays for the 
specific genome build and design.

An array that is not selected for view and analysis.

An array that is selected for view and analysis. The specific color of this icon can vary.

A calibration array.

An empty folder.

Data created from a multi-pack array.

blue 
text

The active experiment. All data and results that appear in Chromosome, Gene, and Tab 
Views are from this experiment.

red text An item that matches the search term in a search.

(Dock out button) Moves the Experiment pane from the main window, and opens it in a, 
separate window.

(Collapse button, available only if the Experiment pane is not collapsed) Collapses the 
Experiment pane, and shows its title bar at the bottom of the Navigator.

(Expand button, available only if the Experiment pane is collapsed) Expands the 
Experiment pane.
Methylation (CH3) Analysis Guide 143



5 Methylation (CH3) Analysis Reference
Experiment pane — actions and shortcut menus
Experiment pane — actions and shortcut menus 

You can u se many items in the Experiment Pane of t he Navigator to open 
shortcut menus or t ake other actions.

• In general, double- click the Experiments folder within the Experiment 
Pane, and the folders within it, to expand and collapse them. Exception: 
Double- click the name of an unselected experiment to select it for 
analysis. This action opens the Experiment Selection dialog box. To 
select the experiment for analysis, click Yes.

Experiments Folder

• Right- click the Experiments folder to display these options:

Figure 41 Expanded Experiment Pane

Option Description

New Experiment Opens the Create Experiment dialog box (see “Create Experiment” on 
page 178), where you can name the new experiment, and open 
another dialog box that lets you add microarray data to the 
experiment. See “To create a new experiment” on page 51.

Export Opens the Export Experiments dialog box, where you can export one 
or more experiments as a single ZIP file. See “Export Experiments” on 
page 195 and “To export experiments” on page 72.
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Specific Experiment Folder

• In the Experiments folder, right- click the name of a s pecific experiment 
folder to display these options:

Option Description

Select Experiment (Appears only if the experiment is not selected.) Opens the 
Experiment Selection dialog box, which asks if you want to select the 
experiment. Click Yes to select the experiment for display and 
analysis.

Or, in the Experiments folder, double-click the name of an experiment 
that is not selected to open the Experiment Selection dialog box. To 
select the experiment for analysis, click Yes.

If you switch experiments, a Confirm dialog box asks if you want to 
save the current result. Select one of these options:

• Overwrite Current Result – Replaces the selected experiment 
result in the Data Navigator with the result that appears on your 
screen.

• Create New Result – Opens the Save experiment result dialog box, 
where you can save the result that appears in the main window as 
a new experiment result. See “To save a result” on page 114.

• Continue Without Saving – The program does not save the result 
that appears on your screen.

In some cases, the Confirm dialog box offers only Yes and No choices. 
If you click Yes, the Save experiment result dialog box appears, where 
you can save the result that appears on your screen with the name of 
your choice.

Deselect Experiment (Appears only if the experiment is selected.) If the results are unsaved, 
a Confirm dialog box opens with these options:

• Overwrite Current Result – Replaces the selected experiment 
result in the Data Navigator with the result that appears on your 
screen.

• Create New Result – Opens the Save Experiment result dialog box, 
where you can save the result that appears on your screen as a 
new experiment result.

• Continue Without Saving – The program does not save the result 
that appears on your screen.

In all three cases, the program then removes the experiment data and 
results from all views.
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Design Folder

• In the folder of a sp ecific experiment, right- click the name of a design 
to open a shortcut menu with a Delete command. If you click Delete, a 
Confirm dialog box opens. Click Yes to disassociate all of t he arrays 
under the design from the experiment. 

Show Properties Opens the Experiment Properties dialog box. Use this dialog box to 
see the names of the arrays in the experiment, and also to add or 
remove arrays from the experiment. See “Experiment Properties” on 
page 188.

Sample Attributes Opens the Sample Attributes dialog box, where you can change the 
values for the attributes assigned to the arrays in the experiment. See 
“Sample Attributes” on page 213. To add new attributes you must use 
the Sample Manager. See Sample Manager User Guide.

Export Opens the Export Experiments dialog box, where you can export this 
and other experiments as a single ZIP file. See “Export 
Experiments” on page 195, and “To export experiments” on page 72.

Export Attributes Opens the Export Array Attributes dialog box, where you can save a 
file that contains selected attributes of the arrays in your experiment. 
See “Export Array Attributes” on page 191.

Edit Array Color Opens the Edit Array Color dialog box, where you can select a display 
color for each of the arrays in the experiment. See “Edit Array 
Color” on page 186.

Edit Array Order Opens the Edit Array Order dialog box, where you can change the 
order of the arrays in the experiment pane of the Navigator, and in 
Chromosome, Gene, and Tab Views. See “Edit Array Order” on 
page 187.

Rename Opens an Input dialog box, where you can type a new name for the 
experiment. Click OK to rename the experiment.

Delete Opens a Confirm dialog box that asks if you want to delete the 
Experiment. Click Yes to delete it.

Note: You can delete any experiment except the selected one.

Option Description
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Genome Build Folder

• In the folder of a specific experiment, in a specific design folder, 
right- click the name of a genome  build to display these options:

Individual Arrays

• In a specific experiment, right- click the name of an individual ar ray to 
display these options: 

Option Description

Set for Calibration Use of calibration arrays is not recommended by Agilent. This feature 
has been deprecated.

Save As Text File Opens the Save Design dialog box, where you can save all of the data 
for the genome build and design within the experiment as a 
tab-delimited text file.

Delete Opens a Confirm dialog box that asks if you want to disassociate all 
arrays under the design from the experiment. Click Yes to remove the 
links between the arrays and the experiment.

Note: 

• If you delete a design from an experiment, the program removes the 
links between the experiment and the design and its arrays. The 
actual design and array data stay in the Data folder.

• Saved results become unavailable if they involve arrays you delete 
with this command.

Option Description

Select (Available only if the array is not already selected) Selects the array for 
display and analysis. 

Deselect (Available only if the array is selected) Removes the array data from 
Genome, Chromosome, and Gene views, and excludes it from the 
analysis. Also removes the array data from the Selected Arrays tab in 
Tab View.

Select for Calibration Use of calibration arrays is not recommended by Agilent. This feature 
has been deprecated.

Deselect from 
Calibration

Use of calibration arrays is not recommended by Agilent. This feature 
has been deprecated.
Methylation (CH3) Analysis Guide 147



5 Methylation (CH3) Analysis Reference
Experiment pane — actions and shortcut menus
Rename Opens an Input dialog box, where you can type a new name for the 
array in this experiment. Click OK to accept the new name for the 
array. The array name is changed only for the selected experiment.

Delete Opens a Confirm dialog box that asks if you want to disassociate the 
array from the experiment. Click Yes to remove the link between the 
array and the experiment.

Note: 

• If you delete an array from an experiment, the program removes the 
link between the experiment and the array. The actual array data 
remains in the Data folder. 

• You cannot restore an experiment result that includes a deleted 
array.

Show Properties Opens the Microarray Properties dialog box, where you can view and 
edit microarray attributes. See “Microarray Properties” on page 208.

For array files from the Agilent Feature Extraction program, you can 
also view the headers and feature data from the file.

See “To display or edit the attribute values of a specific array” on 
page 59.

Edit Array Color Opens the Select Color dialog box, where you can select a display 
color for the array. See “Select Color” on page 216.

Edit Array Order Opens the Array Order dialog box, where you can change the order of 
the arrays in the Experiment pane of the Navigator, and in 
Chromosome, Gene, and Tab Views. See “Edit Array Order” on 
page 187.

Option Description
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My Entity List pane – Icons, buttons, and special text
My Entity List pane – Icons, buttons, and special text

My Entity List pane – Actions and shortcut menus

Gene List folder

• Right- click the Gene List folder to open a shortcut menu wit h an 
Import Gene List option. This command opens an Import dialog box 
that you can use to import a gene list into the program. See 
“Import” on page 201.

• Double- click the Gene List folder to show or hide its gene lists.

Item Comments

Click to expand a folder and display its contents.

Click to collapse a folder and hide its contents.

A folder that contains files or other folders.

An individual gene list or track.

red regular 
text

An item that is an exact match with the search term in a search, or a gene list that 
has not been applied or that has red chosen as its custom color.

colored 
italics

A gene list that has been applied.

red bold 
italics

A track that is selected for display in Gene View.

black bold 
italics

A “combined” track that is selected for display in Gene View. A combined track 
contains information from two or more individual tracks associated by logical 
criteria.

(Dock out button) Moves the My Entity List pane from the main window, and opens 
it in a, separate window.

(Collapse button, available only if the My Entity List pane is not collapsed) Collapses 
the My Entity List pane, and shows its title bar at the bottom of the Navigator.

(Expand button, available only if the My Entity List pane is collapsed) Expands the 
My Entity List pane.
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My Entity List pane – Actions and shortcut menus
• In the Gene List folder, right- click the name of a gene list t o display 
these options:

Tracks folder

• Right- click the Tracks folder to display these options:

Option Description

View in Table Opens the Gene List dialog box, where you can view the list of genes. 
You can also edit the description of the gene list, and change the 
display color of the genes. See “Gene List” on page 199 and “To 
display the genes in a gene list” on page 66.

Rename Opens an Input dialog box, where you can type a new name for the 
gene list. Click OK to accept the new name.

Delete Opens a confirm dialog box that asks if you are sure you want to 
delete the gene list. Click Yes to confirm.

Save As Opens a Save As dialog box, where you can save the gene list as a text 
(*.txt) file. See “To export a gene list” on page 73.

Add to gene list Opens the Add gene list dialog box, where you can add the gene list to 
any other one in the Gene List folder. See “Add Gene List <name> 
to” on page 166 and “To add one gene list to another” on page 67.

Highlight (Available if the gene list is not selected.) Displays all genes in Gene 
View, and highlights the genes from the gene list in their display color. 
See “To show gene lists in Gene View” on page 90.

Show only (Available only if all genes appear in Gene View, or if the gene list is 
not selected) Restricts the genes in Gene View to those on the gene 
list. No other genes appear. The program displays the genes in their 
display color. See “To show gene lists in Gene View” on page 90.

Show All (Available only for the selected gene list.) In Gene View, displays all 
genes, without highlighting. See “To show gene lists in Gene 
View” on page 90.
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Track name

• Right- click the name of a track to display these options:

Option Comments

Import Tracks Opens the Import Track dialog box, where you can import a 
BED format track file into the program. See “Import Track” on 
page 206 and “To import tracks” on page 47.

Export Tracks Opens the Export Tracks dialog box, where you can select 
tracks for export as a single BED format track file. See “Export 
Tracks” on page 196 and “To export tracks” on page 73.

Combine Tracks Opens the Combine Tracks dialog box, where you can 
associate two or more individual tracks by logical criteria to 
create a new combined track. See “Combine Tracks” on 
page 172 and “To combine tracks” on page 68.

Option Comments

Show in UI Mark this option to display the track in Gene View next to the 
data and results of the selected experiment. See “To show 
tracks in Gene View” on page 92.

Show in Report Mark this option to display the track in the reports. 

Genomic Boundaries Click to analyze data invoking the genomic boundaries for only 
that track. You can choose to do this for only one track.

Show in UCSC Opens the UCSC Genome Browser in your Web browser and 
uploads the track. You can then view the track. 

View Details Opens a dialog box that displays information about the track. 
See “Track” on page 223.

Rename Opens an Input dialog box, where you can type a new name for 
the track. Click OK to rename the track.

Delete Opens a Delete Track dialog box that asks if you are sure you 
want to delete the track. Click Yes to delete the track.
Methylation (CH3) Analysis Guide 151



5 Methylation (CH3) Analysis Reference
Genomic Viewer
Genomic Viewer

Genomic Viewer is the display for the DNA Analytics applications (CGH, 
ChIP and CH3).  It includes the three Views – Geno me, Chromosome and 
Gene Views – the Tab View and the View Cursor.

Genome View

Figure 42 Genome View (vertical orientation), with human chromosomes. The X chro-
mosome is selected.
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Genome View
Genome View shows pictures of each of the distinct types of chromosomes 
in the selected genome. A blue box is dra wn around the selected 
chromosome, and t he View cursor appears as a blue line across the 
chromosome. 

Genome View actions and shortcut menus

• Click a chromosome to select it . When y ou select a chromosome, 
Chromosome, Gene, and Tab Vie ws show only genomic regions, genes, 
and data for it. The spec ific location in whic h you click the 
chromosome sets the position of the cursor. See “The View Cursor” on 
page 160.

• On the selected chromosome, click anywhere to move the cursor. See 
“The View Cursor” on page 160. This also moves the cursor in 
Chromosome, Gene, and Tab Vie ws.

• Right- click anywhere within Genome View to display a menu. If you 
click View Preferences, the View Preferences dialog box opens, where  
you can set pref erences for the display. See “View Preferences” on 
page 236.

• Click the Detach button  (located at the top center of the pane) 
to remove Genome View from the main window and open it in a 
separate window. To reattach the view, click its Close button . 

• Drag the side or bottom borders of the pane t o resize it. 

• On a border of the pane, click a resize button (for example,  or ) that 
points away from the pane to move that border all the way to the edge 
of the main window. To move the border bac k to its previous location, 
click the other resize button. 
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Chromosome View
Chromosome View

Chromosome View shows a mor e detailed diagram of t he chromosome you 
select in Genome View. 

• Cytobands and a plot area appear next t o the chromosome. 

• When you select arrays for display, their data appear in the plot 
area.

• The cursor appears as a solid blue line acr oss the chromosome and 
the plot area.

• The selected region of t he chromosome (if an y) appears as a dotted 
blue box in t he plot area. 

Figure 43 Chromosome View, human X chromosome shown
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Chromosome View
Chromosome View actions and shortcut menus

• Click a cyt oband, any part of the chromosome, or anywhere in t he plot 
area to move the View cursor to that location. See “The View 
Cursor” on page 160.

• Drag the pointer over any part of t he plot area to select a chromosomal 
region for display in Gen e View. Drag par allel to the chromosome. This 
also moves the cursor to the center of the selected region. See “The 
View Cursor” on page 160.

• Right- click anywhere within Chromosome View to display a menu. If 
you click View Preferences, the View Preferences dialog box opens, 
where you can set pref erences for the display. See “View 
Preferences” on page 236.

• Click the Detach button  (located at the top center of the pane) 
to remove Chromosome View from the main window and open it in a 
separate window. To reattach the view, click its Close button . 

• Drag the side or bottom borders of the pane t o resize it. 

• On a border of the pane, click a resize button (for example,  or ) that 
points away from the pane to move that border all the way to the edge 
of the main window. To move the border bac k to its previous location, 
click the other resize button. 
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Gene View
Gene View

Gene View shows a mor e detailed view of the chromosomal region y ou 
select in Chr omosome View. See “Chromosome View” on page 154.

• Regions that contain genes appear as small blue bo xes. Gene names 
appear nearby. You can customize the appearance of gene names. 
Also, you can use a gene list to highlight genes of int erest, or to 
display only the genes in t he list. See “To change t he appearance of 
genes in Gene Vie w” on page 92, and “To show gene lists in Gene 
View” on page 90.

Figure 44 Gene View, with log ratio data from an experiment and CNV tracks. 
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Gene View
• Log ratio data from selected arrays in t he active experiment appear 
as a scatter plot. You can also customize the scatter plot. See “To 
change scatter plot appearance” on page 84.

• The location of the cursor matches the location of the cursors in 
other views. See “The View Cursor” on page 160.

• The name of the chromosome, and the coordinates and size of the 
displayed chromosomal region appear at the top of the pane. 

• Imported tracks can also appear in Gene View. See “To show tracks 
in Gene View” on page 92.

Scatter Plot

You access t he scatter plot comm and group in Gene View or t hrough View 
Preferences from the View tab. The commands are dif ferent for CGH, ChIP 
and CH3 applications. Scatt er plots appear in t he Chromosome and Gene 
Views but only if they have been selected in the View Preferences dialog 
box.

Methylation
Results

Mark the box to enable the Methylation Results scatter plot. Selection for 
the CH3 Methylation Results scatter plot lets y ou color the methylation 
results based on Z- score Values.

Log Ratios Mark the box to enable the Log Ratios scatter plot. Selections for the CH3 
Log Ratios scatter plot let you color the Log Ratios by Log Ratio Values or 
Probe Score Values.

Figure 45 Scatter Plot command group in CH3 Gene View 
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Gene View
Configure Colors
and Ranges

Opens the Configure Coloring Ranges and Shades di alog box, where you 
can set up t he colors and ranges  for the Methylation Results and Log 
Ratios scatter plots. For more information, see “Configure Coloring Ranges 
and Shades” on page 174.

Gene View buttons

Zooms in t o see a smaller region in mo re detail.

Zooms out to see a larger region in less detail.

When in v ertical orientation, scrolls up t hrough the genes and data to 
lower- numbered chromosomal coordinates.

When in v ertical orientation, scrolls down through the genes and data to 
higher- numbered chromosomal coordinates.

When in vertical horizontal orientation, scrolls left through the genes and 
data to lower- numbered chromosomal coordinates.

When in vertical horizontal orientation, scrolls right through the genes and 
data to higher- numbered chromosomal coordinates.

(Resize buttons) The button that points away from Gene View expands the 
view. The ot her button restores the view to its orig inal size. (These 
buttons will appear horizontal if t he view orientation is horizont al.)

(Detach button) Removes Gene Vie w from the main window, and opens it 
in a separate window. 

Gene View shortcut menu and other actions

• Click anywhere in the plot area of Gene View to move the cursor to 
that location. See “The View Cursor” on page 160.

• Drag an inside border of Gene View to resize the view. 

• Right- click anywhere in the plot area of Gene View to display these 
options:
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Gene View
Option Description

Create Gene List Opens the Create Gene List dialog box, where you can create a 
new gene list based on the selected (or another) chromosomal 
region. See “Create Gene List” on page 180 and “To create a 
gene list” on page 65.

Upload Track to UCSC Opens the Upload Track to UCSC dialog box, where you can set 
parameters to upload the track to the UCSC (University of 
California at Santa Cruz) Genome Browser in your Web 
browser. You can then display the track and use the tools 
available in the UCSC Web site to examine the data. See 
“Upload Track to UCSC” on page 229.

Search Probes in eArray Opens the Search Probes in eArray dialog box, where you can 
set the region to search for probes in eArray.

User Preferences Opens the User Preferences dialog box, where you can set 
user preferences on three separate tabs. See “User 
Preferences” on page 231 for more information.

View Preferences Opens the View Preferences dialog box, where you set 
preferences for the Genomic Viewer. See “View 
Preferences” on page 236.
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The View Cursor
The View Cursor

The View cursor reflects the center of the current chromosomal location of 
interest. It appears in s everal Views:

• In Genome View, it appears as a blue bar acr oss the selected 
chromosome.

• In Chromosome View, it is a blue bar t hat appears across the 
chromosome and across the plot area of  the view.

• In Gene Vie w, it is a blue bar that appears acr oss the plot area  and 
tracks of t he view.

Figure 46 Genomic viewer showing view cursors

The position of the cursor in  one view is also t he position of the cursor in 
all views. The ex act chromosomal location of the cursor appears in t he 
first cell of t he Status bar. Several actions change t he position of the 
cursor:

• In Genome View, click anywhere on a c hromosome to move the 
cursor to that location.

• In Chromosome View, click a cytoband name, part of the 
chromosome, or anywhere in the plotting area to move the cursor to 
that location.

• In Gene View, click anywhere in t he plotting area t o move the cursor 
to that location.

The cursor used in Gene View is the same cursor used for the tracks.
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Tab View
• In Tab View, click a r ow of a data table to move the cursor to the 
chromosomal location for that row.

Tab View

Tab View displays design annot ation and log ratio data related to the 
chromosome you select in Chr omosome View. 

• The exact column content of the tables depends on t he specific tab 
and design, but it alwa ys includes chromosomal locations of probes.

• The selected row of dat a appears highlighted in blu e. This r ow 
represents data that corresponds approximately with the location of 
the cursor.

• Columns of log ratio data appear below the names of the specific 
arrays to which they correspond. If an array is select ed for display 
in Chromosome and Gene vie ws, a co lored square appears next t o its 
name.

Figure 47 Tab View
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Tab View
• Signal intensity (raw signals) and/or annotations appear if selected 
from the View command ribbon.

Tab View tabs and buttons

You can see the following tabs and buttons in Tab V iew. See Figure 47 for 
a diagram that identifies some of these elements.

Design tabs A separate tab appears for each microarray design included in t he active 
experiment. The name  of the design appears on each tab, along with an 
icon:

 – A methylation array design

 – An aCGH ar ray design.

 – A gene expression array design.

 – A ChIP- on- Chip array design.

When you click a design tab, the data and annot ation for the arrays in the 
design appear in Tab Vie w. The pr ogram separates the arrays of the 
design into the Arrays tab and the Calibration Arrays tab (see below).

Arrays tab (Available when you click a specif ic design tab.) Contains a table of data 
and annotation for all arrays in a design t hat contain biological data.

Selected Arrays
tab

Contains a table of data and annotation for the selected arrays from all 
designs in t he active experiment.

(Resize buttons) The button that points away from Gene View expands the 
view. The ot her button restores the view to its orig inal size

(Detach button) Removes Gene Vie w from the main window, and opens it 
in a separate window. 

Tab View actions and shortcut menus

• Click the name of an array in a column heading to select the array for 
display. 

• Right- click the name of an array in a column heading to display these 
options:
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Option Description

Rename Array Opens an Input dialog box, where you can type a new name for 
the array. This only changes the name of the array within the 
active experiment.

Remove Array From 
Experiment

Opens a confirmation dialog box. Click Yes to remove the link 
between the array and the active experiment. This command 
does not delete the data file from the program. To do this, see 
“To remove data or design files from the program” on page 64.

Select Array (Available if the array is not selected.) Selects the array for 
display. A colored square appears next to the name of the 
array.

Deselect Array (Available if the array is selected.) Removes the array data 
from scatter plots, and removes the column of the array from 
the Selected Arrays tab.

Edit Array Color Opens the Select Color dialog box, where you can change the 
display color of the array. See “Edit Array Color” on page 186 
and “To change the display color of an array” on page 81.

Edit Array Order Opens the Edit Array Order dialog box, where you can change 
the order in which the names of the arrays in a given design of 
the active experiment appear in Tab View and in the Data 
Navigator. In Gene View, when you view separate scatter plots 
for each array, the plots also appear in this order. See “Edit 
Array Order” on page 187 and “To change the order of arrays in 
an experiment” on page 54.

Select All Arrays Selects all arrays in all designs in the active experiment for 
display. All arrays appear in the Selected Arrays tab.

Deselect All Arrays Removes all arrays from display, and from the Selected Arrays 
tab.

Scroll to Column Opens the Scroll to Column dialog box, where you can select a 
column in the current tab. The program then scrolls the data 
table in the tab so you can see the selected column. See 
“Scroll to Column” on page 214.
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Tab View
• Right- click a heading of a column other than an array data column 
to open a shor tcut menu with a Scroll To Column option. If you click 
this option, the Scroll To Column dialog box appears, where y ou can 
select a column in t he current tab. The program then scrolls the data 
table in t he tab so y ou can see  the column.

• Click an entry in a data table to select t he row in which it appears. 
This also moves the cursor t o the location of the data point 
corresponding to the selected row.

• Right- click a data table entry to display these options:

Option Description

Find in column Opens the Find in column dialog box, where you can search for 
a specific text string within the column you clicked. See “Find 
in column” on page 197.

Google
LocusLink

PubMed

UCSC HG15(April ‘03)

UCSC HG16(July‘03)

UCSC HG17(May‘04)

UCSC HG18(March‘06)

UCSC mm8(Feb‘06)

UCSC mm9(July‘07)

DGV(hg18)

GO

KEGG(HUMAN)

Opens your Web browser, and sends the column entry you 
clicked as a search string to the selected site. The UCSC links 
search the indicated University of California, Santa Cruz 
database related to the indicated genome build. See “To 
search the Web for information on probes in Tab View” on 
page 100.

Customize Link Opens the Customize Search link dialog box, where you can 
create or edit a custom Web link that appears in this shortcut 
menu. When you click a custom link, the program opens your 
Web browser, and sends the column entry you clicked as a 
search string to the site. See “Customize Search Link” on 
page 182 and “To create a custom Web search link” on 
page 100.

(other options) If other options appear in this shortcut menu, they are custom 
Web search links. Click them to open your Web browser, and 
send the column entry you clicked as a search string to the 
site.
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Status Bar

The Status Bar displa ys information related to the displayed data.

Cursor position The chromosomal location of the cursor. See “The View Cursor” on 
page 160.

Genome build The genome build f or the displayed data.

Ratio type The mathematical type of t he array data. The possible types are:

• ratio

• log2 ratio

• log10 ratio

• ln (natural log) ratio

Selected Row The row in the displayed data table that is selected. The location of the 
cursor is approximately the chromosomal location for this row.

Table size The number of r ows and column s in the displayed tab. The size appears 
as 
<# of r ows> x <# of columns>.

Figure 48 Status bar 

Genome build Ratio type

Table size

Cursor position
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Dialog Boxes
Dialog Boxes

This section describes the dialog boxes specific to the interactive analysis 
of the CH3 Application.  They are list ed in alphabetical order by title.

Add Gene List <name> to

Purpose: Adds genes from one gene list (the source gene list) to another 
(the target gene list).

To open: In the Data pane, right- click the name of a gene list, t hen click 
Add to Gene List.

Select target
gene list

The gene list t o which ge nes are added. Select on e from the list.

Build (Read- only) The ge nome build for the genes in t he list. The builds of t he 
two gene lis ts must match.

Figure 49 Add Gene List <name> to
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Agilent Feature Extraction Importer
Description (Optional) Description of the combined gene list.

List of genes A list of the genes in t he target gene list.

Gene List Color (Read- only) The dis play color of  the target gene list.

OK Adds the genes fr om the source gene list t o the target gene list.

Cancel Closes the dialog box without adding any genes to the target gene list.

Agilent Feature Extraction Importer

Purpose: Lets you edit the name of the FE data file you will import and 
to indicate whether you want to flip the red/green ratio for the data.

Figure 50 Agilent Feature Extraction Importer
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Agilent Feature Extraction Importer
To open: In the Home tab, click Import > Array Files > FE File, select 
the desired FE dat a file(s), then click Open.

Name Lets you edit the names of the FE files. You can c hange the names of t he 
files to names that are easier  to recognize or remember.

Dye Flip For each array:

Select Normal if:

• The test samples were labeled with cyanine- 5 (red).

• The control samples were labeled wit h cyanine- 3 (green).

• The imported ratio (test/control) should be reported as is.

Select Flipped if:

• The test samples were labeled with cyanine- 3 (green).

• The control samples were labeled wit h cyanine- 5 (red).

• The imported ratio (control/test) should be reported with the ratio 
inverted (test/control).

The program does not co mbine dye- flip pairs.

Overwrite arrays
with duplicate

names

Mark this option to replace existing file(s) in the program with the 
imported one(s), if they have the same name(s).

Run in
Background

Imports the files, and lets you use your computer for other purposes while 
the import occurs. This is es pecially useful if y ou have many files to 
import.

OK Imports the files in the foreground. You cannot use your computer for 
other purposes while t he import occurs.

Cancel Cancels the entire im port process without importing anything.
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Array Set

Purpose: To select replicat e arrays to combine in the analysis.

To open: Click Fuse in t he Preprocessing ribbon.

The array set dialo g box opens when you combine designs. See “To 
combine (fuse) arrays” on page 105.

Table Displays the arrays that are combined, in o rder of their values for the 
ArraySet attribute. The program creates a separat e combined array for 
each group of arrays with a g iven value for ArraySet. The t able also shows 
the design ID for each array, and t he design type.

Select
Normalization

Select Centralization normalization or none. See “Methylation Detection 
and Measurement Algorithms” on page 246.

Remove arrays
from experiment

after fuse

Deletes the original individual arrays after creating combined arrays so 
that the experiment w on't contain duplicate data.

Continue Click to create combined designs using the selected options.

Cancel Cancels any selections, and cl oses the dialog box.

Figure 51 Array Set dialog box.
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Batman Parameter Setup

Figure 52 Batman Parameter Setup dialog box

Purpose: This dialog box is used to set the parameters for the Batman 
tool of met hylation analysis. For details on ho w this algorithm works, see 
“Bayesian tool for methylation analysis (BATMAN)” on page 256.

To open: In the Analysis tab, under Batman, mark the Apply box.

Z-score Mark Use Z- score to use the Z- score in plac e of the log ratio valu es.

Select CPG
Window

Select the local CPG window to use.

Select CPG File Click Browse and select a FASTA file containing sequences with 400 bases 
on either side of the center of t he probe. The file must be in  standard 
FASTA format.

Select TM
mapping file

If the Tm inf ormation is pr esent in the design, the TM map file will 
display Available. If t he Tm inf ormation is not in t he design, you must 
select a TM file to use. The Tm file must be a tab delimited text file with 
probe name and Tm as two columns.
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Batman Report Dialog
Continue Click to apply the Batman parameters and displa y them in the views.

Cancel Click to close t he dialog box without applying the Batman algorithm.

Batman Report Dialog

Figure 53 Batman Report Dialog

Purpose: This dialog box is used to select the output format and location 
of the Batman report.

To open: In Reports, click Generate Batman Report.

Report Type All methylation reports are probe- based.

Output Format Complete Genome – Creates report as .xls file for entire genome
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Combine Tracks
Per- Chromosome – Creat es report for each chromosome as .tx t file. Open 
in spreadsheet program to see headers properly aligned.

Select File
Location

Click Browse to select a location for the file, and type a file name.

Combine Tracks

Purpose: Lets you create a combin ed track that contains elements of tw o 
or more source tracks, associated by logical criteria. See “To combine 
tracks” on page 68.

To open: In the My Entity List pane, right- click the Tracks folder, then 
click Combine Tracks.

Name The name of the combined track

New Condition Adds a new, empty row to the Track/Operator table in the dialog box.

Delete Condition Removes the bottom row from the Track/Operator table in the dialog box.

Track In each row, select a track to include in t he combined track.

Figure 54 Combine Tracks dialog box
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Combine Tracks
Operator In each row, select the desired logical operator. This operator controls the 
manner in whic h the program combines the track in t his row with the 
others. Select one of these options:

Reset Removes all Track/Operator pairs fr om the table in the dialog box, and 
clears the Name of the combined track.

Save Creates the combined track, but does not clo se the dialog box.

Close Closes the dialog box. Opens the Confirm track sa ve dialog box if you 
created a combined track, but did not sa ve it.

Operator Comments

AND Places an element in the combined track if it appears in both this track and any of 
the others.

OR Places an element in the combined track if it appears in either this track or any of 
the others. If you set this operator for all tracks in the list, the result is a 
nonredundant set of elements from all tracks.

MINUS Removes the elements that appear in this track from the combined track, if they 
otherwise appear there.
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Configure Coloring Ranges and Shades

Figure 55 Configure Coloring Ranges and Shades dialog box

Purpose: This dialog box is used to enter ranges and select colors for 
scatter plot o ptions. Tabs show selections for Methylation Results and Log 
Ratios options.

To open: In Gene View, move the mouse pointer over Scatter Plot to 
display the scatter plot options and then click Configure. Or, click the 
View tab and click View Preferences. Under Configure Coloring schemes, 
click Configure Colors and Ranges.
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Table 4 Methylation Results Parameters

Parameter Description

Z-score Values

Min Type a minimum value for the range.

Max Type a maximum value for the range.

Color Click to open the Select Color dialog box, where you can select the 
color you want to display for this range. See “Select Color” on 
page 216 for more information.

Add Range Click to add a row to the range table using the values displayed in Min 
and Max, and the selected Color.

Remove Range Click to remove the ranges with Edit/Delete box marked.

Edit Range Click to edit range(s) with Edit/Delete box marked.

Range table This table displays the defined ranges, including minimum and 
maximum values, color for each range, and Edit/Delete selection.

Table 5 Log Ratios Parameters

Parameter Description

Log Ratio Values

Min Type a minimum value for the range.

Max Type a maximum value for the range.

Color Click to open the Select Color dialog box, where you can select the 
color you want to display for this range. See “Select Color” on 
page 216 for more information.

Add Range Click to add a row to the range table using the values displayed in Min 
and Max, and the selected Color.

Remove Range Click to remove the ranges with Edit/Delete box marked.

Edit Range Click to edit range(s) with Edit/Delete box marked.

Range table This table displays the defined ranges, including minimum and 
maximum values, color for each range, and Edit/Delete selection.
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Probe Score Values

Min Type a minimum value for the range.

Max Type a maximum value for the range.

Color Click to open the Select Color dialog box, where you can select the 
color you want to display for this range. See “Select Color” on 
page 216 for more information.

Add Range Click to add a row to the range table using the values displayed in Min 
and Max, and the selected Color.

Remove Range Click to remove the ranges with Edit/Delete box marked.

Edit Range Click to edit range(s) with Edit/Delete box marked.

Range table This table displays the defined ranges, including minimum and 
maximum values, color for each range, and Edit/Delete selection.

Table 5 Log Ratios Parameters (continued)

Parameter Description
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Confirm Overwrite

Purpose: When you import an experiment, it can cont ain designs and/or 
arrays that have the same names as those already a vailable in Agilent 
Genomic Workbench. This dialog box lets you select which designs and/or 
arrays to overwrite.

To open: This dialog box appears when you import a ZIP format 
experiment file, and it contains designs and/or arrays that are already 
available in A gilent Genomic Workbench. See “To import an experiment 
file” on page 49.

Select the designs to overwrite

Design The names of t he designs in t he imported file that have the same names 
as designs t hat are already a vailable in A gilent Genomic Workbench.

Overwrite Mark the check box for each design that you want to overwrite.

Select All Marks all of the check boxes under Overwrite.

Deselect All Clears all of the check boxes under Overwrite.

Figure 56 Confirm overwrite dialog box
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Select the microarrays to overwrite

Array The microarray identification, usually a barcode.

Name The names of the arrays in t he imported file that have the same names as 
arrays that are already a vailable in A gilent Genomic Workbench.

Overwrite Mark the check box next t o each existing ar ray that you want to 
overwrite.

Select All Marks all of the check boxes under Overwrite.

Deselect All Clears all of the check boxes under Overwrite.

OK Overwrites the selected files (both designs and ar rays) and closes the 
dialog box.

Cancel Closes the dialog box, and retur ns you to the Import (experiments) dialog 
box. See “Import (experiments)” on page 203.

Create Experiment

Purpose: To create an organizational unit in the Experiment pane of t he 
Navigator to link to array data for display and analysis and to create the 
links to the data for the experiment (see “Experiment Properties” on 
page 188).

To open: In the Experiment pane of the Navigator, right- click the 
Experiments folder, and click New Experiment, or cli ck File > New 
Experiment.

Figure 57 Create Experiment dialog box
178 Methylation (CH3) Analysis Guide



Methylation (CH3) Analysis Reference 5
Create Experiment
Name Type a name for your new experiment.

Description Briefly, describe your experiment with information that will help you 
identify it.

Properties Click to display the Experiment Properties dialog box where you can 
select microarrays to add to your new experiment. See “Experiment 
Properties” on page 188.

NOTE Do not click OK until you have added arrays to your experiment in the Experiment 
Properties dialog box or you will have an empty experiment. You can also add arrays to the 
experiment later, by dragging and dropping the arrays from the Data pane of the navigator. 
See “To add arrays to an experiment” on page 53.
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Create Gene List

Purpose: To limit the genes presented in Gene View to a p reselected 
number valuable f or interpreting data

To open: Right- click Gene View, and click Create Gene List.

Name Type in name of gene list.

Build Select the genome build for the genes.

Description Describe the type or natur e of t he genes in t he list.

Set Chromosome Start-Stop

Select a chromosome and a region in Chromosome View for selecting the 
genes in the list before you open the Create Gene List dialog box.

Figure 58 Create Gene List dialog box
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User Defined Select to choose region from which the genes in Gene View are select ed. 
The chromosome selection list and t he Start and St op positions on t he Y 
axis are enabled when t his option is selected. With this option, y ou can 
override the selections you made before opening Create Gene List.

For complete
gene view

Select all the genes in Gene View.

For aberrant
region below

cursor

Select those genes that appear in t he aberrant region just bel ow the 
cursor position in G ene View. 

Chromosome If you select User Defined, you can select a different chromosome than 
had been selected before opening the Create Gene List dialog  box.

Start If you select User Defined, you type in a Start position t o define the 
region that contains the genes f or the list.

Stop If you select User Defined, you type in a Stop position to define the 
region that contains the genes f or the list.

Color

Change Click to change the color of the gene list name in Dat a Navigator.
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Customize Search Link

Purpose: This dialog box lets you create a custom Web search link in t he 
shortcut menu that appears when y ou right- click a table entry. The link 
opens the URL of y our choice, and sends t he table entry to it as a sear ch 
string. See “To create a cust om Web search link” on page 100.

To open: Right- click any entry in a t ab in Tab View, other than a column 
heading, then click Customize Link. 

URL Name The name of the custom Web search link that appears in the shortcut 
menu (see above). To edit an existing custom Web search link, select it 
from the list.

URL The full un iform resource locator (URL) of the desired sear ch page. For 
the query string value, type <target> 

For example, this URL sends the selected tab view entry to google.com:

http://www.google.com/search?hl=eng&q=<target>

New Opens an Input dialog box, where you can type a name for a new custom 
Web search link. Click OK to add the name to the URL name list.

Update Saves the settings in t he dialog box.

Delete Deletes the selected custom Web search link.

Close Closes the dialog bo x.

Figure 59 Customize Search Link dialog box
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Design Properties

Purpose: Gives general and de tailed information about a given microarray 
design. See “To display the properties of a specific design” on page 62.

To open: In the Data pane of the Navigator, right- click the name of a 
genome build within a design folder, then click Show Properties. Several 
tabs are available.

Attribute tab

Displays general identifying attributes of the array design, and st atistics 
such as the total number of f eatures in t he design. For Catalog designs, 
the “Date” field is the date of the downloaded catalog design file.

Non Unique Probes tab

Displays the nonunique probes in the design. Nonunique probes have more 
than one mapping in the genome that is a perfect match. 

Figure 60 Design Properties dialog box – Attribute tab
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S. No The sequence or der of t he probes within the tab. 

Probe The name of the each nonunique probe.

Value The chromosomal locations to which each of the probes binds. Because 
these are nonunique pr obes, two locations appear for each probe.

Figure 61 Design Properties dialog box – Non Unique Probes tab
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Data tab

Displays the names of the probes in the design and their target genomic 
locations. The tab displays the probes for one chromosome at a time.

Select
Chromosome

The chromosome whose probes appear in the list. To display the probes 
for another target chromosome, select one from this list.

Probe The name (Probe ID) of each probe.

Chromosome The name of the chromosome to which the probe is de signed.

Start The location on the selected chromosome of the first base pair f or the 
probe.

Stop The location on the selected chromosome of the last bas e pair for the 
probe.

Figure 62 Design Properties dialog box – Data tab
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Edit Array Color

Purpose: To change the color of the arrays in an experiment

To open: Right- click the experiment name, and click Edit Array Color.

Select Array Mark the check box for the array(s) whose color you want t o change.

Color Click to change the color for the selected array(s). If you selected more 
than one, all the selected arrays will change t o the same color .

Select All Click to mark all the check boxes.

Deselect All Click to clear all the check boxes.

Edit Color Click to change the color for the selected array(s). Same as Color button.

Restore default Click to restore the original color(s) to the selected array(s).

Figure 63 Edit Array Color dialog box
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Edit Array Order

Purpose: This dialog box lets you change t he order of arrays in an 
experiment, which defines the order in which the program displays arrays 
and array data in the Experiment pane of the Navigator and in Tab View. 
If you select the Stacked rendering style for scatter plots, the array order 
also determines the order in which t he scatter plots f or the arrays appear.

To open: Right- click the name of an experiment, t hen click Edit Array 
Order in t he shortcut menu. 

Array Name The arrays in the selected design, listed in their current order.

Design Select the name of a design. In Array Name, the program displays the 
arrays associated with the selected design.

Order by Select an attribute to use as a basis for ordering the list. For example, if 
you select Barcode, the program reordered that Array Name list based on 
Barcode.

Moves a selected array up in t he Array Name list. T o select an array in 
this list, c lick the name of the array.

Moves a selected array down in t he Array Name list. To select an array in 
this list, c lick the name of the array.

Figure 64 Edit Array Order dialog box
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OK Applies the new array order.

Cancel Closes the dialog bo x without making an y changes to the array order.

Experiment Properties

Purpose: To select the arrays to link to the experiment

To open: In t he Create Experiment dialog bo x, click Properties, or in t he 
Experiment pane of the Navigator, right- click the experiment name, and 
click Show Properties.

Experiment
Name:

Displays the name of t he selected experiment.

Description
Text Box:

Displays the description of the experiment that was entered when the 
experiment was created.

Select Design

Designs Select the design whose arrays you want to add to the experiment.

Figure 65 Experiment Properties dialog box
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Genome Builds Select the genome build for the design you selected, if the design has more 
than one genome build.

Arrays

Array List Displays the arrays in the selected design that are a vailable for the 
experiment.

• To select an array to move to the Selected Array List, click its name. 

• To select additional ar rays, hold down the ctrl key and click their 
names. 

• To select a conti guous block of arrays, click the name of t he first array, 
then hold down the Shift key and clic k the name of the last one.

Selected Array
List

Displays the arrays that you have selected for the experiment.

Moves the selected arrays in Array List to the Selected Array List. You can 
move arrays from as many designs as y ou want, if they are all for the 
same genome build.

Moves all of the arrays in Ar ray List to the Selected Array List.

Removes an array from the Selected Array List. To select an array for 
removal, click its name. If desired, you can re- add an ar ray.

Clears the Selected Array List.

Display name by Click to select how the array names are displayed in t he experiment. The 
Global Display name is t he name a ssigned in Sam ple Manager for the 
array. See the Sample Manager User Guide for more information.

OK Adds the selected arrays to the experiment and closes the dialog box.

Cancel Closes the dialog box without making any changes.
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Export

Purpose: Lets you select a location f or an exported file. 

To open: This dialog box appears after you select specif ic experiment(s), 
track(s), or ar ray attribute(s) to export. See “To export experiments” on 
page 72, “To export tracks” on page 73, or “To export array attributes” on 
page 71.

Look in Displays the folder or ot her location whose contents appear in t he main 
pane of the dialog box. To select another folder or o ther location, click .

Moves to the next higher f older level.

Displays the Desktop.

Creates a new folder in the selected location in Look in.

Displays the names, only, of folders, files, and other locations in the main 
pane of t he dialog box.

Figure 66 Export dialog box – Several types of file exports use this dialog box. This spe-
cific example exports selected experiment(s) as a ZIP format file.
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Displays both the names and information about f olders, files, and ot her 
locations in t he main pane of t he dialog box.

Main pane Displays the folders, files, and ot her locations in t he selected location in 
Look in. Only files of the selected type are displayed. To select file, click 
its name. To open a folder or ot her location, double- click its name.

File name Displays the name of t he file to which the exported content is sa ved. To 
change the name, you can ei ther select a file in the main pane of the 
dialog box, or type a new name.

Files of type Sets the type of files that are displayed. To show all f iles, click , then 
select All Files.

Export Saves the selected content to the location given in the dialog box.

Cancel Cancels your selections and closes the dialog box.

Export Array Attributes

Purpose: This dial og box lets you select ar rays whose attribut es you want 
to export. It cont ains two tabs: an Ar ray tab where y ou select t he arrays, 
and an Attribute tab where you select the attributes of the selected arrays 
to export. See “To export array attributes” on page 71.

To open: In the Home command ribbon, click Export > Array Attributes, 
or in t he Experiment pane of the Navigator, right- click the name of an 
experiment, then click Export Attributes.
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Array tab

Select Design

Designs Displays all of  the designs available in the program. Select the design for 
arrays that you want t o export.

Genome Builds Displays the genome build(s) for the design. Select the desired genome 
build to display the arrays for a single genome build.

Arrays

Array List Displays the arrays in the selected design that are a vailable for export.

• To select an array to move to the Selected Array List, click its name. 

• To select additional ar rays, hold down the ctrl key and click their 
names. 

• To select a conti guous block of arrays, click the name of t he first array, 
then hold down the Shift key and clic k the name of the last one.

Figure 67 Export Array Attributes dialog box – Array tab
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Selected Array
List

Displays the arrays that you have selected for export.

Moves the selected arrays in Array List to the Selected Array List. You can 
move arrays from as many designs as y ou want, as long as they are all f or 
the same genome build.

Moves all of the arrays in Ar ray List to the Selected Array List.

Removes an array from the Selected Array List. To select an array for 
removal, click its name. You can lat er add a removed array.

Clears the Selected Array List.

Next Moves to Attribute tab to select attributes for export. 

Cancel Closes the dialog box without exporting any array attributes.

Attribute Tab

Figure 68 Export Array Attributes dialog box – Attribute tab
Methylation (CH3) Analysis Guide 193



5 Methylation (CH3) Analysis Reference
Export Array Attributes
Attributes

Attribute List Displays the attributes that are not ex ported for the selected arrays.

Selected
Attribute List

Displays the exported attributes for the selected arrays.

• To select an attribute to move to the Attribute List, click its nam e. 

• To select additional attribut es, hold do wn the ctrl key and click their 
names. 

• To select a contiguous block of attr ibutes, click the name of the first 
attribute, then hold down the Shift key and click the name of the last 
one.

Removes an attrib ute from the Selected Attribute List. To select an 
attribute for removal, click its nam e. You can add a removed attribute 
later.

Clears the Selected Attribute List.

Moves the selected attributes in the Attribute List to the Selected Attribute 
List. 

Moves all of the attributes in the Attribute List to the Selected Attribute 
List.

Back Moves back to the Array tab for array selection or removal.

OK Opens the Export dialog box. See “Export” on page 190.

Cancel Closes the dialog box without exporting any array attributes.

NOTE You must select the following mandatory attributes, or else you cannot import the attribute 
file at a later time: Array ID, Global Display Name, Green Sample, Red Sample, Polarity.
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Export Experiments

Purpose: Lets you select experiments for export. The program exports all 
array designs and data for the experiments as a sing le ZIP file. This file 
does not incl ude any parameter settings, array selections, or res ults. See 
“To export experiments” on page 72.

To open: In the Home tab, click Export > Experiments. 

Select experi-
ments to export

Displays all experiments a vailable for export. Mark each experiment y ou 
want to export.

Select All Selects all experiments for export.

Deselect All Clears all check boxes under Select experiments to export.

OK Opens an Expor t dialog box. See “Export” on page 190.

Cancel Cancels the export and closes t he dialog box.

Figure 69 Export Experiments dialog box
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Export Tracks

Purpose: Lets you select tracks to export as a single BED format file. See 
“To export tracks” on page 73.

To open: In the Home tab, click Export > Tracks.

Select tracks Displays all of t he filters available in t he program. Mark the check bo x 
next to each track t hat you want t o export.

Select All Selects all available tracks for export.

Deselect All Clears all of the check boxes under Select Tracks.

OK Opens the Export dialog box, where you can se lect a lo cation for the 
exported BED format file. See “Export” on page 190.

Figure 70 Export Tracks dialog box
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Cancel Cancels the export and closes t he dialog box.

Find in column

Purpose: This dialog box lets y ou set search parameters for a specific 
column entry for the selected chromosome. Based on these parameters, 
the program can high light the row of t he first entry that matches. The 
cursor then moves to the location defined in the row.

To open: Right- click any entry in a tab in Tab Vie w other than a column 
heading, then click Find in column in the shortcut menu. 

Find in column Type all or par t of the entry you want t o find.

Direction Select a search direction:

• Up – Sets the search to move up the column from the selected location.

• Down – Sets the search move down the column from the selected 
location.

Conditions Mark any of these search options:

• Match Case – Mark this option to take case into account. For example, 
if you mark Match Case, and y ou type aa351 in F ind in co lumn, the 
search finds the next entr y in the column t hat contains aa351. It do es 
not find entries t hat contain AA351 or Aa351.

Figure 71 Find in column dialog box
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• Match whole word – Mark t his option to only find entries in which the 
complete entry matches what you type in F ind in column. For example, 
if you type AA351 in F ind in column, and mark Match whole word, the 
program finds the next AA351 entry. It does  not f ind entries such as 
AA3512 or AA351992.

Find Next Finds the next matching entry in the selected column, and moves the 
cursor to the location def ined in t he row that contains the entry. The 
search is performed only for the chromosome selected in the Genome 
View.

Cancel Closes the dialog bo x.
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Gene List

Purpose: Lets you view the names of the genes in a specific gene list and 
to change the display color of the gene list. See “To display the genes in a 
gene list” on page 66.

To open: In the My Entity List pane of the Navigator, right- click the 
name of a gene list, then click View in Table.

Name (Read- only) The name of t he gene list.

Description (Optional) Brief descriptiv e comments about the gene list, such as ho w it 
was created or t he nature of the genes in the list. You can edit the 
description.

Figure 72 GeneList dialog box
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S. No The sort order number. This i s the index number of each gene within the 
gene list.

Gene Names The names of t he genes in the gene list.

Color Opens the Choose Gene List Color dialog box, where you can change the 
display color for the gene list. See “Combine Tracks” on page 172.

OK Saves the gene list wit h any new description or displa y color, and closes 
the dialog box.

Cancel Closes the dialog bo x without making any changes t o the gene list.

Go To Gene/Genomic Location

Purpose: To find a specific gene location in Gene View by either selecting 
the RefSeq by Symbol or by selecting the Genomic Location.

To open: Click Home > Go to Gene/Genomic location.

RefSeq by Symbol Select the Reference Sequence accession symbol from NCBI, and click Go.

Genomic Location • Chromosome – The chromosome number.

 

Figure 73 Go To Gene/Genomic location dialog box
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• Base Position – The position on t he chromosome.

Click Go after selecting the chromosome number and  the position of the 
gene on the chromosome.

Cancel Closes the dialog box.

Import

Purpose: Lets y ou select files and im port them into Agilent Genomic 
Workbench.

To open: In the Home tab, click Import, then select any kind of import 
except Genome B uild or T rack. The type of file for import appears in t he 
title of the dialog box. To import a gene list, right- click the Gene List 
folder in t he My Entities List pane of the Navigator, then click Import 
Gene List.

Figure 74 Import dialog box
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Use the standard Windows Explorer commands in t he dialog box to select 
a file for import. 

For some imports, you can select multiple files. Click the name of the first 
file, then hold d own the ctrl key and cl ick the names of addition al files. To 
select a contiguous block of files, click the name of the first file in the 
block, then hold down the Shift key and click t he name of the last one.

File name Displays the name of a f ile you select for import.

Files of type Lets you select t he types of f iles to display from the types shown in t he 
table below. To display all files, click ,then select All Files.

.

Import or Open Imports the file into the program. In some cases, the name of this button 
is Open, rather than Import. Also, when y ou click Import, in many cases 
one or a series of additional dialog  box(es) lets y ou further define the 
content for import. See the instructions for each type of im port in 
Chapter 2.

Cancel Cancels the import and cl oses the dialog box.

File type Extension

FE array File *.txt

Axon array file *.gpr

UDF file *.txt

Design file (GEML) *.xml

Axon design file *.gal

Array attributes *.txt

Experiments *.zip

Filters *.xml

Gene list *.txt
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Import (experiments)

Purpose: Lets you select the specific experiments within a ZIP format 
experiment file to import into the program. See “To import an exper iment 
file” on page 49.

To open: In the Home tab, click Import > Experiments. In t he dialog box 
that appears, sel ect the desired ZIP format experiment file, then click 
Import.

Select
experiments to

import

These columns appear:

• Import – Mark the check box for the experiment(s) to import.

• Experiment – The name s of t he experiments available for import in the 
ZIP format experiment file.

Select All Selects all of t he experiments in t he ZIP file for import.

Deselect All Clears all of the check boxes under Import.

OK Imports the selected experiments into the program. If the name of an 
imported array design or data file matches one t hat is already available in 
the program, the Confirm overwrite dialog box appears, where you can 
select the data and/or design f iles that you want to overwrite. See 
“Confirm Overwrite” on page 177.

Figure 75 Import dialog box (for experiments)
Methylation (CH3) Analysis Guide 203



5 Methylation (CH3) Analysis Reference
Import GEML design files
Cancel Cancels the upload and closes t he dialog box.

Import GEML design files

Purpose: To display information in the design file and to remove any files 
that you don’t want to import. 

To open: In the Home tab, click Import > Design Files > GEML File. 
Select the desired *.xml design files, then click Open.

File Name The name(s) of t he design file(s) for import.

ID The Agilent ID number f or the design file

Type The application type; CGH, C hIP, miRNA, or gene expression.

Figure 76 Import GEML design files dialog box
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Species The species for the genome build. This appears automatically when t he 
Genome Build is sele cted. 

Genome Build The genome build for the design. If the genome build is not read 
automatically, a “?” appears. Click Genome Build and select t he correct 
value from the list.

Status • Not Set – Appe ars if Ge nome Build and Spe cies information is not 
shown.

• Not Allowed – Appears if a Ge nome Build is sele cted that does not 
match the design.

• Overwrite – Appears when the design file has been updat ed and wil l 
overwrite any existing one of  the same name.

• Valid – Appears when t he file is ne w.

Remove Click  to remove a specific design file from the list. 

Start Import Starts the import of the design files in the list.

Cancel Cancels the upload and closes t he dialog box.

Import Genome Build

Purpose: To import a ne w set of genome build f iles into Agilent Genomic 
Workbench. See “To import a genome build” on page 46.

To open: In the Home tab, click Import > Genome Build.

Figure 77 Import Genome Build dialog box
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Import Track
Species The genome’s species of origin. 

Build Name The name of the build to import.

Refseq File The location of the RefSeq database file. This f ile contains chromosomal 
locations of genes. T o select a Refseq file, click Browse.

CytoBand File The location of the applicable cytoband file. This file contains graphical 
cytoband information for Gene View and Chromosome View. To select a 
cytoband file, click Browse.

OK Imports the genome build an d closes t he dialog box.

Cancel Cancels the import and cl oses the dialog box.

Import Track

Purpose: Lets y ou import a BED f ormat track file. See “To import 
tracks” on page 47. Track information can appear in Gene view. See “Gene 
View” on page 156.

To open: In the Home tab, click Import > Track.

Species Select the species to which the track relates. 

CAUTION Import only Agilent-supplied genome build files. 

Figure 78 Import Track dialog box
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Build Name This list contains the available genome builds for the selected species. 
Select the desired genome build.

Color The assigned display color for the track. To change this color, click 
Change. 

Track Name Type a name to identify the imported track. 

Track File Type the location of the BED track file that you want to import, or click 
Browse to select a file.

Browse Opens an Open dialog box, where you can sele ct the BED track file to 
import.

OK Imports the track into the program.

Cancel Cancels the import and cl oses the dialog box.
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Microarray Properties
Microarray Properties

Purpose: Displays the properties associated with an ar ray. You can also 
edit the values of specific attributes. To add attributes to the list, see  the 
Sample Manager User Guide.

To open: For any array in t he Data folder or Experiments f older, 
right- click the array name, then click Show Properties. For non- Agilent 
arrays, only the Attribute tab appears.

Attribute tab

• Attribute — Displays the attributes in an ar ray by name. You can load 
these from an Excel spreadsheet.

• Value – Ind icates the values, if any, for each array.

Figure 79 Microarray Properties dialog box with list of Attributes and their values
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Microarray Properties
Close Closes the dialog box.

FE Headers Tab

Index Displays a sequential index to help identify FE pr operties.

Name Displays feature parameters, statistics and constants for the whole array.

Value Displays the value f or each paramet er, statistic and const ant.

Close Closes the dialog box.

NOTE You cannot edit values for read-only arrays.

 

Figure 80 Microarray Properties dialog box with list of FE Headers and their values
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Microarray Properties
FE Features Tab

Selection List Select the chromosome whose feature information you want to display.

List Box Displays FE f eatures and t he associated data. The fields are:

Figure 81 Microarray Properties dialog box with list of FE Features and associated data

Index FeatureNum ProbeName

gIsPosAndSignif LogRatioError PValueLogRatio

gProcessedSignal rProcessedSignal gMedianSignal

rMedianSignal gBGSubSignal rBGSubSignal

gIsSaturated rIsSaturated gIsFeatNonUnifOL

rIsFeatNonUnifOL gIsBGNonUnifOL rIsBGNonUnifOL

rIsPosAndSignif gIsWellAboveBG rIsWellAboveBG
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Probe Methylation Status Setup

Purpose: To associate Tm (melting temperature) map files with the design 
files for the arrays in the experiment or to make sure the Tm information 
is already in t he design file. 

To open: Click Analysis, then mark Apply for the Probe Methylation 
command

Design Name Shows the names of the design files contained in t he experiment

Tm Map File Click Browse to find the Tm map file for the design file. This is necessary 
only if the design is a custom design or if Tm is still not available after an 
attempted update. 

If the design is an Agilent Catalog array, the Tm inf ormation is a vailable 
within the file as long as it has been updat ed. If the design file has not 
been updated, the Browse button is active. If it has been updat ed, the Tm 
Map File option says Available. If not, update it bef ore continuing.

Continue The methylation algorithm calculates and displa ys the Z- score results.

Cancel Closes the dialog box without generating a report.

Figure 82 Probe Methylation Status Setup dialog box
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Probe Methylation Report Dialog 

Purpose: To select whether the results are reported for the complete 
genome or for individual chromosomes. See “Report Format” on page 240.

To open: Click Reports, then click Generate Probe Report.

Report Type All methylation reports are probe- based.

Output Format Complete Genome – Creates report as .xls file for entire genome

Per- Chromosome – Creat es report for each chromosome as .tx t file. Open 
in spreadsheet program to see headers properly aligned.

Select File
Location

Click Browse to select a location for the file, that you must name.

Figure 83 Probe Methylation Report dialog box
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Sample Attributes

Purpose: To show, hide, or ed it array attributes

To open: In the Experiment Pane of the Navigator, right- click the 
experiment, and click Sample Attributes.

This dialog box lets you enter or change the existing values for the 
attributes listed for the arrays in the experiment. You can also sho w or 
hide attribute columns. The colu mns that appear initially are the default 
columns (Array ID, Gl obal Display Name, Green Sam ple, Red Sample, 
Polarity and Extraction Status) plus any that you selected to show. 
Changes you make are appl ied globally. See t he Sample Manager User 
Guide.

Figure 84 Sample Attributes dialog box

NOTE Changes to array attributes you make in this table appear also in the Sample Manager 
table.
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Scroll to Column
Scroll to Column

Purpose: This dialog box lets y ou select a column . The program then 
scrolls the tab so t hat you can see the selected column.

To open: Right- click a column heading in Tab View, then click Scroll To 
Column. in the shortcut menu. 

Select column Displays the columns a vailable in the selected tab. Select the one you 
want to display.

OK Scrolls the current tab to show the selected column.

Cancel Closes the dialog bo x.

Figure 85 Scroll to Column dialog box
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Search Probes in eArray

Figure 86 Search probes in eArray dialog box

Purpose: To select the probes you want to update in eArray

To open: Right- click Gene View, and click Search probes in eArray.

Select a chromosome and a region in Chromosome View for selecting the 
probes related to the genes in this region.

User Defined Select to choose the region to search for probes in eAr ray. The 
chromosome selection list and  the Start and St op positions o n the Y axis 
are activated when this option is sel ected. 

For complete
gene view

All the probes related to the genes in Gene View are searched.

For aberrant
region below

cursor

Selects those probes for the genes that appear just below where the cursor 
sits in Gene View. 

Chromosome If you select User Defined, you can select a different chromosome than 
had been selected before opening this dialog box.

Start/Stop If you select User Defined, type Start and Stop positions f or defining the 
region for the genes in t he list.
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Select Color
Select Color

Purpose: To select a color . Three tabs are available for selecting colors: 

• Swatches tab -  select co lors based on sam ples (swatches)

• HSB tab -  select colors based on an  HSB schema (Hue, Saturation, and 
Brightness)

• RGB tab -  select co lors based on an RGB schema (Red - Green- Blue)

To open: This dialog box opens when a function a llows you to change a 
color. For example, right- click on an array in an experiment, click Edit 
Array Color and click the Swatches, HSB, or RGB tab.

Swatches tab

This tab is used to select a color based on color samples (swatches).

Preview The Preview area shows how the selected color appears. Wh en you change 
the color, the original color appears at the top of t he color box on t he 
right.

Figure 87 Select Color - Swatches tab
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Select Color
Recent: Choose a recent color selection.

OK Click to select t he color and close the dialog box.

Cancel Click to close t he dialog box without changing the color.

Reset Click to change swat ches, HSB, and R GB colors b ack to the default colors.

HSB Tab

In this tab, you can select a color based on an HSB schema (H ue, 
Saturation, and Brightness).

Hue Click the H button, and move the slider up and do wn, or go up and do wn 
the list of numbers, to select the hue or color of the array.

Saturation Click the S button, and move the slider up and do wn, or go up and do wn 
the list of numbers, to select t he saturation le vel for the color.

Brightness Click the B button and move the slider up and down, or go up and down 
the list of numbers, to select the brightness le vel for the color.

Figure 88 Select Color - HSB Tab
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Select Color
RGB Numbers Reflect the amount of red, green and blue in t he resulting color.

Preview The Preview area shows how the selected color appears. Wh en you change 
the color, the original color appears at the top of t he color box on t he 
right.

OK Click to select t he color and close the dialog box.

Cancel Click to close t he dialog box without changing the color.

Reset Click to change the swatches, HSB, and RGB colors back to default val ues.

RGB Tab

This tab is used to select a color based on an RGB schema.

Red Move the slider to change the amount of red in t he color. Or, click the up 
or down arrow to select a number .

Green Move the slider to change the amount of green in the color. Or, click the 
up or do wn arrow to select a number .

Figure 89 Select Color - RGB Tab
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Blue Move the slider to change the amount of blue in the color. Or, click the up 
or down arrow to select a number .

Preview The Preview area shows how the selected color appears. Wh en you change 
the color, the original color appears at the top of t he color box on t he 
right.

OK Click to select t he color and close the dialog box.

Cancel Click to close t he dialog box without changing the color. 

Reset Click to return the swatches, HSB, an d RGB colors back to default values.

Select data type for experiments

Purpose: Lets you select t he mathematical form of t he data in an 
imported UDF file, and its associat ed application type. See “To import a 
UDF file” on page 43.

To open: In t he Home tab, click Import > Array Files > UDF File. In t he 
dialog box that appears, select the desired UDF f ile, then click Open.

Experiment Name By default, the experiment name is the name of the imported UDF file. To 
change the name, double- click it, then edit it as de sired.

Data Type Select the mathematical form of the array data in the UDF f ile. The 
options are:

• ratio

Figure 90 Select data type for experiments dialog box
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• log2 ratio

• log10 ratio

• ln ratio (base e)

Design type Select the application type (CH3, CGH, or e xpression, for example) for the 
array data in the UDF f ile.

Continue Accepts your selections, and goes t o the next step in the UDF import 
process.

Cancel Cancels the UDF import.

Set genome build and species for Axon design files

Figure 91 Set genome build and species for Axon design files dialog box
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Purpose: Lets you set the species and genome builds  for imported Axon 
design file(s), and t o remove specific designs f iles from the import, if 
necessary. See “To import Axon design files” on page 41.

To open: In the Home tab, click Import > Design Files > Axon File. In 
the dialog box that appears, select at  least one Axon design f ile, then click 
Import.

No. An index number within the dialog box for each Axon file.

File Name The names of each Axon design file selected for import.

Species The species for each design file. If a species is incorrect, select the correct 
one from the appropriate list.

Genome Build The genome build for each of the design files. If a genome build is 
incorrect, select the correct one from the appropriate list.

Status The status of t he file is one  of the following:

• Valid – The f ile is a new file that can be im ported.

• Healthy – The file passes validation and can be imported.

• Not Set – Appe ars if Ge nome Build and Spe cies information is not 
shown.

• Not Allowed – Appears if a Ge nome Build is sele cted that does not 
match the design, or if t he design is an A gilent Catalog design.

• Overwrite – The file is a valid design file, but when y ou import it, it 
will replace an existing design that has t he same name.

• Corrupt – The file failed validation. When you start the import process, 
the program ignores the file.

Remove Click  to remove a specific design file from the list. This is 
useful if you select a design file in error, or if y ou do not want to 
overwrite an ex isting one.

Start Import Imports the file(s) and closes t he dialog box. 

Cancel Cancels the import and cl oses the dialog box.
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Show/Hide Columns

Figure 92 Show/Hide Columns dialog box

Purpose: Used to select the attributes for display in the Sample Attributes 
dialog box and t he Sample Utility t ab. The S ample Utility tab is a vailable 
when you go to Sample Manager. See the Sample Manager User Guide for 
information about Sam ple Manager.

To open: This dialog box appears when you click Show/Hide Attributes 
at the bottom of the Sample Attributes dialog box. 

All available attributes are sh own in the Attributes column. A ttributes 
with a check- mark next to them are displayed in the Sample Attributes 
and Sample Utilities t ab for each sample. To select an attribute for display, 
mark the Show in Table box next t o it. To hide a n attribute, clear the 
Show in Table box.

Save Saves the current list of selected attributes and updat es the Sample 
Utilities table based on the selections.

Select All Selects all the attributes in t he list.

Deselect All Clears all check marks from attributes in the list.
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Close Closes the dialog box. If changes have been made, the program asks if you 
want to save your changes before closing.

Track

Purpose: This dialog box lets y ou view the chromosome locations in t he 
track.

To open: Click the Details link f or the desired track in t he Tracks tab of 
the Preferences dialog box. See “Tracks tab” on page 231.

Figure 93 Track details dialog box
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Track
Track Parameters These parameters appear:

Data Tracks must cont ain entries for at l east these four columns in the table:

The other columns are additional BE D track file columns that can appear 
for some tr acks. Agilent Genomic Workbench does not display these.

Close Closes the Track dialog box.

Parameter Description

Name The name of the track.

Species The species to which the track applies.

Format The format of the track data. Agilent Genomic Workbench supports 
the BED format.

Genome Build The specific genome build of the species to which the track applies.

Description Descriptive text saved with the track.

Column Description

Chromosome The name of the chromosome

Start The first base pair of the particular feature in the chromosome.

Stop The last base pair of the particular feature in the chromosome.

Name The name of the feature. This name appears next to the defined region 
for the feature.
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UDF Import Summary

Purpose: Reports how many lines of dat a were successfully imported from 
a UDF f ile, and how many lines were skipped. Skipped lines are caused by 
missing chromosome mapping information, or improper formatting of t he 
UDF file.

To open: Import a UDF file (see “To import a UDF f ile” on page 43). This 
dialog box appears after you map the columns of the UDF f ile.

Table Displays the file name of the imported UDF file, the number of lines that 
were successfully imported, and t he number of lines, if any, that were 
skipped during im port. If many lines were skipped, review the data for 
improper formatting or missing chromosome mapping information.

OK Closes the dialog box.

Figure 94 UDF Import Summary dialog box 
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Universal Data Importer - Map Column Headers

.

Purpose: Lets you set up a un iversal data file (UDF) for import. You select 
several properties for the UDF, and identify the contents of each column 
of data in the file. You can als o save column mappings f or re- use.

To open: As y ou go through the UDF im port process (see “To import a 
UDF file” on page 43), in the Select da ta type for experiments dialog box, 
click Continue. See “Select data type for experiments” on page 219.

Species Info

Select Species Select the species for the array data in the UDF. 

Select Genome
Build

Sets the species- specific build t o use.

Figure 95 Universal Data Importer - Map Column Headers dialog box
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Mapping Info

Select Mapping Applies an existing column map t o the current UDF. A column map 
identifies the contents of each column of dat a. To create a new column 
map for the current UDF, select CUSTOM.

Save Mapping As Saves the column map under a new name. Opens an Input dialog box, 
where you can type a name f or the new map. 

Array ID Info

Virtual Array ID A number that uniquely identifies the data in the UDF. Typically, an 
Agilent microarray slide has a physical barcode that Agilent Genomic 
Workbench uses t o generate an Ar ray ID. The Ar ray ID is used to track 
the data from the slide as it goes through the steps of an anal ysis 
workflow. A “ virtual” Array ID is, by default, a system- generated ID t hat 
serves the same purpose for data from UDFs. You can also create your 
own virtual Array ID.

Use System
Generated Array

ID

By default, the virtual barcode assigned to the array data in a UDF is a 
number that is created by the program. To create your own barcode, clear 
Use System Generated Array ID, then type a new number in Virtual 
Array ID.

Table

This table lets you identify the contents of t he columns of dat a in the 
UDF. The first row of t he table displays the column heading information 
from the UDF. The second row contains labels that you apply to each 
column, and the rest of the table displays lines of data from the UDF. If 
the UDF cont ains data from Agilent arrays, the column headings will 
exactly match the labels in the lists.

In the list below each column heading, select the applicable label. Y ou 
must use each of the labels exactly once, except LogRatio, which you can 
use more than once. These labels are a vailable:

Label Description

ProbeName Names of probes.

ChrName Names of chromosomes.

Start First chromosomal location for each probe.
Methylation (CH3) Analysis Guide 227



5 Methylation (CH3) Analysis Reference
Universal Data Importer - Map Column Headers
Reset Clears all the column labels in t he second row of the table. If you have 
selected an existing column mapping, this command also clears the labels 
in the saved map.

Import Imports the UDF file with the specified parameters, and opens the UDF 
Import Summary dialog box (see “UDF Import Summary” on page 225).

Cancel Cancels the import and cl oses the dialog box.

Stop Last chromosomal location for each probe.

Description Text annotation for the probe.

LogRatio Array data values that correspond to each probe. You can use this 
label more than once.

Label Description

NOTE If you select an existing column mapping, then change or reset the column labels in the 
table, the program changes or resets the saved column map as well. 
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Upload Track to UCSC

Figure 96 Upload Track to UCSC dialog box

Purpose: Lets y ou select a track t o upload t o the UCSC Web site, where 
you can view it in t he UCSC genomic browser.

To open: Right- click in Gene View, and select Upload Track to UCSC.

Name Type a name f or the track. This name identifies the track when it appears 
in lists and dis plays.

Build (Available if y ou select User Defined in Set Chromosome Start- Stop.) 
Select the genome build with which to associate the track.

Description Type descriptive text to attach to the track for reference.

Set Chromosome
Start-Stop

This parameter defines the region of the chromosome used for the track. 
Select one of t hese options:
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• User Defined – Lets you define an arbitrary region of any chromosome. 
If you select this option, select the desired chr omosome in 
Chromosome, then type t he beginning (Start) and end (Stop) locations 
of the desired interval.

• For complete gene view – The chr omosomal region that appears in 
Gene View.

• For aberrant region below cursor – All of the intervals that begin 
before the cursor position and end after the cursor position.  

Select Track
Source

The type of analysis result the program uses to construct the regions 
defined in t he track. Select one or bot h of these options:

• Methylation Score – Uses the current methylation score as the source 
for the track.

Save as Track in
Genomic

Workbench

Saves the selected track in t he Tracks folder in the My Entity List pane of 
the Navigator.

OK Creates the track. To display the track in Gene View, use the Tracks tab 
of the User Preferences dialog box to enable it. See “Tracks tab” on 
page 231. To export the track, see “To export tracks” on page 73.

Cancel Closes the dialog bo x without creating a track.
230 Methylation (CH3) Analysis Guide



Methylation (CH3) Analysis Reference 5
User Preferences
User Preferences

Purpose: This dialog box is used t o set up pref erences for display of 
tracks, data storage locations, and licenses.

To open: From the Home tab, click User Preferences. Or, right- click in 
the Gene View, Chromosome View, or Genome View, and click User 
Preferences.

Tracks tab

Purpose: To import and set up t he appearance of track s next to the Gene 
View. Tracks are additional g raphic displays of ge nomic information 
loaded from an external file. They align with genomic coordinates in Gene 
View.

To open: In the User Preferences dialog box, click the Tracks tab.

Figure 97 User Preferences dialog box - Tracks tab 
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Font Options

Select the font type, style an d size for the gene annotations that appear in 
the selected tracks.

Tracks List

Track Name Name of t he track already loaded or imported

Show in UI Mark the check box to display the track next to Gene View.

Show in Report Mark the check box to display the track information in all the reports.

Genomic
Boundaries

Click to use the track to define only the regions that aberration detection 
algorithms will run. You can choose t o do t his for only one track.

Delete Mark the check box to delete the track from the list. Then, click Delete to 
delete the track from the list. 

Details Click to display all t he chromosome locations defined in t he track.

Import Click to import new tracks.

Delete Click to delete the tracks selected in the Delete column.

Up Click to move a track up t he list.

Down Click to move a track do wn the list.

Visualization Parameters

Genes These options affect the appearance of the Track and Gene Vie w.

• Orientation – T ype a number to set the angle at which the Gene 
Symbols will appear in Gene Vie w and the Track Annotations appear in 
the tracks.

• Show Gene Symbols – Mark to show gene symbols in Gene Vie w, and 
clear the check box to hide them.

Genomic
Boundaries

These options let you include or exclude the Genomic Boundaries from the 
analysis.

Tracks These options affect the appearance of t he Track Views.

• Show Annotations – Mark to show the names of t he gene regions for 
the tracks, and clear t o hide them.
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• Show Overlaid – Mark to overlay all the tracks that appear next t o 
Gene View, and clear the check box to display the information in 
separate tracks.

Miscellaneous tab

Figure 98 User Preferences dialog box – Miscellaneous tab

Purpose: For data/content set- up, this dialog box allows you to set up 
eArray access and t o change the location f or data.

To open: In the User Preferences dialog box, click the Miscellaneous tab.

eArray User
Details

Sets login details for the Agilent eArray Web site.

• URL – A t present, https://earray.chem.agilent.com

• Username – The name  registered on t he eArray site.

• Password – The password registered on the eArray site.
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Error Model (Not available for CH3) The DLRErrorModel (Derivative Log Ratio) 
measures noise in t he data for CGH analyses.

Data Location The folder where the program stores array data and design files. To select 
a location, click Browse.

Apply Applies any changes to the preferences.

OK Accepts any changes and closes t he dialog bo x.

Cancel Cancels all changes and closes the dialog box.

License tab

Figure 99 User Preferences dialog box – License tab 
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Purpose: The License t ab allows you to display and updat e your CH3 
application license. This lice nse enables the CH3 application, and allo ws 
you to use it to analyze array data.

To open: the In the User Preferences dialog box, click the License tab.

Host Name Displays the host computer name automatically.

Select Analysis
Application

Select the Agilent Genomic Workbench application for which you have a 
license.

Server Location Select this option if you have a concurrent user license. To edit this name, 
select Server Location, then type the path where your license(s) are 
located. If you select this option, the Text License option is unavailable.

Text License Select this option if  you have an ap plication license (CGH, ChIP, CH3). To 
change the license, delete the old license text, and p aste the new license 
text in t he box.

OK Accepts any changes you have made, and closes t he dialog box.

Cancel Closes the dialog box without changing any license information.

Apply Accepts any changes you have made, but does not close the dialog box.
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View Preferences

Figure 100 View Preferences dialog box

Purpose: This dialog box allows you to configure how data and results 
appear in Gen ome, Chromosome, and Gene views.

To open: In the View tab, click View Preferences. 
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View Alignment Selects the orientation and rendering style (described below).

Data Visibility For each view, or all views, selects t he kind(s) of data and results t o 
display. 

In View, select the view you want to configure. To set availability of 
display items for all views, select All views. Some displa y items are onl y 
available for certain views. When y ou select a display item, it enables the 
item for display — f or some items, you must t ake additional steps to 
display them. For example, you may need to configure a specific algorithm 
in the toolbar.

Mark any of the following options, as a vailable:

Option Description

Orientation

Horizontal Stacks Genome, Chromosome, and Gene views horizontally in the 
main program window. Genomic locations appear across the bottom 
of each view.

Vertical Displays Genome, Chromosome, and Gene views from left to right as 
side-by-side panes in the main program window.

Rendering Style

Overlaid In Chromosome View and in Gene View, displays data and results as a 
single, combined pane for all arrays. (Default)

Stacked In Chromosome View and in Gene View, displays a separate pane for 
each array.

Display item Description/Comments

Scatter Plot The plot(s) of individual log ratio data points.

Scatter Tool Tip The ToolTips that appear when you place the pointer over specific data 
points on the scatter plot(s) in Gene View. The tool tip shows the array 
of origin and the numerical log ratio value for the data point.

Moving Average The result of the Moving Average algorithm. See “To set up a moving 
average (Log Ratio) calculation to smooth the data” on page 107.
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View Preferences
Rendering
Patterns

These options control the specific appearance of data and results in 
Genome, Chromosome, and Gene views. You configure these options 
separately for each type of ar ray design.

• Design Type – Select the type of design to which the patterns are 
applied: CH3, Expression, or Other.

• Styles – S elect the display style for each of t hese elements:

Scatter Plot (Chr
View) Point Size

Select a point size to use for display of scatt er plot data points.

ZScore Marking this check box displays the results from the methylation 
algorithm to produce the statistical likelihood of methylation or no 
methylation in CpG Island regions of the genome.

Log Ratio Error 
Envelope

Mark this check box to display the error envelope for log ratio values.

Display item Description/Comments

Display element Details

Log Ratios Select how to display individual data points as: Color filled circles 
(ellipses), circles, rectangles, filled rectangles, + signs, or x signs. 
The latter two choices increase performance. 

Moving Average Select the line style for the moving average display. Lines appear in 
the display color defined for each array. See “To set up a moving 
average (Log Ratio) calculation to smooth the data” on page 107.

• Continuous – A solid line.
• Dashed – A dashed line.
• Dotted – A dotted line.
• Do not show area – No line.

NOTE Rendering scatter plots for more than 10 high density arrays in the Chromosome View may 
take significant time. Selecting filled circles as the rendering style for CH3 scatter plots can 
also decrease performance. For faster performance, change the rendering style for CH3 
data from the filled circle to the plus (+) or cross hair sign.
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Configure Scales For Methylation Results or Log Ratios plots, mark Apply to enable the 
custom scale. In Range, type the value to use as t he range for the scatter 
plot.

Configure
Coloring schemes

Use these options to change the display of the scatter plot in the Gene 
View. These options are the same as those displayed in the Scatter Plot 
ToolTip in the Gene View.

Show Memory
Monitor in Status

Bar

Displays a memory usage monitor in the eighth cell of the status bar. For 
information about t he Status Bar, see “Status Bar” on page 165.

OK Applies the changes you made to all preferences and c loses the dialog box.

Cancel Closes the dialog box without applying changes.

Apply Applies changes without closing the dialog box.
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Report Format

The Methylation Report contains all the statistical results t o help you 
determine if there are methylated or unmethylated regions in the genome. 
The report is created in .xls format for the complete genome or in .txt 
format for individual chromosomes. Use a spreadsheet program to open 
the report(s).

To learn the meaning of the values in t he ZScore columns see “Overview 
of Methylation Detection and Visualization Algorit hms” on page 244.

Methylation Reports contain the following columns, in this order: 

Column Description

CytoBand Accepted name of the cytoband for each section of chromosome

ChrName Name of the chromosome (for example, chr17)

ProbeName Name of the probe (for example, P)

Start The first base pair of the chromosomal location to which the probe 
binds

Stop The last base pair of the chromosomal location to which the probe 
binds

Description Name or phrase for the type of probe (for example, promoter)

GeneNames Names of each gene in whose region probes are located

“Name of CpG Island 
Track”

Name of each CpG Island in whose region probes are located

Combined ZScore Combination of both the methylated and unmethylated ZScores. The 
higher the positive combined ZScore, the more likely the probe is 
methylated and vice versa.

ZScore_Methylated Probe ZScore that are contained in right Gaussian. All of these values 
are positive or small negative values.

ZScore_Unmethylated Probe ZScore that are contained in left Gaussian. All of these values 
are negative or small positive values.

logOdds This number reflects how likely it is that a probe is methylated rather 
than unmethylated. The higher the positive value, the more likely it is 
methylated.
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logRatio Log ratio from the extracted FE image file for the probe

Tm Melting temperature for the probe region 

Column Description
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This chapter provides implementation details for the algorithms used in 
the Methylation (CH3) application of A gilent Genomic Workbench 7.0. The 
methylation algorithms facilitate the statistical analysis of met hylated 
genomic regions. The first section pr esents the methylation detection and 
measurement algorithms. This is f ollowed by a section t hat describes the 
visualization options available for methylation analysis.
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Overview of Methylation Detection and Visualization Algorithms
Overview of Methylation Detection and Visualization Algorithms

The Methylation module of A gilent Genomic Workbench provides 
algorithms for genomic methylation detection and visualization. The ma in 
methylation detection algorithms are described below. Information on 
algorithms that visualize the data follows.

Methylation detection and measurement algorithms

Methylation of cytosines in DNA is an epigenetic modification that can 
play a role in the regulation of gene expression. Generall y, methylation is 
associated with repression of gene expression. Much of the aberrant DNA 
methylation associated with disease is found in CG- rich regions, termed 
CpG islands. 

Agilent catalog methylation (CH3) arrays are specifically designed to 
assess the methylation pattern within CpG islands and gene pr omoter 
regions. The m ethylation detection algorithm is designed to be compatible 
only with the Agilent protocol for DNA methylation analysis and the 
Agilent methods for affinity- based methylated DNA enrichment.1

Methylation status detection algorithm

The methylation status detection algorithm is designed f or two- color 
assays, where t he green (Cy3) channel  is comprised of input DNA, and the 
red (Cy5) channel is com prised of the affinity- enriched DNA. As a result 
of constraints imposed on the array design, the probes that target genomic 
regions with varying CG content do not share a uniform melting 
temperature (Tm), which can res ult in com pression of the log- ratios. 

The methylation detection algorithm allows you to normalize the log- ratios 
for each probe, based on i ts Tm, and retur ns the methylation status of a 
probe. This sharpens t he bimodal distribution observed with log- ratios 
alone. For more inf ormation, see “Methylation status detection 
algorithm” on page 246.

BATMAN algorithm

The BATMAN (BAyesian Tool for Methylation ANalysis) algorithm2 has 
been adapted here f or analysis of A gilent methylation microarrays. This 
algorithm takes into account the local density of CpG dinucleo tides in t he 
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Visualization algorithms
genomic vicinity of t he interrogating probes, and es timates methylation 
events using this information. The algorithm is used with log ratio 
observations and can addit ionally incorporate the effects of probe melting 
temperature corrections based on t he output Z- scores from the 
methylation status detection algorithm. For more inf ormation, see 
“Bayesian tool for methylation analysis (BATMAN)” on page 256.

Visualization algorithms

Moving average – linear

The moving average algorithm sets a fixed window size around every point 
of interest. The points are ei ther the probe log- ratio scores determined 
prior to the methylation detection algorithm, or the combined scores that 
result from application of t he methylation detection algorithm. The 
program reports the value for each point as t he average of t hat point and 
neighboring points wit hin the window boundaries. For more information, 
see “Moving average (linear smoothing)” on page 261.

Moving average – triangular smoothing

The triangular smoot hing algorithm is a shaped algorit hm based on a 
moving average. As the moving average centers on a point o f interest, the 
program applies a maximum weight, and t hat weight falls off with 
increasing distance. The program adjusts the point of interest as the 
weighted mean of itself and neighboring points. For more information, see 
“Triangular smoothing” on page 262.
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Methylation Detection and Measurement Algorithms

Agilent Genomic Workbench provides two algorithms for methylation 
detection and measurement of t he methylation levels detected by 
Methylated DNA Im munoprecipitation (MeDIP). The met hylation status 
detection algorithm uses a melting temperature differential to discriminate 
between methylated CpG regions and unmethylated regions. The Bayesian 
tool for methylation analysis (BATMAN) algorithm uses conditional 
probabilities from a calibration step to estimate methylation levels in CpG 
regions. The BATMAN algorithm may be used directl y on the log- ratios, or 
it may be used on the resultant Z- scores from running the methylation 
status detection algorithm.

Methylation status detection algorithm

You find epigenetic methylation predominantly in genomic areas of 
increased GC cont ent, known as CpG islands. Agilent human methylation 
arrays specifically query approximately 25,000 CpG islands in the human 
genome, in addition to gene promoter regions. The A gilent methylation 
protocol uses antibody enrichment for 5- methylcytosine, which results in a 
log- ratio of the relative abundance of genomic fragments wit h methylation 
to those without. 

Although the log- ratio scores give information about t he relative 
abundance of the genomic fragments, individual specificities of the probes 
in each log- ratio score vary by melting temperature. Differences in melting 
temperature can therefore decrease probe specificity. Normally, the probes 
on Agilent arrays are chosen in such a way as to minimize probe- to- probe 
differences in melting temperature.

The algorithm first bins the probes by their melting temperature. Within 
these bins, you can make direct probe comparisons. When you compare 
probes by log- ratio scores within each bin, you observe a bimodal 
distribution — a mo de comprised of those probes that were not 
methylated, and a mode com prised of methylated probes. You also observe 
a bimodal distribution in per - Tm Z- normalized scores.
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The algorithm determines the methylation status of a probe in a 
Tm- dependent manner. To determine which probes are m ethylated, the 
binning process compares log- ratios among probes of similar melting 
temperatures.

To apply parametric statistical techniques, the algorithm fits the bimodal 
distribution to a set of Gaussian cu rves, each of which requires only a 
limited number of parameters to accurately fit the data. The algorithm 
uses normalized Z- scores from the Gaussian distributions to effectively 
judge the methylation status of a given probe on the array.

Purpose Detection of met hylation status is a visualization and repor t analysis that 
determines the confidence score for probes that query known CpG islands 
and gene promoter regions. To determine the probe methylation status, the 
analysis uses a combination of log- ratio scores from competitive 
hybridization methods, and t he range in melting temperatures among 
probes located in CpG islands.

Use To establish a link between genomic methylation and gene expression, 
detection of met hylation status is used t o identify probes likely to query 
methylated genomic regions. CpG islands, measured on t he Agilent catalog 
methylation (CH3) design ar ray, generally are ei ther fully methylated or 
fully unmethylated. You use the algorithm to identify methylation status 
for probes. You can then visualize the probes in a genomic context — f or 
example, CpG islands within the genome.

Algorithm The algorithm first bins the probes by their melting temperature. For each 
bin, it applie s Gaussian fits using one of  three models. It fits the probe 
log- ratios to Gaussians, using a local searching algorithm called random 
hill climbing.3 Z- scores and p- values derived from the Gaussian dat a give 
probabilities and con fidence values for methylated and unmet hylated 
probe populations. The algorithm then calculates a methylation logOdds, 
which gives the relative probability that a pr obe is more likely methylated 
than unmethylated.

NOTE The logOdds score indicates how likely a probe is to be methylated. It compares p-values 
from the methylated to unmethylated populations. If they are the same, this value is zero.
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Step 1: Create a binned distribution of probes

To compare log- ratio scores between genomic fragments enriched by 
methylation and those without methylation, the algorithm orders probes 
into discrete melting temperatures.

7 Probes are b inned according to their melting temperature. Each bin is 
1ºC wide.

8 The algorithm fits the Gaussian distributions to the probe log- ratios 
within each T m bin. It does this by further dividing the probe log- ratios 
into sub- bins (with default size of 0.1 ºC), t o generate the observed 
distribution of signals, as shown in Figure 101.

Step 2: Fit Gaussian curves to the binned data

For each bin of 1ºC, the algorithm applies Gaussian fits in one of three 
models, depending on whether the data points are unim odal or 
multimodal:

Figure 101 Overview of procedures in the methylation status algorithm
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• If the data are unimodal, then it f its one Gaussian distribution to the 
data.

• If the data are bimodal (the most common fit for methylation data), 
then it fits two overlapping Gaussian dis tributions to the data.

• If the data are trimodal, then it fits three overlapping Gaussian 
distributions to the data.

The process to fit a Gaussian curve to the data has two steps:

1 Initial parameter approximation

2 Improvement of the model parameters using a lo cal search procedure 
called random hill climbing.3

Initial parameter
approximation

For each Gaussian curve, the parameters to be fit are the mean (μ), 
standard deviation (σ), and mi xture coefficient (α, the total Gauss 
integral). For each of the three possible models, the algorithm 
approximates the initial parameters as f ollows:

• First Gaussian

For any of the three models, the parameter estimations are done in 
the following ways:

1 The mean is esti mated by the maximum bin.

2 The standard deviation is esti mated using the IQR (Inter- Quartile 
Range) of t he distribution, as inferred from the data left of the mean.

3 The mixture coefficient is estimated from the maximum bin height.

• Second Gaussian

NOTE One Gaussian goodness of fit can exceed two Gaussians if, for example, no methylated 
probes were pulled down during the antibody enrichment process, or if the number of 
methylation events is exceedingly small. If this occurs, Agilent Genomic Workbench 
automatically fits one Gaussian to the data, and the message “SINGLE GAUSS” appears in 
the report. The Z-score in the visualization and report is then calculated from the single 
Gaussian (that is, how likely the probe is to be methylated), instead of a combined Z-score 
(which is reported from models using either two or three Gaussians).
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If the data points are bimodal or trimodal, the first Gaussian is 
subtracted from the distribution. The mean, st andard deviation, and 
mixture coefficient are then estimated in t he same way as the first 
Gaussian.

• Third Gaussian

If the data are not well explained by either a unimodal or bimodal 
distribution, then a third Gaussian curv e can be fit to allow a better 
estimate of t he first and second Gaussian parameters. In this case, 
the parameter estimates are:

1 The mean is estimated from the mean from the entire bin.

2 The standard deviation is estimated from the entire bin.

3 The mixture coefficient is esti mated from the height of t he bin used 
to estimate the third Gaussian mean.

Parameter
improvement

procedure

Because many probes are ge nerally present in eac h Tm bin (on the order 
of thousands), the algorithm uses a straightforward local search procedure 
called random hill climbing3 for parameter optimization. This procedure is 
highly accurate and e xtremely fast when fitting the Gaussian models to 
the data.

In each step, the algorithm alters a random parameter. It accepts this 
alteration if it improves the target fitness function. To converge to a 
(locally) optimal result, each random step gets shorter with each iteration. 
This reduction in st ep is mad e logarithmically by n, the number of 
iterations, and a default starting value of 100 (termed LB):

The algorithm achieves convergence when a new step does not yi eld an 
improvement in the target fitness function. The procedure converges if no 
change occurs t o the fitness value for 1000 it erations, or after the 
algorithm has performed 50000 iterations.

Target fitness
function

The default t arget function is t he Chi- squared goodness of fit. This 
function is des cribed using an observed distribution ODi=1…N, and an 
estimated distribution function EF (for example, the convex combination 
of two Gaussians), as f ollows:

LB n+( )log
LB( )log

----------------------------- 1( )
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Step 3: Calculate Z-normalization scores

After the algorithm fits the Gaussian curve(s) to the data, it performs 
parametric statistical analysis. The log- ratios from the Tm- binned probes 
may differ in value. Agilent Genomic Workbench therefore uses a measure 
from the Gaussian distributions themselves to normalize the scores. This 
measure is called a Z- score:

where μbin is the mean and σbin is the standard deviation of the Gaussian 
distribution. The Z- score is a measure of t he distance of a given probe 
log- ratio score f rom the mean of any of the Gaussian curves, given the 
standard deviation of that curve. The Z- score normalizes comparisons of 
probes from different bins, b y taking into account the Gaussian- fit curves 
of the different bins. 

Because the methylation model typically contains two Gaussians, the 
algorithm calculates Z- scores for each one. The left Gaussian represents 
those probes with a lower log- ratio score, and cons ists predominantly of 
unmethylated probes. The left Gaussian is also t he major mode, because 
the majority of pr obes are generally unmethylated. The rig ht Gaussian 
represents probes with a high log - ratio score, and consists predominantly 
of probes enriched for methylation. The alg orithm calculates the following 
Z- scores as statistical measures of w hether or n ot a probe is methylated:

1 The Z- score derived from the left Gaussian. A negativ e or small po sitive 
value means that the probe is likely to be unmethylated.

2 The Z- score derived from the right Gaussian. A positive or a small 
negative value means that the probe is lik ely to be methylated.

3 The combined Z- score. This is t he summation of the left and right 
Gaussian Z- scores. It reflects the location of a probe log- ratio value in 
relation to the Gaussian distribu tion(s) of probes with similar Tm. A 
strong positive value of t he combined score mean s it is  methylated, 
while a str ong negative value indicates the probe is u nmethylated. See 
Figure 102 for more information.

χ2
ODi EFi

2
–

EFi
---------------------------- 2( )

i 1=

N

=

Z
log ratio– probe μbin–

σbin
-------------------------------------------------------- 3( )=
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In addition to the Z- score calculation, A gilent Genomic Workbench 
calculates a p- value that considers how much of a tail continues past t he 
log- ratio point on t he Gaussian curve. Such a calculation is im portant 
because the tails of the Gaussian d istributions overlap; hence it is o ften 
difficult to clearly assign a given probe log- ratio score to the left or t he 
right Gaussian if a pronounced valley exists between the two distributions. 
See Figure 103 for more inf ormation.

Figure 102 Effect of probe log-ratio score placement on a mixture of Gaussians – result 
ranges for Z-normalization score
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The following p- values are calculat ed for the usual case of two Gaussians:

1 The p- value derived from the left Gaussian. This is deno ted pM in t he 
report, and is t he confidence at which the non- methylation null 
hypothesis is r ejected (that is, t he confidence at which you can call t he 
probe methylated).

2 The p- value derived from the right Gaussian. This is den oted pU in t he 
report, and is t he confidence at which the methylation null hypothesis 
is rejected (that is, t he confidence at which you can call the probe 
unmethylated).

3 Finally, the algorithm uses the bimodal distribution of log- ratio scores 
among probes of sim ilar Tm to calculate a logOdds score of t he probe. 
This final logOdds score ref lects the likelihood that a probe is 
methylated, and is ca lculated as ω:

Figure 103 Calculating Z-scores and p-values from two overlapping Gaussian distribu-
tions

ω
pM
pU
------- 
  4( )log–=
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Interpreting the
results

As shown in Figure 103 above, the boundary to decide whether a probe is 
methylated often comes from log- ratio scores that fall in a valley between 
two Gaussians. Although the program can es tablish a ratio of  the 
contribution of each Gaussian b y calculation of t he logOdds score ω, a 
region exists where ω approaches a value of 1, and a methylation status 
decision cannot be made. In other words, a t hreshold on the logOdds 
score decides the methylation status call. This threshold is not fixed, and 
can be determined after you inspect the output in the context of a pr oject.

Visualization Agilent Genomic Workbench can display a moving average for both the 
probe log- ratio scores and t he Z- normalization scores from the 
methylation status algorithm. The Z- scores used in t he moving average 
visualization are t he combined Z- scores, and ref lect the position of t he 
probe log- ratio score on bo th Gaussian curv es, as sho wn in Figure 102.

Figure 104 displays the Gene View results of the methylation status 
algorithm for Chromosome 21. The left pane displays the Z- score moving 
average. There is no defined cut- off value to determine whether a p robe 
or probe region is m ethylated. The middle pane shows the moving average 
for the probe logOdds ratios, with genomic tracks annotated. The right 
pane displays the CpG island track. Note that the probes fall specifically 
within CpG islands, and upstream of genomic tracks such as coding 
regions.
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Output report The program generates an output report for each chromosome. The repor t 
contains the following statistical measures:

Figure 104 Output of methylation status detection algorithm. On the right side of Agilent 
Genomic Workbench, Gene View displays the moving average for both the 
Z-score (left pane of Gene View) and the probe log-ratios (middle pane of Gene 
View). Human CpG islands are displayed as a track along the right side of the 
moving averages. Note that the probe log-ratios, which are only slightly posi-
tive in this region (colored red), may take on negative combined Z-scores (col-
ored by sample).
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Bayesian tool for methylation analysis (BATMAN)

Epigenetic methylation is f ound predominantly in genomic areas of 
increased GC cont ent, known as CpG islands. Agilent human methylation 
arrays specifically query approximately 25,000 CpG islands in the human 
genome, in addition to gene promoter regions. Like many MeDIP protocols, 
the Agilent methylation protocol uses antibody enrichment f or 
5- methylcytosine, which results in a log- ratio of the relative abundance of 
genomic fragments with methylation to those without.

Although the log- ratio scores give information about t he relative 
abundance of t he genomic fragments, the scores do not re flect the 
underlying distribution of CpG din ucleotides, the abundance of which can 
increase fragment enrichment. Dif ferences in CpG dinucleotide frequencies 

Table 6 Contents of methylation output report

Reported parameter Meaning

Z-score unmethylated Z-score derived from the left Gaussian. This is the probability 
that the observed value for a probe comes from the 
unmethylated population.

Z-score methylated Z-score derived from the right Gaussian. This is the probability 
that the observed value for a probe comes from the methylated 
population.

Combined Z-score Summation of the methylated and unmethylated Z-scores

pM The p-value derived from the left Gaussian. This is the 
confidence at which the non-methylated null hypothesis is 
rejected (that is, the confidence at which you can call the probe 
methylated).

pU The p-value derived from the right Gaussian. This is the 
confidence at which the methylated null hypothesis is rejected 
(that is, the confidence at which you can call the probe 
unmethylated).

logOdds The logOdds score ω; the likelihood that a probe is methylated 
rather than unmethylated.
256 Methylation (CH3) Analysis Guide



Statistical Algorithms 6
Bayesian tool for methylation analysis (BATMAN)
can therefore confound methylation state quantitation because t he signal 
log- ratios themselves depend upon the density of the methylated CpG 
sites.

To obtain an absol ute measure of methylation, the BATMAN algorithm 
first calibrates a set of conditional probabilities based upon the distance 
of a p robe from any CpG sites. Based on expect ed fragment sizes during 
DNA shearing, the total number of CpG sites per probe can be estimated, 
yielding a Gaussian distribution of methylated sites to give the observed 
probe signal. This conditional probability is t hen used as a likelihood to 
generate a Ba yesian posterior probability of t he methylation status of an y 
CpG site given the probe signal. The signal used in BATMAN can be either 
the probe log ratio or the Z- score from the methylation detection 
algorithm.

In general, probes chosen f or MeDIP-  microarray experiments are limited 
by their genomic location and t herefore have a wider range of m elting 
temperatures. The met hylation detection algorithm accounts for this by 
binning the probes according to their melting temperature and 
standardizing the probe scores. Agilent Genomic Workbench therefore 
allows you to combine the output from the methylation detection 
algorithm with the BATMAN algorithm, to account for the differences in 
probe melting temperatures and t he effects of inhomogeneous CpG 
densities.

To increase the speed of t he overall calculation, BATMAN uses the 
assumption that the methylation state of neighboring CpG di nucleotides is 
not independent, but rather homogeneous due t o the effect of methylation 
spreading and maint enance. A Mont e- Carlo simulation is t hen used to 
sample windows of f ixed genomic size to establish methylation levels for 
all CpG sit es.

Purpose BATMAN is a visualization and repor t analysis that determines the 
absolute methylation level for CpG dinucleotides that are contained within 
DNA fragments queried by probes across the microarray. These probes 
typically capture kno wn CpG islands and gene pr omoter regions. T o 
determine the absolute methylation level of individual CpG sites, the 
analysis uses a calibration method to arrive at a distribution that 
describes the conditional probability of t he probe signal given a set of  
methylation states. Bayesian inference is then used t o obtain the 
methylation states given the probe signal. 
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Use To establish a link between genomic methylation and gene expression, or 
to observe epigenetic changes, Agilent Genomic Workbench uses the 
BATMAN algorithm to quantify the methylation level of CpG dinucleotides 
across probes that query methylated genomic regions. You can then 
visualize the probes in a genomic context — f or example, CpG islands 
within the genome, or individual CpG dinucleotides within CG- sparse 
regions.

Algorithm The algorithm begins wit h a calibratio n step, which uses a re gression to 
fit a trend between local CpG density and eit her probe log- ratios, or 
Z- scores if the methylation status detection algorithm is used. This is 
followed by a modeling st ep, which uses the calibration results t o 
construct the conditional probability of t he log- ratios (or Z- scores) given 
the methylation state. A sampling step occurs to generate a large number 
of possible methylation states. Bayesian methodology is used to invert the 
conditional probability and su mmarize the methylation state per probe. 
Finally, a methylation call st ep fits a distribution to the scores on a 
per- chromosome basis. A dditionally, for each CpG island, gen omic 
intervals are f ound with the same methylation call.

Step 1: Calibration step

As described in Do wn et al.,2 a coupling factor Ccp is def ined as:

where c is any given CpG dinucleotide, n is the number of fragments 
containing c, and m is the total number of DNA fragments hybridizing to 
any probe p. A linear regression is then fit to the plot of the log- ratios (or 
Z- scores) versus Ctot, where:

Since most CpG- rich areas are hypomethylated while most CpG- poor 
regions are hypermethylated, the regression fit is increased by limiting the 
least- squares method to the low- CpG regions. The least square estimates 
are given by:

Ccp
m
n
----=

Ctot Ccp
p
=
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and:

The variance of the predicted response (that is, the expected range of 
values of y at 95% c onfidence) is gi ven by:

This value is then used in the modeling step along with the regression line 
slope and int ercept.

Step 2: Modeling and sampling

This step uses the data from the calibration results to create a likelihood 
model. The MeDIP  model is giv en by:

Where Ap is t he log ratio (or Z- score) for the probe, Abase is the baseline 
value given by the linear regression, and Mc, the methylation state at c, is 
regarded as a  continuous variabl e with a Gaussian distribution.

Possible combinations of me thylation steps are sam pled from the MeDIP 
model using nested sampling.4 

Step 3: Summarization (Bayesian inference)

The sampling step results are then summarized to create a score f or each 
probe. Each of the sampling states are weighted by the likelihood estimate 
from the model. The IQR and median val ues are calculated across samples 
and for every probe in every array.
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Bayesian tool for methylation analysis (BATMAN)
The responses are t hen trimmed t o the regions of interested (for example, 
track boundaries). 

Step 4: Methylation calling

A beta distribution is fit to the scores per chromosome obtained in t he 
summarization step. (See “Methylation calling – the beta distribution” on 
page 265 for more information). Agilent Genomic Workbench then 
calculates the modes of the distribution and c ompares the score to the 
mode, assigning methylated / status calls (+1 f or methylated, - 1 for 
unmethylated). If the modes are not unique, then zero is re turned as a 
call.

The beta distribution is fit using a local searching algorithm called 
random hill climbing.3

Interpreting the
results

For each CpG island, Agilent Genomic Workbench displays consecutive 
regions that share t he same call across each chromosome.

Visualization The consecutive regions appear as int ervals for inspection.
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Visualization Algorithms
Visualization Algorithms

After you apply the methylation algorithm, it is useful to visualize the 
general trend of the pre- algorithm probe log- ratios and po st- algorithm 
combined Z- scores, using a moving average line plot. T o facilitate the 
visualization of large datasets, Agilent Genomic Workbench employs a 
sliding window across the genome, to smooth the data points for detailed 
examination. The smoothing functions are available independently from 
the main methylation algorithm. A change in window size in the 
visualization algorithms does not af fect the methylation calls.

To reduce the complexity of the data from probe- to- probe noise, you can 
apply one of two smoothing algorithms. One algorithm applies linear 
smoothing (the moving average algorithm), and t he other applies a 
triangular smoothing function. These algorithms use a slidin g window of 
fixed size, set in the user interface (UI). You can apply them to the log 
ratios, the Z- score output from the methylation algorithm, or both.

The moving average visualization algorithm sets a fixed window size 
around every point of interest. The algorithm reports the value for that 
point as t he average of t hat point and neighboring points within the 
window boundaries.

Moving average (linear smoothing)

To compute a m oving average, the program averages probe log- ratios or 
combined Z- scores over a small sub set of points in t he genome. This 
moving average window, w, may be simply a number of adjacent 
measurements, or it ma y be over a positional window (such as every 
megabase).
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Triangular smoothing
Triangular smoothing

The triangular smoothing algorithm is a shaped smoot hing algorithm based 
on a moving average. As the moving average centers on a point of interest, 
the program applies a  maximum w eight, and t hat weight falls off with 
increasing distance. Then the program adjusts t he point of interest as the 
weighted mean of itself and neighboring points.

Purpose When you visualize or analyze array data, it is common t o smooth the 
data using a moving average. However, the moving average approach is not 
the optimal means to reduce noise associated with each independent 
point, because it can minimize log- ratio changes or me thylation Z- scores 
and obscure individual points. T riangular smoothing is a good  compromise 
that reduces noise of ind ividual points, while remaining sensitive to true 
localized or small - scale variations in the data.

Use The smoothing functions are used  for visualization purposes onl y, and do 
not affect the methylation algorithm. However, the program applies the 
moving average (Z- score) after the methylation algorithm, to smooth the 
methylation Z- scores that you visualize in t he user interface.

Algorithm The number of neighboring points used for smoothing depends on the type 
of moving average. If you select point input (pt in put), the program keeps 
constant the number of points  that are averaged. It may use, for example, 
3, 5, 7, 9, or 11  points, a nd it gives each point equal w eight. Alternatively, 
you can select a windo w of constant width (in Mb or Kb). The windo w 
moves across the data and cent ers on t he point of int erest. All points 
within its range are averaged to yield the moving average value for the 
point.

Two potential problems exist in li near smoothing:

1 Use of a fixed window width (by choice of a base pair from the UI) 
causes a variable number of pr obes to be averaged at each smoothed 
point. Therefore, the degree of a veraging varies fr om probe to probe, 
depending on how many probes are in t he fixed- width window. Because 

NOTE In linear smoothing, the user-defined point input (pt input) uses the same number of probes 
as in triangular smoothing. However, an equal number of probes is taken in each direction 
(to the left and right of the center probe) to compute the moving average. This might not be 
ideal if the probes are placed at varying distances.
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Triangular smoothing
varying numbers of measurements contribute to each smoot hed point, 
the degree of statistical noise reduction also varies for each point. This 
can complicate the error analysis.

2 For so- called “zoom- in” arrays, where some genomic regions of interest 
are covered more densel y than neighboring regions, t he appropriate 
window size can var y greatly between the different genomic regions. 
Smoothing windows that are appr opriate for sparsely tiled regions 
obliterate all structure in densely tiled regions. Windows appropriate for 
densely tiled regions  perform practically no averaging at all  in sparsel y 
tiled regions.

Triangular smoothing avoids these problems, by use of smoothing windows 
that contain a f ixed number of probes, regardless of the total range of 
sequences those probes span. This respects the fact that nearby probes are 
more relevant than distant probes to the average at an y point.

The concept is illus trated in Figure 105. Fixed- count smoothing includes 
the same number of points in each average, but weights probes far from 
the averaged point as much as poin ts near it. In trian gular smoothing with 
pt input, the program enlarges a symmetric windo w around the averaged 
point until it contains the number of  points chosen for the fixed- size 
window. These poi nts may be on one or bo th sides of the averaged point, 
depending on t he probe density around the averaged point. These points 
are then weighted appropriately for the triangular smoot hing function, 
depending on their distance from the averaged point.

When you enter a number of points from the user interface, the program 
uses a variable window width, chosen to be the smallest win dow that is 
symmetrical about t he averaged point and includes the specified number 
of points. Figure 105 illustrates the application of this method for pt 
input. 
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Triangular smoothing
The program applies sm oothing to a region of varying probe density. The 
effective width of the smoothing window, W, depends on t he length of the 
smallest symmetrical region (Δ) that includes the specified number of 
points. The weight given to each point is pr oportional to the height of the 
triangle at that point.

Weights assigned to the log- ratio or combined  Z- score values of these 
probes are given by the equation:

(1)

where the effective window width, W, is determined by the length, Δ, of 
the symmetrical region that includes the specified number of points:

(2)

Interpretation The smoothing algorithms affect the scatter plot in the Chromosome and 
Gene Views. See Figure 104 for more information.

Visualization Agilent Genomic Workbench can display scores fr om the methylation 
algorithms in the UCSC gen ome browser for visual interpretation.

Figure 105 Triangular smoothing with pt input 

w x( ) W x–( ) W2⁄=

W Δ 2 2–( )⁄=
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Appendix
Appendix

This section cont ains additional information about statistical algorithms 
and is useful to understand algorithm steps in detail.

Methylation calling – the beta distribution

The beta distribution is given by:

Where B in t he denominator is an incomplete beta function giv en by:

And the gamma function is:

The beta distribution is shown in Figure 106.

Figure 106 The beta distribution, illustrated with various parameter values
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